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Preface 

As a simulation user, developer, and advocator, I am pleased to see the 
development of a book that not only looks at how to use SIMUL8 software 
but also explores and discusses the uses and application of simulation in 
general.  It has always been the mission of SIMUL8 Corporation to make 
simulation a general purpose, easy-to-use tool that is available to all types of 
decision-makers regarding the flow of work or people.  As a result, the uses 
of simulation and SIMUL8 applications are great and varied.  This book is a 
good introduction to a variety of applications of SIMUL8 over the years 
since its introduction in 1994. 

The authors of this book, apart from myself, are all part of a company 
called Viusal8 Corporation that has, since SIMUL8’s inception, been the 
primary support and solution provider within North America.  As a result, 
this team of authors is well equipped with the necessary experience to tackle 
the use and application of simulation techniques using SIMUL8.  I was 
excited about learning more on the applications that this advanced team of 
consultants has undertaken over the years, and welcomed the introduction 
of SIMUL8 as the basis for a simulation-based textbook for students and 
new users alike. 

The scope of this text is wide and well surpasses any reference material 
currently available on the use of SIMUL8.  Not only does the book cover 
all aspects of SIMUL8 and forms a practically useful guide to the use of 
SIMUL8 software, but it also extends further into the use of simulation, 
industrial applications, and case studies.  This created a mammoth task for 
the team in terms of collecting information on typical case studies and 
making them of general use to the reader.  The group’s main goal was to 
provide a textbook that would inspire readers to tackle new areas of 
simulation application as well as instruct them into methods to easily apply 
the technique.  Consequently, this book is an excellent collection of case 
studies, knowledge, and expert reference to simulation and the tool 
SIMUL8. 



6  •  Preface  

As SIMUL8 approaches its twelfth year, its ease of use makes it a great tool 
for all decision-makers.  This book provides a practical guide to the use of 
the tool within many industries and I am excited to see this area of the text 
grow over the coming years. 

 

Mark Elder, CEO and Founder of SIMUL8 Corporation 
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Simulation Overview 
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Chapter 2: Working with Simulation 35 
Chapter 3: Statistical Considerations 53 
 
 

The first section of this textbook introduces the concept of simulation 
modeling.   

Although it has been used for operational analysis for a number of years, 
few decision-makers are comfortable with the technique or even have a 
basic knowledge of the concepts.  Therefore, we cover first the basics of 
simulation, such as what it is used for, how it works, and what new 
developments are occurring.  Then we describe a typical approach to 
carrying out a simulation study, and deal with some of the issues that are 
often faced by those building models for clients.  Finally, we have included 
some statistical considerations, so the general reader will understand how 
model results obtain their validity. 
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Chapter 1:  Introduction to 
Simulation 

What is Simulation? 
Simulation is the use of a computer program to model a real world system, 
in order to validate decisions affecting the system.  Simulation provides 
decision-makers and clients with the equivalent of a 'flight simulator' of 
their factory or other decision system.  It does this by representing (in 
computer code) every significant resource and event in the factory or 
decision system and displaying on a computer screen an image that moves 
with 'simulated time'.  This enables the client to try out different ways of 
operating the system without experimenting with the real system.  Consider 
the following scenario: 

A new factory is being designed. How many lift trucks will be 
needed? There is seasonality in the demand, and shipping times 
can vary considerably. This does not present a difficult problem, 
since the design group has been modeling the factory with a 
visual interactive computer simulation. Spreadsheets alone are 
not adequate, and a poor guess could lead to an expensive and 
problem plagued startup. Travel paths and times are added to 
the model, and the best data on order levels, production lead 
times and truck traffic, varying randomly within a known pattern, 
are used. Various fleet sizes are tested, and the model is 
observed for congestion, idle lift trucks, lineups at the shipping 
docks, and other signs of imbalance. Only a few simulation runs 
are required to establish the size of a permanent fleet and rules 
for deciding when to rent additional trucks. This will ensure that 
overall transportation costs and service levels are acceptable. 

Simulation is used to help with the design or modification of complex 
systems - factories, businesses, etc. - by experimenting with alternative 
combinations of resources - people, machines, etc. - and with alternative 

 Throughout this 
book, the term 
“simulation” refers to 
visual interactive 
computer simulation 
modeling.  
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operating policies.  It can be used to test out plans or to gain insights into 
which alternatives can be worthwhile under a number of different 
assumptions about the operating environment - for example, customer 
demand. 

'Simulated time' usually moves much faster than 'real' time - so a day in a 
factory might be simulated in a few seconds in the simulation model. 

 
Figure 1-1: Sample Simulation Screen 

Modern simulations provide a graphical representation of what is 
happening in the system as the model is running, and allows the user to 
make changes to the model through a graphical interface.  This is called 
Visual Interactive Computer Simulation, and is the topic of this book.  The 
picture on the computer screen is often a 'plan view' of a factory, or even a 
3D representation, but any useful graphical representation of the process 
can be used.  This allows the users of the model to 'see' what is happening 
inside the model.  The design of the screen image is therefore one of the 
most important aspects of simulation today.  

Today’s packages are becoming easier and easier to use, and are well within 
the grasp of decision-makers at all levels of the corporation.  Using, and 
participating in the building of, models with visual interactive simulation 
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software is in fact becoming an essential skill of decision-makers.  It 
supplements, and even sometimes supplants, the use of spreadsheets and 
other management information sources, in decision-making over a wide 
range of mission-critical activities, including logistics, communication, 
operations, human resources, and finance. 

Why Simulation? 
One of the main benefits of simulation is its ability to model the way things 
occur in the real world.  The types of systems typically modeled exhibit 
dynamic (changes over time) and stochastic (statistical variability) behavior. 

Static vs. Dynamic  
Dynamic modeling ensures that a time dimension is explicitly included.  
Static modeling provides a snapshot of the system with no time element.  
Using simulation means that the dynamics of a system can be played out 
over time.  It is very difficult to accurately model a system that is dynamic 
using static analysis such as spreadsheet modeling or flowcharts.  Rates of 
change are the most difficult component to understand and handle 
statically.  A steady stream of customers is the desire of every business, but 
all customers arriving at once overwhelms most systems and must be 
planned for properly.  Modeling a system over time instantly makes this 
kind of complexity understandable. 

Without an understanding of the dynamics of a system, we tend 
to use the worst case (needlessly expensive) or the average 
(dangerously under-designed) to describe the system. How 
many elevators should a building have? The worst case occurs 
just around 8:00 AM, when 80 employees arrive simultaneously 
from the subway train. The average, over the course of the day, 
is only 30 people per hour. Six elevators are needed, if no one is 
ever to wait for more than three or four minutes. One is enough 
to handle the average traffic. Neither is the correct answer. A 
simple (and inexpensive) simulation will establish the best 
balance between costs and wait times. 
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Deterministic vs. Stochastic 
Simulation provides the capability to model variability in systems.  For 
example, a welder may be supposed to be able to weld one box every 5 
minutes but in practice, there will be some variability in this.  More 
variability will be experienced in how often the customers place orders for 
boxes.  Variability can often be described using statistical distributions.  The 
best known is the normal (bell curve) distribution.  This would describe the 
natural variation in the time for welding a box.  There are many other 
distributions, which describe particular situations (e.g. the exponential 
distribution, which describes the typical interval between order arrivals). 

  
Figure 1-2: Normal and Exponential Distributions 

Simulation creates this type of variability, or randomness, by using a stream 
of 'random numbers' to generate random events that fit the appropriate 
statistical pattern.  Random events imply that one event has no effect on 
what the next one will be. 

Sometimes simulation models do not contain any built-in random elements, 
since variation is not of interest to the purpose of the simulation.  This is 
frequently the case for simulation-based planning and scheduling 
applications. 

Benefits of using simulation 
The advantages of a simulation-based approach to a project have been 
discussed at length by many authors, and go much further than just the 
ability to simulate forward in time.  The following provides a summary of 
some of these advantages, as described by other authors, such as Banks, 
Carson, Nelson, and Nicol (2000); Law and Kelton (2000); and Schriber 
(1991): 

 A stochastic or 
probabilistic simulation 
can act like a 
deterministic model by 
using fixed distributions. 

 



Introduction to Simulation Simulation Overview  •  21 

Copyright Visual Thinking International 2007 

 Determining the ‘best’ choice – By simulating a proposed change, it 
is possible to select the best choice for change before implementing 
it.  This is extremely important, since designs that have been 
implemented are difficult and expensive to alter.  By testing all 
assumptions prior to installation, expensive mistakes can be 
avoided. 

 Manipulating time periods – Simulation provides the ability to 
speed up or slow down time for evaluation purposes.  Many 
simulation packages provide the ability to simulate a whole year’s 
production within a couple of minutes, giving the user access to a 
large simulation period quickly.  Similarly, for in-depth analysis of a 
specific period, the simulation model can be slowed down or 
stepped through for investigative purposes. 

 Understanding systems – Simulation is especially useful when 
systems cannot be viewed or observed in their entirety.  Managers 
can use simulation to reconstruct the system and view the 
operation in its entirety to gain insight and understanding of the 
interconnectivities and interdependencies of the system. 

 Exploration – When undertaking new initiatives, such as those 
which come from a Six Sigma project, the simulation model of the 
system can be used to evaluate and explore the recommendations 
made without disrupting the current system. 

 Problem identification – Most modern systems are complex in 
nature.  Simulation provides a place to explore these systems for 
the identification of problems.  Only by understanding all of the 
interdependent variables is it possible to identify the true source of 
the problem.  This results in less time spent trying to remedy the 
symptoms of a problem instead of solving the problem itself. 

 Bottleneck Analysis – Through identification of the bottleneck by 
means of simulation it is possible to quickly evaluate methods for 
addressing that issue. 

 Visualizing the plan – When designing a completely new system, 
many potential design flaws cannot be anticipated through 
evaluation of a static system.  By monitoring the design in an 
animated model, it is possible to find inherent design flaws and 
eliminate them. 
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 Gaining approval – Simulation provides an excellent platform for 
demonstrating new ideas and concepts for system improvement.  
When managers can see the immediate benefits of a change, it is 
much easier to get acceptance or budget approval. 

 Preparation through ‘what-if’ analysis – By running many 
simulations of potential problems, which can occur over time in 
the system, it is possible to be prepared for most eventualities, and 
develop plans to address them. 

 Analyze capital improvements – A typical simulation study costs 
approximately 1% of the cost of capital improvements.  By using 
simulation to ensure that the correct capital improvement is made, 
large savings can usually be realized. 

 Training other employees – Simulators have been used for years 
for training.  In the same manner, a discrete-event simulation can 
be used to demonstrate a new policy for employees.  Visualization 
provides an accelerated learning platform. 

Challenges in using simulation 
Many of the difficulties in using simulation are being addressed with 
advances in computer technology and simulation capabilities, but some are 
as follows: 

 Special knowledge is required – In the past, only simulation experts 
could create simulation models.  This was generally expensive.  
Simulation packages, especially those based on Windows™ 
technology, are becoming much easier to use, and require little to 
no code. 

 Hard to interpret – As many of the outputs are the results of 
random number generation, it can be difficult to determine the 
accuracy of the results.  Most simulation packages will provide 
summary and detailed reports for improved analysis, as well as 
export features to programs like Minitab™, and Stat::Fit™ for 
analysis of statistical significance. 

 Time-consuming – Detailed simulation models sometimes take a 
long time to develop, tying up valuable resources.  Through the use 
of dialog driven, drag and drop build objects, simulation models 
can be built quickly and easily for analysis. 
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The Position of Simulation in the 
Organization 
Approaches to Simulation 
Simulation holds a unique position within an organization.  It is not a 
traditional function such as marketing, finance, IT, HR, or operations, but 
instead can be applied across any or all of these departments.  Depending 
on the simulation software package used, the type of application, and the 
size of the company, organizations dedicate varying amounts of effort and 
resources to simulation. 

The following table shows of how different kinds of companies will 
typically approach the use of simulation. 

 

Approach Typical User Considerations 

No staff 
assigned to 
develop or 
use 
simulation. 

Small companies 
without engineering 
staffs 

Occasional 
simulation users 

Rapid model development, 
through use of consultants 

Reliance on consultants to 
interpret results of modeling 
projects 

Cost effective for well-defined 
projects 

A few staff 
to use 
simulation 
part time 

Midsize companies 
with industrial 
engineering 
departments 

Users who want to 
play a part in the 
development of 
recommendations 

Rapid development of models, 
through use of consultants, with 
user training provided 

Ability to explore a wider range 
of options 

Cost effective for ongoing 
projects, with fairly simple 
structures 

A few staff 
to develop 
simulations 
part time 

Medium to large 
companies, with a 
variety of engineering 
disciplines 

Slower development of models, 
with some reliance on 
consultants, to ensure models 
and results are valid 
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Approach Typical User Considerations 

Users with occasional 
expansion or 
reengineering 
projects 

Cost effective for ongoing 
projects, with structures and 
testing of medium complexity, 
and the need to modify models 
constantly 

Dedicated 
internal 
simulation 
consulting 
group 

Large companies 
with a variety of 
specialist engineering 
departments and 
other analysts on 
staff serving several 
locations 

Users constantly 
expanding or going 
through 
improvement 
initiatives (e.g. Six 
Sigma, Lean) 

Internal group acts as 
consultants to managers and 
project leaders, who have an 
understanding of the uses of 
simulation 

Cost effective where there are 
many, or large, projects 
requiring constant assistance 
from simulation specialists 

Figure 1-3: Position of Simulation in the Organization 

Who should be doing Simulation? 
It is fast becoming accepted that any decision-maker who is capable of 
using a spreadsheet should additionally be using simulation, or should have 
access to simulation to make informed decisions.  Simulation is becoming 
much easier to use and as a result is becoming more accessible to the 
general decision-maker, including some of the following:   

 Project Engineers, 
 Six Sigma Black Belts, 
 Plant Managers, 
 Process Improvement Planners, 
 Plant Design Engineers, 
 Manufacturing Engineers, 
 Business Consultants, 
 System Analysts 
 Production Planners 
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Choosing Simulation Software 
The following discussion will deal only with modern visual interactive 
simulation packages and, in particular, those designed to be used in 
interaction with clients. 

Like most software today, simulation software packages are adding features 
and capabilities very quickly due to competition and customer expectations.  
Although there are many users of simulation around the world, the market 
for simulation software is still quite small.  Consequently, there are many 
small companies producing specialist simulation software.  No two 
packages are alike (in contrast to word processing software packages, for 
example, which have similar features and operate nearly identically, and are 
marketed by a few large developers). 

Implementation on high-power hardware has always been preferable for 
effective simulation, since large simulation models would otherwise be slow 
to run.  If the user has a large number of runs to undertake, a fast computer 
is essential.  Conversely, user-friendliness is also very important, so 
mainframe computers are inappropriate.  Personal computers with high 
power processors have been popular with simulation vendors.  With one 
notable exception, very few simulation packages are available for the Apple 
Macintosh operating system. 

Software selection checklist: 

� Captures the essence of the system in the screen image 

� Uses industry standard interface 

� Uses customizable templates 

� Allows for different levels of detail 

� Automatically collects statistics 

� Allows freedom to build custom screen displays 

� Allows the builder to implement custom control logic in code 

Figure 1-4: Software selection checklist 

Currently, any simulation software that is selected should provide the user 
with the following facilities: 

 Use the Simulation 
Software Survey from 
OR/MS Today as a 
starting point when 
evaluating simulation 
packages  
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• Capture most of the logic of the model as the picture of the factory 
(or other system) is drawn on the screen.  In the past, it was 
necessary to write a program or fill in forms describing the system, 
and either attach the display afterward or program the model to 
drive the display.  The display is a vital element, as indicated above, 
so this is where the model should be built. 

• Use an "industry standard" operating system (e.g. MS Windows™). 

• Provide standard high-level elements that can be customized.  For 
example, if the user simulates an automated warehouse as part of a 
system, the simulation package should provide a standard 
"automated warehouse" template that can be customized. 

• Allow different degrees of detail in the model.  For example, when 
modeling a car factory, the developer may need to model each car 
individually, whereas in modeling a canning line, the developer may 
treat each can as part of a continuous flow of ‘product.’ 

• Automatically collect statistics on the performance of the simulated 
system and make these available so they can easily be placed in 
reports.  Packages are becoming available now that take care of a 
good deal of the statistical calculations (including helping to decide 
on warm-up time, etc). 

• Enable the developer to design and build screen displays that are 
tailored to the requirements of the client.  They must be 
recognizable to the client, and also designed to help the developer 
and the client see the key variables in the problem 

• Allow the developer to customize the logic in the model to match 
the situation modeled.  It is possible to create simulation packages 
that are very easy to use, but they do not have sufficient flexibility 
to enable the developer to describe the exact situation being 
modeled.  Therefore, having captured most of the description of 
the model as it was drawn on the screen, the package should 
provide a means to modify and add detail to this logic.  The extent 
to which this can be done can be an important element in the 
process of deciding what simulation package is suitable. 
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How does Simulation work? 
A simulation model is a computer program.  As with other user-friendly 
programs, the inner workings are usually hidden from the user.  This allows 
the model builder to concentrate on getting results, rather than having to 
learn to construct code. 

While the user does not need to know how a simulation model works in 
order to run and use a model, knowing a little about it usually helps 
facilitate the development and analysis process. 

All Simulation models contain three important, though frequently hidden, 
items: 

1. A time clock that represents 'simulated time'.  In computer terms, 
this is simply a variable in the computer's memory.  This changes 
on the screen as events take place in the model.  The time might be 
measured in seconds (quite common in a factory simulation where 
the length of jobs might be measured in minutes and parts of 
minutes), but could be weeks (if the simulation dealt with the 
exploration of the North Sea for oil fields) or micro-seconds (if the 
simulation focused on the performance of some electronics for a 
new type of telephone exchange). 

2. A list of future events.  An 'event' in a simulation model changes 
the state of some part of the model into a new state at a particular 
time (for example machine 21 in the factory will finish welding the 
side on a box 5 minutes after it starts).  The list of future events 
contains those events that have already been calculated to occur at 
specific pre-determined times.  At any given time the simulation 
model will only have determined a small number of the events that 
will actually occur - for example, it will not be able to determine 
when the machine will finish welding the box until it has started to 
weld the box, since the finish time is the product of the start time 
plus a process time determined from sampling a statistical 
distribution of possible times. 

3. A record of the current states of all the things in the system that 
can change state.  For example, machine 21 is currently welding the 
side on a box and this is the seventh box it has welded this 
morning.  This information will be used for additional calculations, 
such as determining when to halt the welding process for machine 
cleaning (which happens after welding 10 boxes). 

 Recommended 
units of time: 
- Seconds for less 

than 1 day 
- Minutes for less 

than 6 months 
- Hours for less than 

2 years 
- Days for more than 

2 years  
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The clock is set to zero at the start of each run of the simulation.  At this 
point, the computer looks at the list of future events and decides which 
comes first, by reading their corresponding time label.  The computer then 
changes the clock to read that time and deals with the corresponding event.  
This is simply a matter of adjusting the states (point number 3 above) in 
whatever way is appropriate for the type of event  - for example, the 
machine is now idle having finished welding the box.  The computer then 
adds to the list of future events any new events that are now capable of 
being determined, and perhaps changes states.  For example, as there is 
another box waiting to be welded, the machine is set into a busy state again 
and another 'finish weld' event is added to the list of future events.  During 
all this activity, the time clock has been reading the same time.  Now the 
computer starts over again and looks at the list of future events to see what 
time to set the clock to next. 

Simulation Time: 7.9333 Simulation Time: 7.9667 

 

→

 

 
Figure 1-5: Simulation History, Now, and Future Events 

Although the above comes in many guises, all simulation systems (at their 
heart) work in this way. 

Most simulation packages will actually contain rather more information 
than these three elements.  An obvious category is statistical information 
collected as the model is running. 

Another important category of information contained in a simulation model 
is structural information.  This encompasses all the information about 
where and how to display the states of everything in the simulation.  For 
example, where to display the machine mentioned above (physically with 
respect to other machines, etc.), what it should look like, and how its 
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appearance should change when it is in different states (working, idle, 
broken down, being cleaned, etc). 

Other Types of Simulation 
Having defined simulation for the purposes of this book, alternative types 
of simulation should be discussed.  

Continuous Simulation 
A category of simulation that remains important is continuous simulation.  
These models simulate systems that cannot be broken down into discrete 
events because of the mathematically continuous relationship between the 
variables.  An example might be that the rate at which a chemical reaction 
takes place is dependent on the temperature of the chemical and that is 
dependent on the rate at which the reaction is occurring.  These situations 
have to be modeled using differential equations.  Where differential 
equations are a central part of the problem system, it is worth using a 
specialist continuous simulation system to model them.  Most modern 
simulation software packages handle continuous simulation when necessary, 
by breaking a continuous process into a large number of discrete events. 

Historical development of Simulation 
Simulation, as a process, has evolved considerably over the years since its 
inception in the 1960’s.  Early simulations were developed entirely in 
computer code, and provided no visual display of the simulated system.  As 
computing capabilities evolved, so did simulation, with the introduction of 
graphical displays, although these systems were still heavily dependent upon 
a skilled computer programmer.  The latest generation of simulation 
software utilizes standardized objects and drag-and-drop functionality that 
make it easy to create simulation models without the need for a computer-
programming expert.  As a result, simulation is fast becoming a decision 
support tool for many managers in the same way that spreadsheets have 
become widely been used.  There are two main restrictions to this 
evolution: ease of software use, and the possession of simulation skills to 
develop usable simulation models. 
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How simulation users approach Operational Research (OR), in general, has 
a large impact on their use of simulation.  OR techniques, in recent years, 
have started to become standard tools used in organizational decision-
making.  OR is slowly becoming so engrained in the decision-making 
process that predominantly OR departments no longer exist as totally 
separate entities within companies.  Real world applications of OR are 
generally so complex that generating a mathematical model encompassing 
the entire solution space is simply too large and complex to be useful.  OR 
practitioners have been turning to simulation techniques to model dynamic 
and mathematically complex situations.  In this way, simulation is rapidly 
becoming a widely trusted and utilized decision support tool.  This is the 
origin of the claim, stated above, that models need to be built and used by 
the decision makers themselves as often as possible.  Decision makers 
should at the least be heavily involved in the model development process 
and its direction. 

The Future of Simulation 
Advanced Planning and Scheduling 
Advanced Planning and Scheduling (APS) through simulation has recently 
become of increasing interest to both academic researchers and business 
professionals.  Several papers on Planning and Scheduling have been 
published.  Advanced simulation packages are now providing the capability 
to integrate APS into simulation modeling.   

Many organizations have implemented ERP systems to satisfy the need for 
financial and production information for top executives.  However, ERP 
systems are limited in meeting the day-to-day needs of the shop floor.  ERP 
systems cannot help when it is necessary to react quickly with alternative 
planning and scheduling decisions in reaction to sudden changes in 
requirements and equipment breakdown. 

Simulation, by its nature, provides a detailed capture of all the inner 
workings and detailed rules and routings of work within a plant.  This is a 
level of detail that large ERP systems cannot possibly approach.  By 
backward planning in the same manner as these ERP systems and then 
executing the plan through a detailed simulation model, an efficient 
schedule is generated which actually works on the shop floor. 

 See the Institute 
for Operations 
Research and 
Management 
Science website 
(www.informs.org) for 
more information on 
OR  
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Simulations are also responsive to the constantly varying needs of an 
organization.  Packages are becoming more and more robust and flexible, 
and organizations are implementing simulation with ERP to make decisions 
as quickly as circumstances change, such as machine breakdowns, resource 
unavailability, and the arrival of rush work orders.  The ability to re-plan on 
a minute-by-minute basis avoids the need for inefficient manual change to a 
production plan. 

AutoSched and SIMUL8-Planner are two products that use simulation as a 
platform for Advanced Planning and Scheduling. 

Real-Time Decision Support 
The use of simulation for real-time decision support is becoming 
increasingly important.  Plants and systems are dynamic in nature.  Their 
needs are constantly changing, as machines go down, new orders arrive, or 
resource availabilities change.  Many simulation tools, including planning 
and scheduling applications, need to be capable of reacting to these 
changing circumstances quickly and efficiently.  Usually, engineers or model 
users manually intervene in reaction to changes.  However, to ensure data 
integrity, another method of updating the scheduling system must be used. 

The simulation must be tied to the MES (Manufacturing Execution 
Systems) and ERP systems to obtain data on the current state of the plant.  
PLCs (Program Logic Controllers) are constantly collecting and feeding 
detailed operational information to the MES for monitoring purposes.  
ERP systems contain up-to-date order databases and other operating 
parameters, which can be used by the simulation model.  By downloading 
this information to a simulation model, it will be working with the current 
state of work-in-progress, availability or states of machines, and accurate 
task times at the stations, ensuring up-to-the-minute accuracy of model 
outputs.  In this way, real-time decisions can be made using simulation.   

The diagram below shows a typical architecture for real-time decision 
support using historical and current data from MES and ERP systems to 
drive simulation and advanced planning and scheduling. 

An example of this is adaptive APS using simulation.  The simulation-based 
scheduling tool downloads live updates on the current operating status, 
process times, reliability, and order status from the MES, and obtains 
detailed inventory data and order requirements downloaded from MRP 
systems or other databases.  Following the procedure discussed in the 

 SIMUL8-Planner is 
a software package 
that combines 
simulation with 
planning and 
scheduling tools.  
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previous section, the most efficient schedules are then automatically 
generated.  

Real-time and historical data can also be used to drive a number of other 
different simulation applications including constraint analysis, line-
balancing, capacity planning and workflow analysis tools.  For example, a 
constraint analysis tool can take historical information on equipment cycle 
time and reliability and dynamically identify bottlenecks in the system. 

 
Figure 1-6: Real Time Decision Support Architecture 
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Chapter 1 Review and Questions 
 

Chapter Summary 

We saw that simulation is the use of a computer program to 
model a real world system.  The chief benefits of using 
simulation to solve problems and help in making decisions, rest 
on including the time element, and random variation in system 
characteristics, in order to describe the real world more 
accurately than static methods of analysis can.  Visual interactive 
simulation modeling is the main way to simulate on a computer. 
This means that simulation can be easily used by any size 
organization, and by a wide range of individuals within the 
organization. Selecting software for simulation should therefore 
be based on ease of creating the screen image, and capturing 
the main features of the system, without the need for writing 
code.  Of course, it is still important to understand that simulation 
rests on a time clock, a future event list, and a record of the 
current state, and is driven by pseudo-random number streams. 
Since its early days, simulation has come a long way, in tandem 
with the development of the personal computer.  Simulation 
remains a dynamic field with new developments such as 
simulation-based advanced planning and scheduling, real-time 
decision support, and emulation. 

 

 

Test your understanding 

1. Describe a problem in which the decision-maker must consider a 
variety of criteria (multi-criteria decision model) in which 
simulation would be useful. 

2. Describe a problem in which the visual aspect of a simulation 
would be the key motivator for using simulation tools. 

3. Give examples of the following: 
a) Static system  
b) Dynamic system 
c) Deterministic system  
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d) Stochastic system 

4. Describe the link between simulation studies and decision-making. 
a) Who makes decisions? 
b) Who makes simulations? 
c) Why is simulation potentially powerful? 
d) What other programs are useful to aid in making 

decisions?  Which overlap and which can be integrated 
together? 

5. Describe a problem that could be simulated for the following: 
a) Project Engineers 
b) Six Sigma Black Belts 
c) Plant Managers 
d) Process Improvement Planners 
e) Plant Design Engineers 
f) Manufacturing Engineers 
g) Business Consultants 
h) System Analysis 
i) Production Planners 

Try to identify for each problem: 
i. Who should develop the simulation?   
ii. Where should they be positioned in the organization?   
iii. What set of skills should the developer have? 

6. Name the first five events happening in a simple single ATM system. 
(Describe all states and events.) 

7. Describe the potential for APS in six different industries 
a) Healthcare 
b) Mining 
c) Metal Production 
d) High volume manufacturing 
e) Low volume manufacturing 
f) Coffee (from bean to mug) 

8.  Describe how real-time simulation would affect the following: 
a) Constraint analysis 
b) Line balancing 
c) Capacity planning 
d) Workflow analysis 
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Chapter 2:  Working with Simulation 

Typical Simulation Study 
Most simulation projects will have a client, whether a consultant is working 
for an external organization, or an industrial engineer is working for a Plant 
Manager.  We will deal with the steps in a typical simulation study from this 
point of view.  In practice, a simulation study is not generally a series of 
steps, but an iterative process where the model builder and client work 
together to refine the simulation model.  However, the following aspects of 
a project should be included to ensure a successful simulation study. 

Simulation study checklist: 

� Identify the objective 

� Determine the level of detail 

� Determine the processes to be included 

� Create a rough model 

� Refine the model 

� Run the model 

� Verify the model 

� Determine the warm-up time 

� Explore the model 

� Choose scenarios and run trials 

Figure 2-1: Simulation study checklist 
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1) Identify a Need/Objective 
Listen to the client to find out what issues they are interested in exploring 
and how their operations work.  Their thoughts on what concerns them will 
provide a good idea of what variables and structure will help them to use 
the model of their system effectively.  At this stage, a conclusion is reached 
whether simulation is even the best way to assist the client. 

2) Determine Level of Detail 
Consider the level of detail that is appropriate for the model.  For example, 
is it necessary to include every part of every operation at each machine in 
the factory, or is it more appropriate to simply model the output of whole 
departments and how they interact with each other?  Putting too much 
detail in a model takes longer time and can also cloud the issues that the 
decision maker is interested in. 

3) Determine the Processes to be Included 
Consider the scope of the model.  For example, is it reasonable to limit the 
boundaries of the model to the factory itself, or do the systems that affect 
supply of raw materials to the factory also need to be included? 

4) Create a Rough Model 
Build a rough and ready simulation model as quickly as possible.  It does 
not matter if some data is missing or if it crashes when it runs; the best 
attitude is ‘to start before you are ready.’  This rough model can then be 
shown as a prototype to the client.  Experience has shown that even static 
drawings on a computer screen can do a good job of helping the client to 
understand the following: 

• What information the client will get from carrying out the 
simulation study? 

• What aspects of the need and objective mentioned above, have 
been misunderstood? 

• What aspect of the system is of particular interest to the 
investigation now that a consultant has put some structure to the 
problem? 
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Creating a rough model is much more important than it may seem.  The 
model builder's first idea of what is a suitable simulation model can be very 
different from the simulation model at the conclusion of the study.  This is 
not because the model builder was necessarily wrong, but because the 
client's needs evolved in the course of the process. 

Again, it does not matter how rough the model is, because, in most cases, it 
will be necessary to start again. 

5) Working with the Client 
Start working more closely with the client to build a more robust model.  In 
fact, with the types of software becoming available now, it is possible for all 
the stages above to be part of one session with the client. 

It is especially important to work with the client since the process of 
building a simulation provides a learning experience in which the client 
uncovers new facts about the system.  Through this process, many 
experiments will be tried that challenge the assumptions of both the client 
and consultant.  Both the client and model builder will learn a lot about the 
way the factory operates (and could operate) under different circumstances.  
If clients are not engaged in this development, then they will not 
understand how the end result has been reached.  Without client 
involvement, implementation of anything other than an obvious solution 
could be difficult, as the client may not trust the results.  The process of 
building models will be discussed in the sections on simulation technology, 
but it is important to realize that there are two key, but separate, skills 
involved in the model building process. 

1. Being able to use the software to build a robust model. 

2. Being able to design the display for a model that highlights the 
important issues to the client without clouding the root causes 
with information overload. 

The second of these is not easy to learn, but this book is designed to 
provide a feel for its importance and what is likely to affect its success. 

Working with the client breaks down into many sub-steps.  This phase 
continues until the client feels they know what is best to do, in other words, 
until the problem is solved.  The client/model builder relationship will be 
discussed in greater detail later in this chapter in the section Client – Model 
Builder Relationship on page 41. 
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6) Running the Model 
Run the model (start the simulation clock and see the units moving around 
the system).  This stage can provide many insights into how the system 
works and what changes would improve it.  However, it is very important 
that certain key steps are taken to ensure validity of these discoveries. 

7) Verify the Model 
Verify that the model is running in the same way that the real world would 
work in the same circumstances, as the first step.  In theory, there is a need 
to do this every time a change is made to the model, but clearly, this would 
be impractical.  If the simulation is a model of an existing system, this 
verification stage is just a matter of ensuring the model behaves like the real 
system.  For example, putting some actual customer orders into the model 
and seeing if they are handled in the same way and in the same time as they 
are in the real factory would accomplish this. 

The only way to verify a model of a new system (which does not yet exist) 
is to carefully experiment with the model, watching both the animated 
screen and the statistics to see if the changes observed are reasonable in the 
light of changes made to the model input parameters such as demand, 
numbers, speeds of machines, etc.  There is a methodological problem here 
because clearly, if these changes were known or expected, there would be 
no need to build and use the simulation model in the first place.  
Nevertheless, careful examination of the model's behavior will allow the 
identification and removal of most mistakes or misunderstandings in the 
model building. 

It is very easy to omit this stage in the excitement and urgency of trying to 
help the client find a solution.  Omitting it is also one of the easiest ways to 
lose a client's faith when they see some result which is not only intuitively 
wrong but proves to be caused by a mistake. 

8) Determine Model Warm-up Time 
Find a suitable 'run-in' or 'warm-up' time for the simulation model.  Models 
of factories usually need a warm-up time because the simulation model is 
likely to start empty (no products at any of the machines), but real factories 
do not start each week without any work-in-progress.  A situation in which 
a warm-up time would not be required in a simulation model might be 
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when the model represents the start-up of a new factory in which the client 
happens to be interested in the first day of operation, or where the 
simulation represents a situation that starts each day empty, like a shop, a 
car park, or an airport.  However, even in these circumstances it might be 
preferable to separate off the results obtained during the early part of the 
day from the results under peak conditions because knowing the 'average' 
performance of an operation, which never works under ‘average’ 
conditions, is probably not worthwhile.  Calculating an appropriate warm-
up time is detailed in the Determining Warm-Up Period section on page 53.  

9) Model Exploration 
Model exploration can be considered the most important step in 
undertaking a simulation project. 

Traditionally the next stage in using simulation was to design and perform a 
series of experiments with the model to see how the factory could be 
improved.  Details of how to do this are in the next section, ‘Choose 
Scenarios and Run Trials’.  However, a much more important step in doing 
simulation (and one which only became possible when simulation became 
visual and interactive) is to explore the model visually with the client.  This 
gives both the model builder and the client the opportunity to gain an 
understanding of how the different parts of the model interact with each 
other, and how the performance measures can be affected, and to gain 
insights into how the system can be changed and improved. 

This 'visual exploration' is done by running the model and watching the 
products move around on the computer screen.  For example, it is possible 
to see where inventory builds up and under what circumstances it is the 
largest.  By changing the model and watching to see the effects, the model 
builder and client can gain knowledge and understanding of the way the 
system behaves.  It is possible to get to know, in detail, the characteristics of 
the system. 

Of course, exploring a model visually like this is not a rigorous or scientific 
testing procedure, and should always be followed by some careful tests.  It 
is much better at giving insights into how to improve the system, however, 
than a series of controlled experiments.  There are two additional, and 
perhaps unseen, benefits to these investigations.  The first is quickening the 
user buy-in.  The user will start to trust the model and seek to fully exploit 
its usefulness.  Secondly, these investigations get the user thinking ‘out of 
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the box’, leading to some ‘what-if’ investigations that can be radically 
profitable. 

10) Choose Scenarios and Run Trials 
Once some insights have been gained from working with the model it is 
important to test the resulting ideas. This is especially true if there are a 
number of competing ideas and it is difficult to see visually which is best.  
In order to do this, distinct scenarios in which some aspect of the 
simulation has been changed should be run and the results evaluated. 

It is important to remember that a simulation usually contains random 
numbers and if a week's production is being simulated, the results reported 
only apply to that one week (perhaps a lucky week when few of the 
machines broke down).  A different week might provide slightly or very 
different results.  For this reason it is important to run the model a number 
of times, and collect results, using a different random number stream each 
time. 

Importance of the Simulation Steps 
A simulation is a model of a system that is supposed to support the 
decision making process.  The decision may be a one-off decision, or may 
be one that is recurring and is part of day-to-day operations.  The model 
built should reflect the use for which it was designed.   

It is entirely possibly that in the process of building a model for a one-off 
decision, the client and the modeler may come to a decision before the 
model is even completed.  One of the most important things to realize 
about simulation in practice is that much of the benefit of simulation comes 
from the model-building phase of the study.  While building a simulation 
model, the model builder asks the client many questions in order to gain 
sufficient understanding of the process to build the model.  This 
questioning process has the benefit of structuring, in both the model 
builder’s and the client's minds, many thoughts about the process, which 
had not previously been pulled together.  The simulation model then acts as 
a logical piece of documentation about the process.  It is a ‘document’, 
which is extremely easy for most people to understand, being a moving 
picture of the process. 

This was realized during the first uses of visual interactive simulation in 
industry.  It was noticed that clients were very keen for models to be built 

 A computer 
simulation provides a 
risk-free arena to test 
various scenarios, so 
try many different 
situations including 
extremes.  
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for them, but often before the model builder was ready to formalize the 
experimentation process, the client wanted the model changed.  The act of 
building the model itself was sufficient in some cases to enable the client to 
see a new way of operating the plant that the client wanted to see tested in 
the model. 

The consequence of this is that the model builder will spend most time in 
the first steps of the above process, and only dip into the more technical 
steps occasionally.  It also means that the model building stage needs to be 
relatively easy and quick, in order to be able to be developed in session with 
the client.  This is the area of software development where most attention 
has been focused over the last few years.  

In the stage ‘Working with the Client’ above, it was stated that the stage 
continues until the client feels they know what is best to do, but there is 
another option that is becoming increasingly important.  Simulation models 
are now so easy to use that the client may want to be left with the model 
and use it regularly to manage their operation.  In this case it is particularly 
important that the statistical issues which were mentioned are understood 
by the client, and that the model is set up to aid them in dealing with these. 

Client – Model Builder Relationship 
Managing the relationship between the client and the model builder can be 
a complex task – but is important for the success of the project.  There are 
several steps in the simulation project where involvement of the client is 
highly beneficial.  This section will look at managing an effective Client – 
Model Builder Relationship. 

Hidden Agendas 
Every client of a simulation project has an agenda; this may be open or 
hidden, depending on nature of the relationship.  It is the job of the model 
builder to establish the true agenda or objective of the project.  If this is not 
done, it is possible for the client to steer the project to a preconceived result 
through selective disclosure of information pertinent to the project.  A 
good model builder should be capable of establishing the scope of the 
project without input from the client beyond setting the model objective.  
In this way, the model builder establishes what information is required to 
answer the question at hand. 
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Models are used to support decisions.  They should encompass all the 
information necessary to make the decision.  Determining what information 
is required is the key to exploring the important elements of the entire 
solution space.  If the model builder is not aware of client’s agenda, they 
may not seek out all information pertinent to the project, thus building a 
poor decision tool.  The model builder’s job is to produce a reasonable 
model of the system, which provides all the necessary elements and 
produces accurate results.  It is then the decision maker’s job to do what 
they wish with the information.  Agendas should be left out of the model 
and for this reason it may be necessary for the model builder to subtly 
manage the scope of the project.  

Managing Scope Creep 
Often during the course of a project, especially if this is the client’s first 
involvement with simulation, there is a tendency for the scope of the model 
building effort to “creep.”  Many a model builder has heard the words 
“Wouldn’t it be really good to see this area of the plant simulated…”  
Although it is great to have an enthusiastic client, in order for the project to 
be completed on time, and be successful, it is essential for the model 
builder to manage scope creep.  When the initial objectives of the project 
are not met on time, it is unlikely that funding will be provided for further 
projects.  Keep all extras for subsequent projects unless the payback for 
time spent is worth it. 

Communication 
Most modeling assignments should provide for periodic reviews of the 
work.  This should be an open forum for the model builder to test any 
views or conclusions about the answer to the model’s objective.  It is 
amazing just how far and how quickly a project can go off track if this does 
not take place.  Blind alleys can be fascinating places in which to carry out 
lengthy modeling assignments at the client’s expense in either time or cost.   

From a client perspective, it is reassuring to see that the project is running 
to schedule and that any problems are being dealt with.  But this is also a 
good time to discuss views and ideas with the end customer.  Whatever 
recommendations the model provides, it is important to have general 
acceptance of these early on within the project, or to establish that the 
objectives are unattainable.  Usually, it is better to give a client a hint of 
where the results are leaning before giving the actual results.  Allowing them 
time to get used to the answer will provide for greater acceptance. 
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Providing Acceptable Recommendations 
The solution space the model explores should have reasonable boundaries.  
When working with the model, the user must find appropriate answers 
within the current project scope.  These recommendations have to be 
acceptable to the client.  There is no point in explaining the 20% 
throughput that could be achieved with a state of the art machine that runs 
exponentially faster than anything currently owned, if there is nothing left 
of the capital budget.  That does not mean that recommendations should 
always be exactly what the client wants to hear, but should have been well 
thought out, considering all potential concerns of the client.  Alternatives 
should be provided for flexibility.  In order to accomplish this, it is 
important to understand the client’s concerns and comfort zone 
surrounding expenditure and change.  There is no reason why a comfort 
zone cannot be the subject of negotiation, but establishing it provides a 
framework from which to work.  A good client-model builder relationship 
should establish boundaries, and identify hidden agendas while meeting the 
project’s objective and deadline.  While this may not always be achievable, 
exploring the alternatives available and providing reasoning as to why they 
cannot work provides a good argument and understanding for the client. 

Focus on communication surrounding project objectives, ideas, plans, and 
recommendations.  This will provide a good grounding for a successful 
client-model builder relationship. 

Other Considerations in Model 
Development 
Including Financials 
Most simulation packages allow for some type of financial analysis.  This is 
because most system alterations will require capital expenditure.  The 
simulation must therefore provide a financial analysis for the return on 
investment (ROI) calculation.  Two types of cost can be taken into account.  
These are capital costs and operating costs.  By inputting information on 
the cost of running machinery, the resource costs, capital costs, as well as 
revenues generated from completed products, it is possible to generate a 
Profit and Loss Statement directly comparing two or three alternatives.   

It would be difficult to imagine attempting to purchase the correct number 
of automatic guided vehicle (AGV) units in a system that has variable shifts, 
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demand, reliability, and production rates, without the use of simulation, on 
account of the computational complexity of this problem. 

It is important to include financial information when assessing complex 
systems such an automated storage and retrieval system (ASRS) and AGV 
due to the variation in demand or operating performance. 

Some of the costs to consider for the simulated period are as follows: 

• Parts and Supply 

• Warehousing and Carrying Costs 

• Equipment Running Costs 

• Changeover Costs 

• Resource Costs 

• Capital Costs of Equipment, Storage, and Resources  

If there are no financial options within the simulation package, results can 
be exported or copied into a spreadsheet package for further development 
of a financial case. 

Coding Tips 
There are many ways to make coding easier: use generic names for looping 
purposes, create generic code that can be called multiple times throughout 
the model, and generate components and templates for re-use, as provided 
for by many packages.  The following are the three cardinal rules of good 
model development, and effective use of the project time: 

1. Make it general – Re-use of code will reduce model 
development time by 20-50% 

2. Use a naming convention – Time spent looking up names 
of objects, and de-bugging when wrong variables have 
been utilized in a certain piece of code, can be excessive. 

3. Comment, comment, comment – Much time can be saved 
by merely documenting development steps during 
development. 

 



Working with Simulation Simulation Overview  •  45 

Copyright Visual Thinking International 2007 

Make it General 
Developing a simulation model does not have to be a masterpiece, but 
there are some techniques that not only make it easier to understand, but 
speed up development time as well.  Keep it general.  Most simulation 
packages are moving towards Windows type copy and paste options.  So 
for example, if there are several production lines within a plant that produce 
the same work, create one general line.  Include all of the line parameters, 
write any code required, attached it to the appropriate areas, then copy.  It 
is also possible to have multiple references to the same piece of code.  
Using a single piece of referenced code saves a lot of time should that code 
need to be changed.  By changing just one section, it is possible to quickly 
reflect the change throughout the simulation model. 

Another example is a plant which has over 20 machines built by the same 
manufacturer.  They follow similar mean time between failure (MTBF) and 
mean time to repair (MTTR) patterns, so instead of inputting a distribution 
into each machine, create a generic distribution, and call it in all machines.  
If the distribution needs to be changed, a single change will be instantly 
reflected throughout the model. 

Using input spreadsheets is another method for quickly and easily updating 
the simulation model for different what-if analyses.  This requires more 
start-up effort, but is a worthwhile investment if several small alterations 
need be made, as they can all be made in one place.  This also provides a 
convenient single reference point for the scenario tested, as the spreadsheet 
clearly shows which parameters have been altered. 

Naming Conventions 
It is recommended that a naming convention be used when creating large 
simulation models.  By using a naming convention, it becomes easier to 
distinguish between variables and objects when using the internal 
programming languages of simulation packages.  Development time can be 
reduced since the variables and objects within the simulation are far more 
manageable and easily identifiable, when a naming convention is used.  This 
means that all different object types should have a discernable prefix.  A 
spreadsheet could be prefixed with ‘ss_’ (short for ‘spreadsheet’), or an 
integer loop variable that can be used anywhere could be prefixed with 
‘int_’.  Sections of code should also be given names following an 
appropriate naming convention.  Indeed, it is good practice to select a 

 Recommended 
naming Convention: 
lbl_ = Label 
dist_ = Distribution 
ss_ = Spreadsheet 
int_ = Local Integer 
gbl_ = Global Integer 
str_ = Text String 
obj_ = Object 
Variable  
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naming convention and apply it to the development of all simulation 
models across the organization.  This ensures that models constructed by 
different developers are more easily transferable. 

Documentation 
The majority of simulation users are intermittent users.  The software is 
usually purchased to help with a one-off decision, and is then shelved until 
another decision needs to be made.  Often model developers have a change 
of priority and may not even be able to complete work on their simulation 
model and have to pass the work on or go back to it at a later date.  As a 
result, many simulation models lie dormant for long periods.  In fact, the 
actual user-developer might change over this period, and therefore it is 
extremely important to document any simulation model.  What may be 
obvious to the current user at the time of development may not make sense 
to another user or even for that matter to the original developer in a year’s 
time.  To avoid duplication of work or long learning curves on subsequent 
projects, all simulation model developers should make use of the 
commenting or notes facilities provided by the simulation package.  If this 
facility is not provided, separate notes should be made on the model 
development, all keys areas of code, and specific object configurations and 
functionality of the model. 
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Chapter 2 Review and Questions 
Chapter Summary 

Simulation studies should generally follow a set of defined steps 
to ensure model validity and client satisfaction. In models built for 
a one-off decision, however, it is not unusual for the client to see 
the solution before all steps, especially the more technical ones, 
are complete. Looking further at how simulation is done in 
business settings, the model builder, whether an outside 
consultant or an internal expert, should be aware of some of the 
pitfalls of the client relationship. These include the possibility of 
hidden agendas, the tendency for clients to want to expand the 
scope of the project once it is under way, failure to carry out 
periodic project reviews, and the loss of trust that occurs when 
unrealistic recommendations are made. There are also technical 
considerations that the model builder should be mindful of. 
These include developing the financial side of the model 
(whether through internal financial functions of the modeling 
software, or through export to other applications), and good 
coding practices, such as using general, reusable code, using 
easily understood naming conventions, and finally remembering 
to constantly document the model, so the builder or someone 
who takes over at a later date can understand what the model 
does, and how. 

 

 

Test your Understanding 

Typical Simulation Study  

A Case Study 

Chatting with a friend, Bob, on the golf course, he begins to tell 
you about the headache that is his family’s business.  The business 
produces canned fruit for a variety of customers.  It has been in 
operation for years and the family has not invested in 
improvements to their operations in recent memory.  With your 
experience, you take some interest in his problem because you feel 
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you may be able to give him some direction and get him started on 
the right path. 

The canned fruit business has not been as lucrative as it was in the 
past.  Supermarkets can no longer get the same margin on the 
product.  This has tightened available profits through the entire 
supply chain back to the farmers.  In recent years, however, there 
have been some new, higher margin market possibilities opening 
up.  The largest growth has been in frozen and organic fruit. 

The traditional canned fruit market may still have a reasonable 
margin to be made.  Each contract with customers guarantees a 
certain proportion of high-grade fruit and different mixes of fruit 
types.  Bob figures that for each product run they overshoot their 
quality target by a large proportion.  Additionally, over the harvest 
season the price of the fruit can vary depending on supply and 
demand for fresh fruit.  The canning company pays the growers, 
not the end customer, so Bob feels this is an area in which they 
could improve. 

Bob also recognizes that there are potential process improvements 
that could be made.  The company has not taken the time to do 
involved time studies.  Management has little idea where there are 
underutilized areas or where the critical bottlenecks occur. 

The canners have little control over when fruit arrives at their 
docks.  They schedule growers to make drops on one of Monday 
or Tuesday, but they do not specify time of day.  This can cause 
congestion at the docks.  There is even the case that sometimes 
several loads come in just before closing causing the dock workers 
to work overtime.  On a few occasions, the production line has 
even become temporarily held up because of the lack of material. 

Bob has explained a little about why they over sell the high-grade 
fruit.  The fruit must be processed within 7 days of it arriving on 
the docks.  Bob will agree to buy a certain amount of fruit from a 
grower and pay a market price but this cost always needs to be 
adjusted because what arrives at the dock is never the exact 
quantity or quality that was agreed upon.  An additional 
complication is the limited capacity of the facility.  There are limits 
to the amount of raw fruit they can hold, processing capacity and 
finished product storage.  They do not have total control over the 
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mix and even if they get a fantastic price there is a limit to their 
ability to capitalize on the deal.   

Bob’s property is quite large; they have long had zoning approval 
to expand production.  He has reached a point where he feels that 
if the business does not change they will quickly lose all room to 
maneuver and may not have the resources to adapt.  Even worse, if 
several factors play against his business, he could eventually be 
faced with going out of business.  He is excited about getting into 
the organic or frozen markets.  The company already has 
relationships with farmers and the major chains.  Bob has still not 
convinced himself that they have the experience to tackle this 
problem; he is worried that he does not understand the processes 
fully.  The frozen food is bagged rather than canned and of course 
requires freezers, both technologies that Bob has never managed.  
Organic food product regulations require that the product be 
processed separately from the non-organic fruit.  Organic fruit is 
presently marketed differently than canned fruit; the product will 
demand a jarring capacity. 

Discussion: 

1. What is the problem? 

2. What is the required level of detail needed to address this problem? 

3. Which processes need to be modeled in detail?  Which can be 
approximated? 

4. What would be included in the rough model? 

5. Explain the importance of client involvement in different phases of the 
project. 

6. How long should the model run and what are the visual elements? 

7. Describe what set-ups and outputs could be used to verify the model’s 
accuracy. 

8. Model Warm-up time - how long would individual elements of this 
model take to warm-up before the numbers would represent the steady 
state numbers for the system? 

9. Model Exploration - what type of ‘what-if’ analysis would be 
performed with this model?  Who would be involved?  Remember this 
should help develop a set of scenarios. 
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10. Choose Scenarios and Run Trials – which and for how long? 

Managing the Client – Model Builder Relationship 

1. Describe features of a simulation model that could help you, the 
developer, support your client while at the same time keeping the 
model robust.   

2. If your client is pushing for the model to support one particular idea, 
you may, throughout testing the model, identify other potential avenues 
that may be reasonable solutions or identify potential problems with 
the client’s plan.  What preparation would you make before bringing 
these ideas to the table?  What would you do with the model? 

3. A project is underway and the client changes their needs – What would 
you suggest to them that they do?  

4. When would you start from scratch and who would be involved in that 
decision? 

5. When would you extend the scope of the project? 

6. When would you trade off certain model features for others, why 
would this be an advantage to the client, and how could this effect the 
evaluation of the project? 

 

Other Considerations in Model Development – Financial Considerations 

In order to answer these questions, refer to the online model entitled 
Financial at www.visual8.com/demonstrations.  

The first model, which uses SIMUL8’s Finance tool, contains four 
scenarios.  The user has the ability to choose which set-up is active and to 
see their financial effect.  The scenarios are as follows: 

Scenario 1:  No scrap 

Scenario 2:   Some scrap but also a higher revenue per piece 

Scenario 3:   Better trained workers, which cost more but incur 
less scrap 

Scenario 4: More expensive raw material and the same better 
workers, incurring even less scrap 
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Questions: 

1. What set-up will allow production at the lowest overall cost? 

2. What happens if the employees get a raise?  (Requires changing model)  

3. What if a different supplier supplies the parts – they are 10% cheaper 
but scrap is 10% more?  (Requires changing model) 

4. What if we now consider the cost of owning the building?  How would 
you add this to the model? 

5. How much part revenue would you need to generate to establish a 
profit if total overhead cost is the same as total raw material cost? 

In the second online model, there are two input streams of products.  Each 
stream has a different cost.  Work Centers 1 and 3 are grouped, as are Work 
Centers 2 and 4, such that only one of each pair is working at any time.  
This is the same effect as having different processing times and different 
pay rates for the two products at the same station.  There are two Work 
Exit points, each of which generates different revenue.  Workers A are 
required for line A and Workers B are required for Line B. 

Questions:  

1. In your accounting – what proportion of overhead would you attribute 
to product A?  Product B? 

2. How could you find the average profit per piece for the existing 
system? 

3. How could you set up the model to automatically calculate the profit 
per piece? 

 

Other Considerations in Model Development - Coding Tips 

Using only natural language statements, write example pieces of code that 
could perform the following functions: 

1. Count the number of rows in a spreadsheet. 

2. Calculate the average of several values in a spreadsheet. 

3. Set the processing time for a product depending on product type. 

4. Set the route out label. 
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5. Reference data in a spreadsheet. 

6. Calculate time in station. 

7. Extend function to calculate the cost for that process. 

8. Extend function to calculate the revenue and profit for that 
process. 

9. Extend function to record time and profit in detailed results report. 

10. Create code that updates input distributions (named distributions) 
from values in a spreadsheet. 
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Chapter 3:  Statistical 
Considerations 

A project is useful only when its recommendations are reliable.  Thus, the 
statistical validity of the inputs and outputs of the model must be assured.  
This chapter deals with the most important aspects of ensuring that a 
model produces reliable results. 

Determining Warm-Up Period 
Depending on the nature of the simulated environment it is most likely that 
a warm-up period is required for the model.  This is because there are very 
few processes that start each week with no work-in-progress (no work 
present at the different stations).  Systems such as call centers; a grocery 
store, plant start-up simulations, etc are the exception to the rule, as there is 
no work present in the system at the beginning of the model run period.   

Most simulation packages provide a facility to set-up a “warm-up” period 
during which the collection of statistics is usually switched off, or separated 
from the main results collection time. 

There is a simple procedure for determining how long this warm-up period 
should be, which shall now be introduced. 

1. Identify the key performance indicators (KPIs) for the system 
being modelled.  For example a KPI could be Jobs per Hour 
(JPH), the utilization of a machine, or the length of a queue 
specified in time-spent waiting.  If there is more than one KPI, it is 
important to carry out this procedure for all those measures of 
interest then use the longest identified warm-up period.  For the 
purpose of this example let’s assume the KPI is JPH. 

2. Run the model for a short period of time.  This ‘short’ amount of 
time is dependent on the system being simulated, but if the total 
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run period was a week, then a couple of hours should be adequate.  
It should be a sufficient amount of time to see items leaving the 
simulated system.   So having run the model for 60 minutes, record 
the number of products that have left the system.  Depending on the 
system being modelled this is quite likely to be zero.   

3. Run the model for another 60 minutes (or whatever time increment 
chosen) and record how many products left the system in the 
second 60-minute interval.  i.e. the JPH for the second hour – not 
the total at the end of 120 minutes.  Repeat until a table similar to 
Figure 3-1: Production Output is completed: 

 

Time Products 

60 
120 
180 
240 
300 
360 
420 
480 
540 
600 
660 

0 
0 
5 
41 
82 
23 
15 
22 
21 
16 
21 

Figure 3-1: Production Output 

This table should then be plotted against time, enabling a view of 
what is happening in the system: 

 
 

                                            
    1 This is the difference between the total output after 180 minutes 

and the total output after 240 minutes. 

    2 This is the difference between the total output after 240 minutes 
and the total output after 300 minutes. 
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Figure 3-2:  Output Chart 

By plotting the graph while running each subsequent hourly period, 
it will be possible to identify when there are sufficient plot points.  
In the example above it can be seen that there is a fairly distinct 
difference between the JPH recorded prior to 360 minutes and the 
JPH recorded after 360 minutes.  So the warm-up time for this 
particular system would be 360 and prior to that time the system 
was ‘warming-up’. 

Simulations attempt to model reality so a completely steady line will 
not be achievable or expected – however identification of a steady 
state is important.  The simulation will use random numbers to 
emulate the variability in the real world, so variability is expected. 

This example has been deliberately made clearer than often occurs.  
Quite often the performance measure being evaluated never looks 
at all stable.  Sometimes during the warm-up time the key measure 
is very high and sometimes it is very stable - becoming unstable 
once the model has warmed up.   It is important to identify a point 
in the model where the model emulates real-life. 

A judgement will have to be made from looking at the figures.  
With several KPIs it is easier to be more certain about where the 
warm-up period should be.  The principle is simply to ensure that 
the model is not in some atypical start-up state caused by the 
model starting from empty. 

4. Once a warm-up time has been established most simulation 
modellers will add 20% to it, to ensure that the model has achieved 
steady state before any statistics are collected.  The only potential 



56  •  Statistical Considerations Chapter 3 

disadvantage with a long warm-up time is that it can take up a lot 
of time when the model is running.  With today’s simulation 
packages this should not be too much of a concern. 

Remember when adapting the model further that significant changes to the 
model might affect how long it would take to warm-up.  Repeat the above 
process if the simulation model has been significantly changed. 

Determining Simulation Run Length 
Once a warm-up period has been established the next element of the 
simulation model to be determined is the appropriate run length.  A 
simulation contains random numbers and by simulating a specific period of 
time, the results apply to that period of time generated by one set of 
random numbers only.  The random numbers in this period’s production 
may have generated an exception; perhaps many machines broke down 
sequentially, and perhaps the bottleneck machine ran particularly well.  A 
different period might provide slightly or vastly different results. 

All simulation packages allow users to change the random numbers so they 
can also see what happens when the random numbers are different.  This is 
accomplished by allowing the user to set the 'stream' of random numbers 
that will be used.  Most packages have many thousands of 'streams' of 
random numbers built into them so there is no limit on the number of 
different weeks that can be simulated in the factory.  By running trials of 
events, the results produced from the simulation model will represent 
several weeks of production all with different random numbers.  To 
determine the length of the trial, please see Determining Simulation Run 
Length on page 56. 

So far one week’s production has been discussed.  However many 
simulation models are interested in a month, a year, or sometimes only a 
day or an hour.  Identifying the appropriate length of time is a function of 
the key performance measures used.  The simulation period should be 
appropriate for meeting the performance measures. 

Simulation run length is determined by one of two things.  The simulation 
is either modeling a specific period of time or it is modeling a steady state 
system.  When selecting a run length for the steady state system, the time 
required would be that to achieve statistical validity.  Please see 
Determining Simulation Run Length on page 56.  When modeling a specific 
time period, a run length that makes sense to the model objectives should 
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be chosen.  For example if a factory is modelled to determine whether it 
can meet seasonal demand, the factory can either be modelled for the entire 
year including all seasonal variances in demand and shift patterns or the 
simulation can be designed to model the factory for the peak demand 
period and the opening state can be set by the user.  These different 
approaches can be used to address the same issue. 

Random Numbers 
A simulation usually uses random numbers to generate timing for events.  If 
a week's production is being simulated, results will be seen that apply only 
to one week (perhaps a lucky week when few of the machines broke down).  
A different week might provide slightly or very different results. 

The procedure described here gives a step-by-step way to ensure the results 
are valid.  Even if the user does not feel it necessary to go as far as 
calculating the statistical validity of the results, the first part or the process 
should be performed and the simulation model run with a number of 
different set of random numbers. 

When using most simulation packages, if the time clock is set back to zero 
and the model re-run exactly the same things happen on the screen, in the 
same sequence as the last time it was run, despite the fact that the model 
contains random numbers to emulate 'real life'.  This is because simulation 
packages use 'pseudo random numbers' which are generated mathematically 
and simply appear to be random.  Each time the random numbers are re-
started, the same sequence of numbers will be generated.  This is very 
useful because it means it is possible to re-watch a model several times to 
understand exactly what is happening, without the issue being clouded by 
the random numbers changing each time.   

All simulation packages allow the random number streams to be changed in 
order to see the effect this has on the behaviour and output of the model.  
They do this by allowing the user to set the 'stream' of random numbers, 
which will be used.  Most packages have many thousands of 'streams' of 
random numbers built into them so there is no limit on the number of 
different weeks that can be simulated. 
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Confidence Intervals 
Example: 

A factory is simulated one week at a time and with each random number 
stream a different number of products are completed by the end of the 
week.  This information can be really useful to the client - but it has to be 
presented in a useful and valid way for it to be of genuine use.  This section 
is all about how to do this. 

At this point in a simulation study sets of results are collected in order to 
compare two or more alternative decisions.  In this example there are two 
alternatives and the simulation has been run 30 times for each of these 
alternatives.  For each run of one week plus warm-up time different 
random numbers were used and the following output figures obtained: 

Number of products leaving the factory in 30 different weeks 
(30 different random number streams). 

 Alternative   Alternative 

Week One Two  Week One Two 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 

293 
274 
196 
254 
203 
228 
234 
228 
300 
210 
234 
216 
218 
315 
239 

261 
264 
230 
287 
287 
316 
285 
257 
273 
334 
242 
320 
301 
292 
288 

 16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 

246 
189 
220 
229 
259 
273 
265 
248 
280 
232 
212 
238 
300 
287 
254 

271 
274 
285 
253 
265 
239 
298 
223 
319 
235 
260 
225 
188 
246 
298 

Figure 3-3: Output Variation 

The results for alternative one are as low as 189 and as high as 315 with the 
figures for alternative two being a low of 188 and high of 334.  Which is 
best?  The averages for the two alternatives are 245.8 and 270.5, so perhaps 
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alternative two is best.  There is so much overlap between the two that 
perhaps there is not really any difference between the two alternatives.  Can 
the client really justify spending the extra money that alternative two will 
cost?  What if the next 30 weeks (random number streams) average out the 
other way around?  What will the genuine long-term average really be? 

One option is to run the simulation model many more times.  However, 
often, if there is a large amount of variability in the process, this will not 
improve the predictability of the results. 

A simple statistical procedure can help here.  In addition to the information 
shown above, the standard deviation of the individual results can be 
calculated. 

 Alternative 

 One Two 

Average: 245.8 270.5 
Standard 
Deviation:

33.1 33.3 

Figure 3-4: Statistical Results 

But this calculation only provides the variability of the individual results.  
The main area of interest is in how the average figures differ.  If there were 
time to do another batch of 30 runs, would its average be different?  If the 
model were used to run 30 trials of 30 runs, what would the variability of 
the averages be? 

Fortunately there is a statistical relationship, which applies here, which 
provides a method of predicting the standard deviation of the averages from 
the standard deviation of the individual results - which has just been 
calculated. 

Standard Deviation of Averages = Standard Deviation of Results / 

√Number of Results 

In this case: 

Standard Deviation of Averages = 33 / √30 = 6 

Confidence limits for the average can now be calculated to report to the 
client.   
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As 95% of normally distributed numbers are within 2 standard deviations 
of their average then: 

95% confidence limits for our average  =  Average +/- 2 x 6 

     = 245.8 +/- 12 

     = 233.8   to 257.8 

      for alternative one  

and 

     = 270.5 +/- 12 

     = 258.5 to 282.5 

      for alternative two 

The results show 95% confidence that the true average for alternative one 
lies in the range 233.8 to 257.8 and also that there is 95% confidence that 
the true average for alternative two lies in the range 258.5 to 282.5.  So with 
95% confidence alternative two will produce more boxes in the long term 
(but not every week). 

A picture of this can be useful: 

 
Figure 3-5: Confidence Intervals 1 

Showing this type of picture to the client can help understanding especially 
when the numeric production count information is changed into profit or 
cost.  The above picture shows that it is just possible to distinguish 
(statistically) between these two alternatives. 

Of course, the picture might show the following: 

 
Figure 3-6: Confidence Intervals 2 
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There is an overlap between the two ranges, in which case the following 
two apply: 

1. It is not valid to distinguish between the two alternatives.  It is not 
reasonable to report any difference between them to the client 
because the average for alternative one could be as high as 257 and 
the average for alternative two could be as low as 254. 

2. More simulation runs could be done because (take a look at the 
way the range is calculated) the larger the number of runs the 
smaller the predicted standard deviation of the averages: so the 
smaller the range.  Of course this does not mean the two ranges 
will definitely separate by conducting more and more runs - it 
simply means that the figures are getting more and more accurate.  
The results may move towards something more like this: 

 
Figure 3-7: Confidence Intervals 3 

If this happened, it would show there is no difference between the 
alternatives. 

It is rarely necessary to do as many as thirty runs.  By conducting five runs 
and then doing these calculations, a clear idea can be gained as to whether 
five is enough or whether it is necessary to do more.  To summarize the 
procedure: 

1. Do five runs of each of the selected alternatives and each run using 
a different random number stream. 

2. Calculate the average and standard deviation for each of the 
alternatives. 

3. Calculate the 95% confidence limit ranges for each of the 
alternatives  

= Average +/-2 x Standard Deviation / √Number of Result 

4. Draw these on a graph like the one above to see which alternatives 
differ significantly from one another. 

5. If ranges overlap, do more runs to see if they separate.   
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A bit of statistical theory:  This procedure only works if it is known that the 
averages are going to be 'normally' distributed.  If there are at least 25 runs 
to calculate the average, this will then be the case.  Fortunately, for 
simulation users, this is usually the case for smaller numbers of runs, 
because when the individual run results are normal the average will also be 
normally distributed.  These are usually normally distributed because they 
are, themselves, the combination of a large number (more than 25) of 
individual events, for example, the times between products leaving the 
factory.  A statistical theory called 'central limit theorem' says that any 
number which is the total (or average) of a large number of other numbers 
will be normally distributed, whatever the distribution of the original 
numbers. 
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Chapter 3 Review and Questions 
 

Chapter Summary 

Obtaining valid results from a simulation model is dependent on 
understanding some of the key features of simulation software. 
Without specifically putting Work Items throughout the model, in 
a manner consistent with reality, most simulations will need a 
warm-up period. While some systems start empty at the 
beginning of the day or week, which is the start point of the 
simulation run, most have work in process at this time. It is the 
function of the warm-up period to put the simulation into a 
statistically valid condition before results are collected.  Likewise, 
selection of a run period is critical to getting valid results. This is 
especially true if there are long-term or seasonal variations in 
demand or performance that must be accounted for. Since the 
variation in a simulation model is the result of using pseudo-
random number streams, it is important to make an adequate 
number of runs with different streams, in order to understand 
where the probable system averages and other measures of 
performance really lie. This is especially important when 
comparing alternatives. It may be necessary to calculate 
confidence intervals for results, in order to determine if the 
alternatives are actually distinguishable, before selecting one 
over the other. 

 

 

Test your Understanding 

Statistical Validity 

Case Study 

A typical decision in a factory environment that requires some 
treatment of statistical certainty is the purchase of equipment.  
Machines from different manufacturers or models will have 
different properties.  Some machines will produce more scrap.  
Some take longer to repair than others.  Some will breakdown 
more frequently. 
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A continual headache in the factory is Machine X.  It is the 
bottleneck in the process.  If it is fully operational and producing 
good material, it is capable of meeting the demand.  However, 
demand is not being met and something needs to be done. 

Unfortunately, the machine seems to be plagued with problems.  It 
is not entirely reliable and produces a certain quantity of scrap. 
Adding another machine would seem a clear choice but is not a 
possibly because of space limitations.  The only other choice 
appears to be replacing this machine with one that is more reliable.   

By talking with sales associates from various companies, a 
replacement machine that is claimed to satisfy the plant’s needs is 
found.  Fortunately, there is the opportunity to verify the 
manufacturers claim.  Another facility in the organization uses this 
machine and has been keeping detailed maintenance logs. 

A simple simulation model was built to illustrate the statistical 
analysis of this problem.  On the top is the line set-up to run as the 
manufacturer claims.  The second line uses probability of 
breakdown, repair time and scrap numbers from the other facility.  
The last line is the current line operating in the factory. 

Discussion: 

1. Does the simulation support the manufacturer’s claim? 

2. After 10 trials is there conclusive evidence that the machine from the 
other facility is significantly better than the current machine?  What 
about after 40 trials? 

3. What would the new machine be worth to the organization?  What 
additional features could influence your decision? 

4. Describe a different problem in which the statistical validity of the 
simulation could be a critical feature.  

 

Warm-up period 

1. What would be the difference between results with a warm up period 
and results with no warm up for:  

• Efficiency of a workstation? 

• Average time in system? 



Statistical Considerations Simulation Overview  •  65 

Copyright Visual Thinking International 2007 

2. For each of the following cases identify 3 Key Performance Indicators 
(KPI) and give a reasonable estimation of the warm-up period required 
for the system and give an explanation of this warm-up (making 
reference to those KPI’s). 

Power plant: 

• A system of conveyors transports the supply of coal from the coal 
yard to the boilers. 

• The coal is fed into furnaces and, over a period of time, will heat 
up and begin to produce steam.  Steam is then moved through 
high-pressure pipes to turbine generators. 

• Generators coming on line and off line as, demand changes, 
scheduled and unscheduled maintenance, etc. 

• Daily and weekly there are differences in operations across the 
facility in shifts; coal deliveries etc. 

Car assembly Factory: 

• Each station has a cycle time less than or equal to 48 sec.  

• 75 stations 

• 170 pallets that are recycled through system (two different types in 
different areas of the factory). 

• Damaged parts are inspected and a decision is made if they are to 
be reworked or scrapped. 

• Shipping is done by rail and receiving uses both rail and trucks. 

Emergency Room: 

• Daily arrival rates for different admittance codes. 

• Different admittance streams – walk in and ambulance. 

• Patients who are admitted need to be moved to empty beds in 
other wards.  Beds in these wards are freed only when their doctor 
discharges one of the existing patients (doctors are in the hospital 
at various hours). 

• Availability of tests – technicians may work different hours. 
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Simulation Run Time 

For the following cases, identify two potential problems the manager may 
wish to simulate.  Describe the problem and give an explanation of what 
run time you feel would be appropriate.  Determine if it would be a better 
option to run for several periods or to run repeated trials of the same 
period. 

  Major Hardware Retailer 

This retailer wishes to analyze its supply chain.  They suspect that 
they could work on improving their supply chain to reduce the 
inventory they carry.  The business carries a huge array of products.  
These products range from high cost to low cost, high volume to 
low volume and can be very large to very small.   

They also feel that they could gain market share by making their 
seasonal sales more attractive (i.e. fertilizer or artificial Christmas 
trees).  In order to do this, they must have lower advertised prices 
than the competition and must avoid stock outs during these 
special offers. 

 

Ski School 

The managers of a ski school at a major Canadian ski resort have 
an agreement with their instructors that they will give them a 
schedule of their hours for the upcoming week every Saturday.  In 
order to meet the demand of their customers the ski school must 
have enough instructors on hand.  However, demand is largely 
variable.   

The ski school has identified several factors that they suspect may 
have an effect on the demand.  A shortened list of those factors is 
as follows: day of week, date, exchange rates, snowfall, forecasted 
snowfall, the temperature, and potentially even the terror alert 
level. 
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Business Applications  
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This section focuses on the application of simulation to a variety of 
business issues.   

The role of simulation in business has grown significantly over the past ten 
years with the advent of cheaper, flexible, and more intuitive software 
modeling tools available on the market.  In the past, simulation was a tool 
far too cumbersome to be used on a widespread basis.  It is useful to 
understand how simulation modeling evolved, where it was used, and why it 
has become such a popular problem-solving tool.   

There is a significant amount of literature that describes the early days of 
simulation.  Available simulation packages were both costly and difficult to 
program.  Simulation analysts would spend weeks and months putting 
together models that were approximations of the real system.  These 
relatively inflexible models were slow in execution and limited in results.  
Much of their time was spent on the graphical animation of the system as 
opposed to the underlying procedures and controls.  Results were churned 
out by large mainframes in the form of reams of numbers to be translated 
by mathematicians into terms and results understandable by the decision-
makers.  Aids such as a physical model of the real system, which would be 
manually updated to show the results of the simulation, were helpful but 
extremely cumbersome methods used to communicate the output from 
these computer models.  In spite of their shortcomings, these models were 
valuable for both selling new or modified manufacturing designs to 
management and for proving systems before they were built.  Therefore, 
simulation was successfully employed in increasing the understanding of a 
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complex interdependent system in order to reduce risk and increase 
performance. 

With the advent of capital-intensive factory automation in the automotive 
industry and general manufacturing in the late 70’s and early 80’s, the value 
of risk avoidance and efficient design was paramount.  At the same time, 
the first visual interactive simulation products – See Why, Foresight, 
Siman/Cinema, and AutoGram – emerged onto the market.  These early 
simulation-modeling tools provided the analysts/engineers with simplified 
means of producing graphic animations of a system.  The combination of 
these two events spurred management’s interest in this technique for 
examining the design and workings of complex and costly manufacturing 
systems. 

Since that time, simulation-modeling products have advanced significantly 
due to both computer hardware and software developments.  The 
performance of these modern-day tools, such as SIMUL8, far outstrips the 
speed, ease-of-use, flexibility, and graphical animation capabilities of their 
earlier counterparts.  Their range of application has also broadened from 
the design of systems outside of the manufacturing world into the service 
sector and general business processes.   

The following sections of this book provide an overview of how simulation 
is being used in a number of key areas – manufacturing, the service sector, 
supply chains, production scheduling and control.  Each section includes a 
number of case-examples with viewable simulations to demonstrate the 
benefit of this approach in these areas.  For most worked examples there 
are SIMUL8 models available for download from the following page: 
www.visual8.com/demonstrations.  
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Chapter 4:  Manufacturing Case 
Studies 

Overview 
The complexity of manufacturing operations today requires more than a 
CAD drawing or process layout of the facility to understand the behavior or 
performance of the system as it may operate under various changing 
conditions.  Availability of equipment, materials, people, storage space, and 
rules of operation, all add to the difficulty of predicting the output of the 
system.  However, management needs a way to understand how a complex 
process will operate under alternative plant designs to ensure that financial 
and operational targets can be met reliably before proceeding with 
construction of the facility.  Similarly, to analyze an existing process and 
identify areas for improvement or expansion, decision-makers need a means 
to “play” with the existing system off-line and examine the before and after 
effects of potential changes to the system.  

Spreadsheet analysis, while good at static problem solving, cannot capture 
the dynamic interdependencies of products, resources, and equipment over 
time.  Understanding the rate of flow of products through a series of 
machines with different change-over times, processing times, and materials 
handling requirements requires a discrete-event simulation to show the 
workings of the process.  CAD drawings are helpful in defining the layout 
of the manufacturing process with the proximity of machines, storage areas, 
and materials handling systems, but they fail to show the product flow 
through the plant, the use of resources, and the use of buffer areas over 
time.  But what if we could import the CAD drawing and show an 
animation of the workflow according to the process rules and resource 
availability?  This is now available with simulation tools such as SIMUL8.  
Several examples will demonstrate how this has been accomplished. 
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There are many areas in manufacturing that can benefit from the use of 
simulation - from the design of new processes and the review and 
improvement of existing operations, through to the adaptive planning and 
scheduling of work within a production environment.  The range of 
simulation applications in this area are manifold but there are a number of 
common areas of use such as facilities design, capacity planning, quality 
control and reliability analysis, process improvement, and more recently 
real-time planning and control. 

The benefits of simulation applied in these manufacturing areas include 
cost-avoidance, reduced commissioning ramp-up period, increased 
throughput, reductions in production costs, lower inventories, and 
increased customer service levels.  Using simulation to support the 
execution of production schedules through shop-floor monitoring and 
adaptive controls has also led to significant plant performance 
improvements.  

The following examples are provided to show both the value and utility of 
simulation applied to general manufacturing applications.  They serve to 
highlight the scope of these models, the type and source of data inputs, the 
various screen displays, and importantly, the results that can be derived 
from these simulations.   
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Case Study: Automated Lines 
Background 
In the early days of simulation, platforms required a large amount of user 
knowledge and the outputs were less than visually appealing.  Many 
manufacturers that were using simulation in its previous forms had bad 
experiences with the technique as it proved expensive and difficult to use.  
In recent years, some of these early users have been picking up the 
technique again with the advent of easy-to-use software and changing 
attitudes towards the technique.  Visual interactive simulation has been 
instrumental in helping to make the technique mainstream. 

One furniture manufacturer reintroduced the use of simulation in the 
nineties, as it became more intuitive and yielded valid results.  One of the 
main reasons for taking up the technique again was the ability of the user, 
with minimal training, to visually see the interaction of subtle process 
variations, particularly in the area of product mix analysis.  Software 
advances permitted the user to actually simulate the production lists in 
exactly the same sequence as they would run on the machines. 

Problem 
An office furniture manufacturer wished to evaluate complex processes that 
existed in the plant involving multiple Work Centers or production cells, 
comprised of any combination of machines working together.  Simple one 
or two machine cells operated by a single operator can normally be 
evaluated mathematically and tend to be intuitive in nature.  However, the 
area of interest, the press line, has many systems working together.  The 
interaction is a dynamic relationship, impacted by several factors in addition 
to having high manual labor content.  The effect of the manual involvement 
is most influential on throughput when it is at the infeed to a machine or 
cell.  Manual unloading of a machine has fewer variables since the process is 
regulated by the pace of the machine.   
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Analysis 
A simulation was designed to investigate the output requirements of a new 
automated short-cycle through-feed press line that produces both HPL and 
wood veneer products of multiple thicknesses for five subsequent 
production lines and cells.  These production lines or “customers” operated 
at different operating speeds and produced a wide variety of products.  The 
average output of these lines was material for less than 10 products, 
resulting in continuously changing demand on the press line. 

To perform a valid simulation of machine lines, it is necessary for the 
engineer to have a detailed understanding of both the equipment and the 
realities of the shop floor.  Factors affecting throughput, such as 
breakdowns, paperwork, tool changes, and material handling, all must be 
defined and entered into the simulation to yield valid results.  

Recommendations 
Simulation modeling offered the ability to simulate the “customers’ 
demands” from actual production runs and develop the demand on the 
press line in a pull-through process.  Once the demand was developed for 
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the press line, required cycle times could also be determined.  These 
required cycle times then became the basis for the design of the automation 
of the lay-up as well as infeed and outfeed designs.  This is an example of 
using simulation not only to evaluate an application, but also as an aid in 
defining and evaluating design criteria. 

The same model was also used to determine conflict areas for the infeed of 
the multiple cores, faces and backers being used, as well as to define the 
required sizes of work-in-process surge areas between the press line and its 
“customers.”  The conflict (contention) areas, as well as surge area issues, 
become apparent as soon as the animation is run.  Data that defines the 
magnitude, frequency and duration of any conflicts is collected by the 
program over the length of the run simulation and this information can 
then be used to run “what if” variations as an aid in resolving any issues. 

Payback for equipment implemented in this example was just under three 
years. 

Simulation was also used internally by the company as a sales tool when 
competing for capital funding.  It provided the ability to show management 
and union leaders process alternatives and results, in both animation and 
numbers. 

Discussion 
1. What are the key performance indicators that this simulation is 

designed to examine? 

2. What is the most efficient way of simulating the “conflicts?” 

3. Once the demand for the press line has been determined, what are 
some methods of inputting this data into SIMUL8? 

4. Name another industry that can be simulated using an identically 
structured simulation model. 
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Case Study: Cell Manufacturing 
In the world of cell manufacturing, different facets of an operation affect  
one another in interdependent ways.  For this reason simulation is an 
excellent tool for analyzing how manufacturing cells operate.  Whether the 
issue is establishing design proof or the method of cell operation that will 
satisfy the necessary operational requirements, simulation captures the 
necessary variables.  

 

Background 
One common issue is the allocation of resources to different tasks within a 
cell.  A major Midwest automotive parts manufacturer is having trouble 
meeting demand.  The specialized parts that it produces preclude the sole 
use of production robots and require human operators.  The company 
assumes that more operators would decrease cycle time and increase 
throughput.  They have chosen to use simulation to address the allocation 
of staff to the manufacturing cells.  Although the problem is extremely 
difficult to analyze in a static environment, it is a simple simulation model. 
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Problem 
The company’s allocation options include the following choices: 

 Assigning operators to a particular Work Item and following it 
around the cell, 

 Randomly assigning operators to the next Work Center requiring 
operation, and 

 Allocation of resources/operators to individual operations within 
a cell.   

The challenge is to select the option that maximizes the company’s ability 
to meet demand. 

Analysis 
For this case study, assume that there are six operations within a cell and 
two operators, so the options are limited to the first two on the above list as 
there are insufficient operators to staff the entire cell.  Assigning each Work 
Item to a particular Resource ensures minimization of cycle time to 
complete each individual Work Item, whereas allowing the resources to 
move to the next available operation maximizes Resource utilization, 
especially if any of the stations within the cell only require loading and 
unloading by the operator. 

In this example, we will assume that only one automated station, Station 30, 
requires load and unload by the operator.  The simulation in this example 
has the following parameters: 
 

Scenario  Station 
10 

Station 
20 

Station       
30 

Station 
40 

Station 
50 

I 20 25 30 20 23 

II 20 25 5(R), 20, 5(R) 20 23 
Figure 4-1: Cell Manufacturing Simulation Parameters 

In Scenario 1, attach the operator to the Work Item as it moves around the 
cell.  See the reference section topic  
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Resource on page 197 to learn more about this.  Scenario II, would allow 
any operator to work on any Work Item at any station at any time.  This 
scenario, which breaks out the unload and load functions at Station 30, 
means that the operator is not required to remain at the Station as it 
processes work. 

 
Figure 4-2:  Cell Manufacturing Simulation 

Recommendations 
The Key Performance Indicators for this simulation study are Jobs per 
Hour, Cycle Time, and Resource Utilization.  The following provides a 
summary of the simulation results: 
 

Scenario 
# 

Average      
JPH 

Ave. Cycle 
Time 

Resource 
Utilization % 

I 60.75 119.22 99.89 

II 94.88 169.42 97.62 
Figure 4-3: Cell Manufacturing Simulation Results 

It is possible to see from the results above that although, in Scenario II, 
parts will remain in the system longer as they wait for a Resource, the 
overall throughput of the system will increase by 56%. 
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This model is available for download at www.visual8.com/demonstrations. 

Discussion 
 

1. What manufacturing KPIs are represented in this model?  Which 
perform better in Scenario 1?  Which perform better in Scenario 
II? 

2. Some of the results of this model seem contradictory.  Explain. 

3. Which policy would you suggest in the following scenarios: 

a. The product is very delicate? 

b. The turnaround time required is very tight? 

c. The margin on each part was very low? 

4. This model uses fixed processing times to illustrate the impact of 
different policies more clearly.  What would you expect to find if 
there was some variability around the processing times?  Change 
the model and test your assumptions.  Does the utilization on 
Scenario 1 stay the same? 
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Case Study: Quality Control/Rework 
Although Six Sigma is used across virtually every industry today as a 
problem-solving approach, its birthplace was in the manufacturing 
environment.  More specifically, the methodology was used to measure 
quality and its effect on system output. 

The following simulation example models a manufacturing facility in which 
quality is an issue.  It includes a rework loop after a quality control 
inspection process.  Although the process is simple, the effects of quality 
control initiatives may not be apparent through quick back-of-the-envelope 
calculations.  Instead, a simulation model allows the user to evaluate the 
effects of a probabilistic event on the system.  This event can range from 
inherent variability in the process to machine breakdowns. 

Background 
The simulation focuses on a specific set of operations (metal stamping and 
trimming) as part of a greater manufacturing process.  Pieces of sheet metal 
that have been prepared from upstream operations are stamped at a press 
machine and then trimmed.  Some of the pieces, however, are not trimmed 
perfectly and must be inspected to identify this flawed work then sent back 
for rework.  If the pressed and trimmed parts are of sufficient quality, they 
are packed and shipped.  Each operation in the process has a certain labor 
and energy requirement and thus, costs can be associated with each process 
as well as estimated revenue for each piece shipped.  The problem is to 
determine the costs and benefits of different levels of quality of the press 
machine. 
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Figure 4-4: Quality Control Example Screen Capture 

Analysis 
The simulation model is non-complex.  Processes are inline, each has a 
respective buffer, and cycle times are normally distributed.  The rework has 
been implemented by routing out of the Work Center with the percentage 
discipline (See Route Out Percent on page 268).  A specific percentage is 
sent to Packed and Shipped (a Work Exit Point) while the rest of the Work 
Items are routed back into the queue for the Trim Machine to be reworked 
– hence a Rework Loop.  

The custom dialog box in the Controls menu is available for quick changes 
to the percentage of imperfect parts to evaluate the effects of various levels 
of quality on the specified performance measures.  Additionally, the 
Finance features are used to provide an economic analysis of the system.   

The simulation may be run multiple times (a trial) to obtain more 
statistically significant results than those obtained through a single 
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simulation run.  Scenarios with 90% and subsequently 95% quality parts 
were tested in trials to obtain the following performance results.   

 

 
Figure 4-5: Quality Control Example Results Comparison between Trials 

 on page 321)  

 
Figure 4-6: Quality Control Example Finance Results 

In terms of bottom line, the change in the percentage of items that require 
rework results in a positive income instead of the predicted loss. 

 

 

 

This tells the user 
that a quality 
initiative would cut 
the system’s WIP in 
half as well as 
increase the overall 
throughput.  
Financial results 
were obtained using 
the Finance feature 
within SIMUL8.  
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Recommendations 
The simple manufacturing simulation example above provides a strong 
economic, operational, and visual argument for any decision-maker to 
justify the implementation of a quality initiative within this production 
process.  The simulation was useful for predicting how the system would 
react under various scenarios.  The ability to simulate and analyze a rework 
loop is particularly valuable for Six Sigma professionals.  The above 
example would be used to test out several scenarios during the 
Improvement Phase of the Define, Measure, Analyze, Improve, and 
Control cycle.   

 

This model is available for download at www.visual8.com/demonstrations. 

Discussion 
1. Does the simulation run long enough to determine if the system is 

going to be profitable in the long term?  How do you know? What 
is an appropriate length? 

2. What are the key performance indicators that change when process 
reliability is improved? 

3. What are the increased costs of the QC initiative? 

4. What do you think is the best way of presenting the results? 

5. Expand this model to send all pieces that do not pass inspection 
the first time to a special rework bin and only draw from it when 
the operation is starved of work.  What is the maximum level the 
bin reaches? 
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Chapter 5:  Service 
Industry/Business Process 

Overview 
Outside of manufacturing there are a wide variety of applications wherein 
simulation can be applied.  This section discusses a major group, namely 
service and business processes.  Included are areas such as the processing of 
applications or transactions in a bank or insurance company, the handling 
of calls within a call center, the treatment of patients in a hospital or clinic, 
and the serving of customers in a retail operation.  Indeed, a significant 
proportion of simulation work today relates to non-manufacturing 
applications.  

With the emphasis shifted more on people and procedures rather than 
product and machine routings, business process simulations are being used 
to streamline delivery and service systems.  These models can be used to 
investigate staffing requirements to satisfy projected customer demands; to 
examine alternative ways of processing applications or requests; to measure 
the impact on the system of changes in policy and procedures or with the 
introduction of new technologies such as image processing or ATMs in a 
bank. 

Simulation in business services is a fast growing field because it can look at 
more efficient ways of handling transactions or servicing customers with 
the emphasis on service levels and processing costs.  Extending the 
business analysts process mapping and documentation tools with the 
capability of simulating the process adds greatly to the questions that can be 
addressed.  Business process simulations help to show how efficiently 
documents flow within an office system, how people are utilized, the level 
of customer service that can be attained, and most importantly, the cost of 
doing business and the opportunities for improvement. 
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To define a service process, decision-makers typically draw a map or flow 
chart of the process using tools like Visio or ABC Flowcharter.  Much like a 
CAD drawing in plant layout applications, this information only provides 
part of the story.  On its own, it does not help determine the volume of 
work a set number of staff could handle, nor does it show the physical 
layout of the process.  Simulation of the process can reveal the flow of 
work through the system with the utilization of staff or equipment and the 
timeliness of the service being delivered. 

SIMUL8 offers a link to a number of popular flowcharting packages that 
can speed up the time required to define the process steps within the 
simulation model.  In addition, the product allows the user to specify the 
cost of the service being delivered at each step of the process.  Simulations 
of fast food restaurants, tollbooths, emergency clinics, gas stations, call 
centers, car service shops, and government departments are all examples of 
valid and useful applications. 

The following examples help to demonstrate the diversity of business 
process and service industry simulations.  They are a small set of case 
studies drawn from our experience with a wide range of companies in the 
service sector and they highlight the emphasis on modeling demand profiles 
and service costs. 
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Case Study: Call Center 
 Call centers have been an interesting area for simulation modeling over 
recent years.  The financial constraints of keeping costs reasonable factored 
against outside pressures to meet service level agreements, and the threat of 
lost business from poor performance put the system’s managers under 
scrutiny.  The goal of any call center investigation is to learn what staffing 
level, schedule, and training is required to meet the expectations of the 
system’s performance. 

As simulation packages become more generic in nature, it has become 
easier to build simulation models of call centers.  Several tools exist to assist 
in the planning of call centers, but simulation provides an excellent method 
for quickly and relatively simply creating an accurate representation of the 
real flow of calls, agent utilization, and performance standards, while getting 
around the limitations of static analysis tools.   

Most simulation packages provide a call center template that allows the user 
to build their call center through build wizards.  The wizards provide 
structure to the problem, which speeds up the development time.  The call 
center problem is a relatively common application of simulation and is 
easily understood, so often the template requires minimal additional work 
to model the specific problem. 

Typical studies on call centers have included the following: 

 Justification for less or more staff across a daily, weekly, or 
monthly profile; 

 Revisions of shift patterns and break allotments; 

 Acceptance of new call types based on identifying extra capacity; 

 Training of personnel for multiple skill types; and 

 Justification for more trunk lines to ensure no lost calls. 

As operations grow and business environments change, managers are 
required to evaluate issues such as the following: 

 Increases in call volumes, 

 Increased call mix, 

 Improved customer service level requirements, 
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 Call escalation, and 

 Outbound / Inbound Combinations. 

All call center simulation models will have a similar set of input and outputs 
required.  Inputs are as follows: 

 Call Arrival Patterns, typically expressed as calls per hour, half 
hour, or quarter hour. 

 Staffing Shift Pattern 

 Call Types and Profiles 

Outputs: 

 Service levels profiled across the simulation period – expressed as 
# of hang-ups, lost calls, and calls serviced within service level 
target. 

 Agent Utilization profiled across the simulation period – match 
over-utilization periods with lost calls, and poor service. 

 
Figure 5-1: An Example Call Center Simulation Model 

Most simulation studies on call centers will include more detailed 
information, such as the following: 

 Average customer wait times by call type, 

 Trunk Line capacity, 
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 Call escalation, and 

 Outbound calling. 

Background 
A call center for a growing IT firm provides technical support for the firm’s 
products including its brand new line.  As an expanding IT firm, it is crucial 
to develop a good reputation for outstanding customer service.  Thus, one 
of the company’s main objectives is to ensure that no calls are lost.  The 
secondary objective is to ensure that service levels are met across all call 
types within the center.   

 
Figure 5-2:  Abandoned Calls across a Daily Profile 

Analysis 
Data described above was input into the model for simulation.  The model 
was then validated, ensuring that it actually reflected the call center.  The 
following issues were analyzed: 

 Can the system handle an increase in certain call types? 

 Under what conditions does the system lose more than 20 callers 
per day?  

 If a different mix of trained staff were available, would the center 
meet service level targets? 
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By studying an incoming work profile, it is possible to correctly predict staff 
requirements by skill type to ensure sufficient availability such that the 
target service levels at the service center is met. 

 
Figure 5-3: Service Levels Profiled across a Simulated Day 

Recommendations 
Results from the model demonstrated that trunk capacity does not need to 
be higher than approximately 25 lines, for the given incoming call profile.  
As this is the case, more than 25 total staff members would be superfluous, 
assuming they are all capable of handling the various types of calls.  In fact, 
increasing the abilities and skills of operators is clearly shown to lower the 
number of staff necessary. 
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Discussion 
1. What increase in call volume (even proportion across the call types) 

can the model handle before the total lost calls reaches 10?  What if 
trunk capacity was increased by 3? 
Starting with the default call volume, what possible changes to the 
set-up would cause the system to lose more than 20 calls? 

a. Different mix of staff? 

b. Different service times? 

c. Different caller tolerance times? 

2. If a contract says that you can handle x % of the customer calls 
within Y amount of time Z % of the time, what service level can 
you guarantee for Call A? (hint: look at Work Complete Results) 

a. Now increase the caller tolerance time by 50% and state 
the new statistic. 

3. Change the caller tolerance time back and decrease the service time 
by 25% and state the new statistic. 

4. If the client is expanding the organization and expects that call 
volume will increase by 5%, how would you change your set-up? 

5. What if the company also wanted to decrease the expected time in 
system by 10%? 

6. How would you augment the financial aspects of the model to 
improve its results? 
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Case Study: Process Simulation and 
Six Sigma 
Six Sigma has become a very popular process improvement methodology in 
recent years as demonstrated by GE and many other leading organizations.  
The Black Belts’ approach to Define, Measure, Analyze, Improve, and 
Control processes has been successfully applied to a wide variety of 
business and manufacturing processes.  Static analysis tools like Statistical 
Process Control are effective for supporting operations that are relatively 
simple and easily observable.  However, in cases where the process is more 
complex with interdependent operations, Six Sigma professionals are 
turning to Process Simulation.   

 
Figure 5-4: Services Simulation Screen Capture 

Process Simulation lets the user capture and display the inner workings of 
operations no matter how complicated the system.  It is similar to Process 
Mapping in that it provides the visibility often required to understand 
involved processes.  Simulation, however, contributes another valuable 
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dimension to this Quality Tool by being able to demonstrate the effects of 
modifications to the system dynamically.  The following example shows 
when and how SIMUL8 can be an effective Process Simulation tool to 
address these time-dependent issues. 

Although Process Simulation is another potential tool within a Black Belt’s 
kit, not all Six Sigma projects require the technique - knowing when to 
apply simulation is crucial.  Here is a simple guide: 

• If the process is complex and provides little or no visibility for 
review, simulation provides the opportunity to observe and analyze 
the working system. 

• If a process has many decision variables such as product types, 
routings, resources, shift-patterns, task times, or rework, simulation 
offers a dynamic platform to examine the performance of the 
system and to determine how it can be improved. 

Background 
Claims processing at a workers’ compensation center is an appropriate 
application of this simulation approach.  The process provides little to 
observe, has intricate routings, and alternative processing rules based on the 
claim type.   

 
Figure 5-5: Services Simulation - Process Map of Claims Processing 

Problem 
The goal of the study was to identify and eliminate constraints within the 
operation.  In the process shown above, the proportion of claim types 
changes daily, but it is not immediately apparent that the bottleneck in the 
claims process continually shifts.   
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A Process Simulation of this claims processing center can assess the system 
as a whole to evaluate current operational Key Performance Indicators 
(KPIs) and to verify the impact of changes to the entire system’s 
throughput. 

One KPI of the process is the application turnaround time – target 90% of 
claims in less than 15 days.  Other KPIs are the average number of claims 
in the system (target under 15 cases), Resource utilization, and claims 
processed (target 140 payments).  The simulation allows us to measure 
these indicators directly. 

Analysis 

 
Figure 5-6: Services Simulation Results 

After simulating the process, it was discovered that the claims processing 
center could only complete an average of slightly over 120 cases with an 
average of 18.66 open claims and only 38% completed in less than 15 days. 

 
Figure 5-7: Services Simulation Scenario 1 Results 



Service Industry/Business Process Business Applications  •  93 

Copyright Visual Thinking International 2007 

Several scenarios were tested using the simulation, such as changes in case 
process times and increasing number of resources available, but these had 
little to no impact on the KPIs.  Instead, results indicated that the mix of 
claim types had the most significant effect and, in particular, the volume of 
Type 3 claims. 

A suggested improvement to the process was to use a dedicated team to 
handle all Type 3 claims.  To test this, a simple change to the simulation 
model was made to replicate this scenario.  Then a trial of 20 runs was used 
to obtain the confidence limits as shown below.  

 
Figure 5-8: Services Simulation Multiple Run Trials Results 

The results from the simulation could also be exported to Minitab™ for 
further post-processing analysis (Results > Results Export > Minitab). 

Recommendations 
The process change had the net effect of decreasing the total claims 
processing time for all three claim types and, through familiarity of claims, 
was expected to reduce the number of staff required. 
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Figure 5-9: Services Simulation Minitab Export 

The turnaround time no longer exceeded 13 days and now averages less 
than 10 days, with a reduction of average open claims to 5.7 and 
throughput in excess of 150 cases!  

 
Figure 5-10: Services Simulation Scenario 2 Results 

The value of Simulation lies in its ability to dynamically show the entire 
process in operation.  Running “what-if” scenarios quickly revealed the 
relationship between process times and the mix of claim types that static 
analysis would have failed to uncover.  In addition, the Process Simulation 
proved useful for monitoring the system’s performance and assessing the 
impact of policy and procedural changes, for example the automation of 
specific operations at the workers’ compensation center. 

Regardless of the industry application, Process Simulation with SIMUL8 is 
an invaluable tool for any Six Sigma professional. 

 

This model is available for download at www.visual8.com/demonstrations. 
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Discussion 
1. What are some other KPI’s that could be examined in order to 

improve the efficiency of the claims processing center? Are there 
any necessary modifications to the model that must be made to 
incorporate these additional KPI’s? 

2. Aside from our recommendations, what other approaches would 
you consider? 

3. Explain how you could use the simulation to answer the following 
question: What percentage of time can you answer a specified 
percentage of calls within a specified number of minutes?  Which 
SIMUL8 function does this for you? 
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Case Study: Airline and Airport 
Simulation 
The airline and airport industry has been taking advantage of operations 
research techniques for many years.  Airlines must ensure that their booking 
policies and schedules are able to generate maximum revenue with 
minimum cost.  The complex layouts, customer service tasks, and security 
responsibilities within large airports present a huge logistical challenge that 
is often addressed using simulation. 

Background  
The check-in process at an airport is quite difficult to model using 
algorithms and spreadsheets.  Factors such as the flight schedule, passenger 
arrival patterns, different customer profiles and processing time of 
customers by check-in staff all add to the complexity of the system.  
Simulation can be effectively used to model airport check-in as each of the 
factors can be quickly set up in the model and examined together or 
independently. 

Problem 
The following example provides a model of an airport check-in area.  The 
objective is to identify the impact of various increases in efficiency in 
serving customers at the check-in. 

Analysis 
The simulation runs for one day of the check-in operations.  It is assumed 
that check-in operates for twelve hours with a constant number of 
resources available and with a steady arrival of customers.  In a more 
complex model, it is possible to correlate the arrival of passengers to a flight 
schedule and also to incorporate recommended check-in times.  It is 
assumed for the purposes of this example that customers will stop arriving 
2 hours before the end of the day. 



Service Industry/Business Process Business Applications  •  97 

Copyright Visual Thinking International 2007 

 
Figure 5-11: Airport Queuing Example Scenario 1 Screen Capture 

Scenarios 
A number of scenarios are examined.  In the first scenario, the input 
parameters shown in Figure 5-12 are used.  The model shows profiles of 
eight different customer types.  Each type of customer has a different 
average check-in time and a respective proportion of the total number of 
customers.  The model makes an approximation of the arrival rate of 
people based on the number of flights per day and customers on each of 
the flights.  There are twelve staffed check-in desks.   

The second scenario evaluates the impact of a small process improvement 
on the customer queuing.  The improvement is a mere 15 second reduction 
in service time for each customer to simulate increased staff efficiency. 
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Figure 5-12: Airport Queuing Example Scenario 1 Inputs 

The simulation model uses a Probability Profile distribution to set the 
profile of customers arriving.  Labels are used to represent the different 
customer types and a named distribution is used to assign a process time as 
the different customer types arrive at the check-in desks.  

Results 
Shown below are the results from running the model under both scenarios, 
with and without the small process improvement.  The buildup of 
customers queuing under both scenarios can be seen as the day progresses.  
The following charts show the profile of customers queuing throughout the 
twelve-hour day.  The first chart shows that under scenario 1, the buildup 
of customers reaches a peak of almost 320 and the customers cannot be 
cleared by the end of the day.  The second chart shows scenario 2 has a 
much smaller queue size and all customers can be served by the end of the 
day. 
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Figure 5-13: Airport Queuing Example Queue Size Charts 
 
The following results from scenario 1 show long queues and waiting times.  
There are also some customers who have not been serviced by the end of 
the day.  This would mean that staff would have to continue working 
overtime in order to deal with those remaining people. 

 
Figure 5-14: Airport Queuing Example Scenario 1 Results 

Scenario 2 shows that speeding up the processing of customers has 
significantly reduced both the queuing time and queue size. 

 
Figure 5-15: Airport Queuing Example Scenario 2 Results 
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Recommendations 
The example simulation of queuing at an Airport Check-in demonstrates 
how small changes in procedures can have a large effect on customer wait 
times.  The model results make a strong case for the implementation of 
even minor improvements to the check-in procedures.  The model could be 
further enhanced to provide a more detailed profile of customer arrivals 
according to flight times, capacities, and destination (recommended check-
in times).  The same type of modeling techniques could be applied to other 
areas around the airport such as security checking or customs. 

 

This model is available for download at www.visual8.com/demonstrations. 

Discussion 
1. What else can be done to decrease customer time in system 

without decreasing service time? 

2. Name at least three improvements to the check-in process that 
would lower the service time of travelers. Of these, which can be 
included in the simulation without making any changes to the 
model? What changes must be made in order to incorporate other 
changes? 

3. How can we refine the arrivals schedule to more accurately reflect 
reality? 
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Case Study: Modeling ATMs 
Financial institutions have traditionally relied on a full-service branch 
system wherein all financial transactions are completed within the physical 
bank building.  With increasing customer demands for 24-hour per day 
availability, a desire for more locations, and cost-reduction initiatives, 
Automatic Teller Machines (ATMs) and internet banking have become 
much more prevalent.  This example focuses on ATMs in terms of daily 
operations and evaluating different geographic networks of ATM locations. 

Background 
An expanding bank is growing quickly and expanding into new geographic 
markets.  The manager responsible for ATM deployment at the financial 
institution wishes to analyze the daily operational performance of placing 
five ATMs into a new metro market.  Instead of using the traditional model 
that dictates where the machines should be placed and evaluating their 
performance post-deployment, the manager has wisely decided to perform 
a simulation analysis of the new system to answer several questions: 

• How much will the ATMs be used? 

• Is there sufficient capacity at the ATMs for the number of 
transactions? 

• Will the ATMs support an adequate level of service?  

• What is the financial benefit from deploying the ATMs? 

In this simplified example, customers use ATMs to withdraw cash, deposit 
cash or checks, and pay bills (or other miscellaneous transactions) 
throughout the day.  Concurrently, armored trucks make regular visits to 
the ATMs to replenish the stock of available cash and to pick up any 
deposit, bill payment, or other transactional envelopes.  The ATMs are 
either located at a grocery store or near the front entrance of an existing 
bank.   

Problem 
The manager’s primary concern is whether the five proposed ATMs could 
meet a certain level of service.  Service level is defined as the percentage of 
satisfied customers who use or plan to use the ATM.  In the model, 
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potential reasons for causing a customer to be dissatisfied are waiting in line 
too long, lack of capacity to deposit envelopes or make bill payments, and 
insufficient cash available for withdrawals.   

Analysis 
The simulation model uses three levels of hierarchical modeling for each 
location through the use of sub-windows.  See the Reference section for 
more details on this useful feature that enables the user to display further 
detail in addition to the macro level view:  

1. The main screen that shows the placement of the locations on a 
map, 

2. The layout of the store or bank location, including a detailed view 
of the ATM queue area, and 

3. The contents of the ATM itself.  

 
Figure 5-16: Modeling ATM Example Hierarchical Structure 
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For each ATM, the user can specify the ATM capacities, processing times, 
customer arrival rates, action types available (i.e. withdraw, deposit, bill 
payment, etc.), costs and revenues associated with operating the ATM, and 
customer service threshold (i.e. amount of customer patience). 

 
Figure 5-17: Modeling ATM Example Model Input Parameters 

The example model uses graphics and animation extensively.  Background 
maps, layouts, and drawings are used within each Sub-Window along with 
icons for each on-screen object.  Work Items (customers, armored truck 
and guard, cash, deposit envelopes, and bill payment envelopes) are all 
assigned different images to visually differentiate between them.  Visual 
Data is shown on the main screen to dynamically display the contents of 
the ATM.  (See Graphics Palette on page 182 for more information.) 

The simulation model indicates how much of the ATM’s carrying capacity 
was actually used, the amount of utilization of the ATM itself, the service 
times, the service levels, and the financial results.  This information is 
presented in an organized fashion using the wizard option of SIMUL8’s 
dialog box feature, shown below. 

 
Figure 5-18: Modeling ATM Example Model Results 
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Recommendations 
The model was run for a simulated week to obtain the following summary 
results. 

 
Figure 5-19: Modeling ATM Example Summary Results 

As shown above, none of the ATMs achieve a very high level of customer 
service and further investigation into the cause of the dissatisfied customers 
is required.  The manager can conduct a more detailed analysis by 
investigating the capacity utilization, the processing times, the interference 
with armored truck drops at the ATMs, etc. 

 
Figure 5-20: Modeling ATM Example Model Results 

The simulation analysis, as shown above, provides a sound basis for 
decision-making before deploying the proposed ATMs.  Instead of placing 
the new ATMs with little information regarding how they will perform, the 
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model allows the user to make adjustments to the proposed deployment 
since she has a better understanding of the system.   

Several options exist for extending the current simulation model.  The 
potential future area of expansion for the current simulation that would 
provide the most value and insight, however, is to convert it to a metro 
network configuration tool.  More specifically, link the current simulation to 
a GIS database to obtain geographically based demographic data pertaining 
to specific locations and show the interactions between them.  By providing 
this feature, various metro ATM network configurations can be tested for 
appropriate coverage when placing new or removing old ATMs.  Therefore, 
while the current model is used to examine individual ATM performance, a 
network model can help evaluate the system as a whole with all the requisite 
detail. 

 

This model is available for download at www.visual8.com/demonstrations. 

Discussion 
1. What method should be used for determining customer service 

threshold? 

2. Can you explain the relationship between customer service level 
and the other KPI’s in the model? 

3. Are there any other issues involved in deploying additional ATM’s 
to satisfy customer demand? Include these in the model and 
produce a new set of results. 
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Case Study: Healthcare 
Healthcare is the single largest industry in North America.  It is constantly 
developing and changing as technology advances and new modes of 
delivery become available.  The consistent evolution of the processes means 
that there are always potential gains to be had from OR studies.  Healthcare 
is a unique industry because it does not conform directly to the economics 
of supply and demand.  Health providers strive to deliver exceptional care 
at a reasonable cost.  Organizations are constantly trying to determine how 
funding should be allocated in order to provide the best patient care.  For 
this reason, the benefits of an OR study are very valuable in terms of 
providing better patient care.  From a business process or services sector 
standpoint, healthcare is a potentially contentious area to quantitatively 
evaluate.  What are appropriate measures of patient care?  Should service 
level, like transaction-oriented businesses, be used to determine how an 
HMO, hospital, or clinic is performing?  If service level is chosen, an 
appropriate definition and method of assessment must be established.  
These are just some of the issues that arise when analyzing a ‘human’ 
system.  The following example describes a basic application of simulation 
analysis to a healthcare setting.  

Background 
Simulation studies can be applied to nearly every aspect of the healthcare 
industry.  Some studies become politically sensitive when they end up 
directly comparing service levels and finance constraints.  Often internal 
structures and policies become invisible constraints to the progression of 
change. 

This example models the simplified operations of a hospital’s emergency 
room (ER).  The administration has several concerns: budget, staffing, 
space, and process times.  In this model, we examine the possible benefits 
that could be gained from a simple reorganizing of patient activities. 

Problem 
Two scenarios are modeled in the example simulation.  Common to both 
scenarios are the process times required for each task, the requirement that 
all patients must pass through each process before being discharged, the 
personnel, facilities available, and the arrival rates of patients at the ER.  
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The first model shows the emergency room before a proposed process 
improvement recommendation is implemented.  When patients enter the 
ER, they first proceed to the area of the ER that they feel is appropriate (i.e. 
a random routing).    

 
Figure 5-21: Healthcare Example Scenario 1 Screen Capture 

In the second scenario, patients are given instructions to go to Registration 
and Administration area first, at which time patients are told exactly where 
to go (i.e. clockwise through each area in the ER).  See the figure shown 
below. 
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Figure 5-22: Healthcare Example Scenario 2 Screen Capture 

Analysis 
The simulation model makes use of the Jobs Matrix feature in SIMUL8 
(See Jobs Matrix on page 275).  The Jobs Matrix enables multiple Work 
Item types, routings, and processing times at each station, without using 
complex coding.  The Resource feature is used to provide the appropriate 
number of personnel required at each of the various processes.  Other 
features of note are the Image label and the use of a Rounded Uniform 
Distribution in Label Actions, which are used together to quickly and easily 
assign various images to patients.  The primary indicators of service level, 
for this case, are patient time spent in the ER system and individual queuing 
time at each process.  Patients are expected to never wait for more than half 
an hour for any one task in the ER.  Otherwise, a complaint is filed.  The 
figure below shows these indicators after a trial of 20 runs. 
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Figure 5-23: Healthcare Example Results Comparison 

The left column shows Scenario 1 results (disorganized routing) and the 
right column shows Scenario 2 results (specific routing).  Comparison of 
these results clearly shows that patients in the second scenario spend 
considerably less time in the ER.  These results can also be seen in the 
histograms shown below. 

 
Figure 5-24: Healthcare Example Time in Simulation Charts 

An additional result of the process change is that the number of complaints 
filed is nearly two thirds fewer than the number in Scenario 1.  This 
translates into a service level increase from 90.8% to 97.3% after the patient 
flow process improvement. 

Recommendations 
The Emergency Room simulation example above provides a convincing 
argument for implementing the proposed process improvements to the 
existing system.  The simulation was particularly useful for comparing the 
two scenarios against specific measures using statistically robust techniques.  
The simulation model can be expanded to provide further insights into 
various healthcare projects in many ways.  One example is providing more 
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detail within the simulation, such as by using different service levels for 
different injury types or ICD10 codes.  Another example is to change the 
scope of the simulation to evaluate ER coverage within an entire metro 
area.  Regardless of the specific area of study, simulation analysis is a tool 
that is scalable, flexible, and practical and can be applied to a variety of 
healthcare issues to provide hard evidence to back proposed improvement 
projects. 

 

This model is available for download at www.visual8.com/demonstrations. 

Discussion 
1. Can you find any major costs in switching from scenario 1 to 

scenario 2? 

2. Which results remain similar in both scenarios? 

3. What improvements would you propose to improve upon these 
results? 

4. How would you expand this model to include a second stream of 
incoming patients? 
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Chapter 6:  Supply Chain Case 
Studies 

Overview 
The term Supply Chain is used loosely to denote any or all aspects of the 
product procurement cycle from sourcing raw materials, managing the 
production of parts and finished goods, transportation of goods to 
warehouse and/or distribution center, and final customer delivery areas.  
What was once termed physical distribution and manufacturing has 
expanded to encompass a wide range of interdependent operations within 
the supply process and with it the complexity of maintaining efficient and 
focused systems. 

Simulation offers the potential of looking at the dynamic working of the 
supply chain from a very high level, examining the flow and cost of moving 
products across the entire supply network.  From this viewpoint, it is 
possible to examine the adequacy of the fill supply system from a response 
or service level standpoint with respect to the cost of providing this level of 
product fulfillment.  This type of analysis may reveal problem areas in the 
network, which may be candidates for more detailed or low-level simulation 
analysis.   

Any segment or part of the supply chain can be simulated in more detail.  
Examples are the internal working of a distribution center or the physical 
transportation of goods from producing plants to storage centers.  The 
performance issues that can be discovered include inefficient storage and 
retrieval systems, inadequate materials handling equipment, or even 
excessive stock levels.  Improvements can easily be studied through 
adjustments to the model parameters, revealing their specific contribution 
to the system’s increased performance.  In this way, a cost-benefit analysis 
can be performed to “fine-tune” the supply chain network with respect to 
service level objectives. 
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As described earlier, supply chain simulations in SIMUL8 can be shown 
across a geographic area, using bitmaps, depicting the location of plants, 
warehouses, distribution centers, and customer demand areas.  The level of 
graphic animation in the model could include truck shipments delivering 
products from source to demand points in the network with the simulation 
keeping track of freight costs and delivery times.  Typically, a simulation of 
the supply chain will manage inventory levels at each stocking point and 
automatically generate replenishment orders based upon inventory 
management rules for the product(s) that are being controlled. 

Supply Chain models can be very data intensive and the analyst has to be 
careful about the combined level of detail and scope of the simulation to 
avoid building a tool that is cumbersome, slow, and impractical for 
addressing operational issues.  The following examples provide a practical 
view of the way in which SIMUL8 has been used to address warehousing, 
physical distribution, and product supply issues under the general umbrella 
of supply chain applications. 
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Case Study: Warehouse Workflow 
Modeling 
 The use of simulation to explore the workings of warehouse operations is a 
common application.  These models allow the analyst to examine issues 
such as the warehouse layout, materials handling requirements, staffing 
levels, storage and retrieval systems, stocking policies, picking and packing 
operations, type and size of racking systems, product storage needs, space 
requirements, etc.  The more complex the materials-handling system, the 
more valuable simulation models can be in helping to determine the flow of 
product or pallets through the system.   

Background 
Simulation models can be used to examine warehouse design issues as well 
as on-going operating practices to improve efficiencies and productivity 
levels.  Indeed, a popular application of this technique is to examine the 
capacity of the warehouse operation to handle a predicted volume of 
received goods or shipment of orders within a specific timeframe.  These 
performance evaluation models typically lead to changes in the operation 
that eliminate bottlenecks that constrain the system’s ability to meet 
planned or predicted workload levels. 

Similarly, simulation can help decision-makers determine staffing levels 
where there are stock pickers and shippers or receivers handling the daily 
inflow and outflow of goods from the distribution center or warehouse.  
The timing of shipments both inbound and outbound can significantly 
affect the staffing profile required to handle the workload in a timely and 
cost-efficient manner.  Physical characteristics of the warehouse can also 
come into play such as the number of shipping and receiving docks, the 
number of fork lift trucks available, and available space to build outbound 
orders or inspect incoming goods. 

The animation provided through the simulation model offers a unique 
bird’s-eye view into the workings of the warehouse’s operation.  Problems 
that may arise such as a build-up of pallets on the floor or trucks waiting to 
be off-loaded can be quickly seen.  This feature, coupled with the power to 
test-out alternative ideas or workload conditions by simulating “what-if” 
conditions or changes quickly in a risk-free setting, gives decision-makers a 
powerful analysis and project marketing tool. 
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Problem 
A pharmaceutical company must redesign its existing warehouse operations 
in order to accommodate a planned increase in production that will result in 
an increase in material handling tasks.  Naturally, management would like to 
minimize capital expenditure and continue to operate within the current 
building, which is directly linked to the production area.  Although 
management suspects there will be a need for large investments, they would 
like to support their decisions with hard evidence.  They have wisely elected 
to use simulation to examine the problem and provide them with clear 
numbers. 

 
Figure 6-1: Warehouse Simulation Layout 

The current warehouse employs forklift trucks to unload pallets of materials 
from trucks at the receiving docks.  These in-bound pallets are fed to 
power-and-free conveyors, which in turn are moved by automatic guided 
vehicles (AGVs) to an automated storage and retrieval system (ASRS) that 
can hold up to 10,000 pallets at any one time. 

Throughout the day, production issues requests to the warehouse for 
materials that are retrieved by the AGVs and transported to the conveyors 
feeding the production area.  Pallets of finished goods are output from 
production to shipment and the AGVs move the pallets to the outbound 
shipping conveyors. 

ASRS 
Receiving 

AGVs 

Production 
Inflow & Outflow 

Shipping 

Conveyors 

Fork Trucks
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Analysis 
Given the demands on this project the study team elected to use a 
simulation model of the current warehouse operation and examine where 
the “pinch-points” developed under increasing workload levels.  The design 
of the simulation model was to provide a bird’s-eye view of the warehouse 
layout with the current materials handling systems.  The model was to be 
controlled by a single input sheet that defined the volume of work in and 
out of the warehouse along with the type of equipment and rate of 
operation.  The results from the simulation were distilled down to a number 
of key performance measures that were also presented on a single output 
sheet. 

Input to the simulation model was provided through a spreadsheet of key 
operating parameters.  As shown below, the user could control the number 
of receiving or shipping bays that could be employed, and adjust the rate of 
loading or unloading trucks.  Note that these rates were input to a normal 
distribution, which provided a realistic range of process times. 

Of particular interest to the user was the ability to adjust resources, such as 
forklift truck and AGVs, and the demand levels from production in terms 
of the inflow and outflow of pallets. 

 
Figure 6-2: Warehouse Simulation Input Parameters 

Once the user was satisfied with the configuration of the warehouse in the 
spreadsheet, she would reset the model to set the simulation model 
parameters.  Running the simulation model would automatically generate 
inbound truck shipments to the warehouse at the rate specified as well as 
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the volume of materials ordered and produced by production (pallets per 
hour) for the warehouse. 

The ability of the warehouse to keep up with the inbound and outbound 
volumes was a function of the number of resources provided and their 
efficiency or speed of operation.  Adjusting these Resource levels had a 
significant impact on the overall performance of the warehouse operation.   

Recommendations 
The key performance results were captured in a formatted spreadsheet, as 
shown below.  This shows the number of trucks that arrived during the 
simulation and the number of pallets that were offloaded.  As can be seen, 
only two receiving bays out of the six available were used.  Similarly, only 
one shipping bay was required to load 31 trucks with 1,240 pallets.  No 
trucks, inbound or outbound, were required to wait. 

 
Figure 6-3: Warehouse Simulation Summary Results Run 1 

Of particular interest was the ability of the AGVs and forklifts to keep up 
with the volume of work as dictated by the production area.  As shown, 
production required and received a total of 2,017 pallets of materials but 
only managed to ship out 1,429 pallets of the 2,216 it produced.  There is 
an unacceptable backlog of 787 pallets sitting in production waiting to be 
handled by the warehouse. 

Looking at the utilization of the resources in the warehouse it is easy to 
identify the problem.  The forklift trucks appear to be operating within their 
areas at an acceptable work level but the AGVs are close to 100% utilized 
either loaded or traveling to a pick-up location.  The question, therefore, is 



Supply Chain Case Studies Business Applications  •  117 

Copyright Visual Thinking International 2007 

“what-if” we added another AGV into the system.  The change is simply 
made in the input spreadsheet, adjusting the number of AGVs to 8, and the 
simulation is then re-run with this new level of Resource. 

The results are now shown from running the warehouse for a one-week 
period with one extra AGV – a modest capital investment – providing a 
total of 8 available vehicles. 

 
Figure 6-4: Warehouse Simulation Summary Results Run 2 

The impact of this one additional AGV is evident.  The production backlog 
has been eliminated and there has been an increase in truck shipments from 
the warehouse, offsetting the cost of the extra AGV. 

This simple but effective use of simulation demonstrates the power of this 
technique in a warehouse setting.  One can conduct sensitivity analysis on 
the results by running a number of trials or by adjusting the parameters in 
the warehouse simulation.  These experiments take no more than a few 
seconds to run but provide valuable insight into the efficient running of the 
operation to satisfy projected workload levels. 

 

This model is available for download at www.visual8.com/demonstrations. 

 

 

 



118  •  Supply Chain Case Studies Chapter 6 

Discussion 
1. What issues are involved in introducing a new AGV into the 

warehouse?  

2. Are there other solutions to the order backlog problem that avoid 
these issues? 

3. For what minimum volume level is our recommendation valid? At 
what level must further changes be made? What would you 
recommend? 
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Case Study: Warehouse Sizing 
The correct configuration, racking setup, and sizing of a warehouse are vital 
issues with respect to supply chain management.  Even when demand can 
be predicted with some level of certainty, determining warehouse 
specifications can be a daunting task.  When supply is then considered, in 
which various options for reordering policies (i.e. EOQ, JIT, Kanban, Push, 
Pull, etc.) must also be established, determining the correct configuration of 
a warehouse can become even more complex.  In most cases, a warehouse-
sizing project is undertaken when building a new facility or 
renovating/expanding an older one.  Because of the large capital 
expenditure associated with new construction and purchases of storage 
racks, assessment of warehouse sizing requirements must be done correctly. 
Simulation is the perfect decision support tool for warehouse sizing, since it 
can take into account dynamic product flow interactions and stochastic 
events.  Whereas static analysis performed in a spreadsheet may yield rough 
results in a matter of minutes but will never attain the required level of 
sophistication, a SIMUL8 model can be developed relatively quickly and 
can include as much or as little detail as needed. 

Background 
The following example model is used to determine the amount of space and 
racking required for work-in-process (WIP) and for finished goods at a 
plastic injection molding plant.  The process involves two steps: molding 
blank product and printing onto the blank product.  The primary statistics 
that the decision-maker requires are the average and maximum levels of 
inventory, the variety of products, and service levels (i.e. on-time deliveries) 
given various scenarios (i.e. number of machines, demand volume, re-order 
policy changes, etc.).  The study cannot easily be completed using static 
analysis since a pull system is used for re-ordering, multiple product families 
and SKUs exist that can only be produced on specific machines and require 
different pallet sizes, and all of this must coincide with a fulfillment 
schedule that includes some uncertainty. 

Problem 
Allocating a large space for WIP and finished goods inventory will, over 
time, cost the company a great deal of money.  The problem at hand, 
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therefore, is to determine how high these costs are relative to the costs of 
changeover times and longer lead times, which allow the use of a smaller 
inventory storage area. 

 
Figure 6-5: Warehouse Sizing Example Screen Capture 

Analysis 
The simulation model does not use a Work Entry point (useful for push 
systems but not for pull), but instead reads from a daily shipment schedule.  
Using a specified lead-time, orders (Work Items) are created for various 
finished product SKUs if there is sufficient WIP (blank molded product) 
and jobs are assigned to appropriate queues for Print machines (Work 
Items added to a Storage Bin).  When WIP of a product family is depleted 
to a certain level (a number of days’ supply), an order for that type is 
generated and delegated to molding machines. 

Several complex rules are used when deciding to which machine to assign a 
job: 

• Machine must be able to accept work from this product family, 
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• Split up batch orders into smaller, suitable portions if it cannot be 
finished on time as one order, 

• Cannot have more than a specific number of machines working on 
a particular product family type, 

• Must meet a minimum order quantity, 

• Minimize number of changeovers from one type to another, and 

• If assigning an order to a machine based on changeovers will make 
the order late, find the machine with the shortest queue. 

All of these rules are modeled in this example simulation.  Each simulated 
day, the model determines what and how much to produce based on the 
input parameters and shipping schedule.   

  
Figure 6-6: Warehouse Sizing Model Parameters 

Even with over 6,000 finished product SKUs, 50 product families, and up 
to 100 mold and print machines, the simulation only takes a few minutes to 
complete an entire simulated year and to obtain results. 

The simulation provides various reports detailing machine utilization, order 
fulfillment times, inventories, and service levels.  All this information is 
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used to evaluate the various options available to the company for facilities 
planning with a particular focus on warehouse sizing. 

 
Figure 6-7: Warehouse Sizing Result Options 

The results of the simulation help determine the necessary size and 
configuration of the warehouse along with the types of racks to be 
purchased, based on the specified input parameters provided.  Along with 
calculating the amount of inventory and the size of the storage area, other 
performance measures relating to various aspects of the plant are analyzed. 

 
Figure 6-8: Warehouse Sizing Summary Results 
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Recommendations 
From this simulation analysis, the company was able to construct a 
Greenfield production plant with confidence in its specifications.  Instead 
of making rough estimates of how the plant would operate under given 
conditions, and thus how much storage space was required, the warehouse 
sizing simulation was applied as a sound basis for testing various scenarios 
and decision-making.  The simulation can be further expanded and 
continues to be used even after the physical construction/expansion of the 
warehouse is complete for ongoing management of the production plant.  
Testing shipment schedules, evaluating machine acquisitions, establishing 
new re-order policies, and labor/resource scheduling are just some of the 
different areas in which this decision support tool can be of further value. 

Discussion 
1. What feature of SIMUL8 can be used to quickly view financial 

details of various configurations? 

2. Are there other methods of displaying simulation results?  Design a 
different output spreadsheet for comparing results of various 
configurations. 

3. How would this study change if only a push system was available 
for the company’s inventory? 
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Case Study: Network Supply 
It is important to look at a supply chain in its entirety to ensure that all parts 
of the network are working well together.  For example, ordering patterns 
have a huge impact on inventory levels and carrying costs.  They can affect 
the delicate balance of the supply network.  Shipping costs also vary greatly 
depending on the quantity and frequency of shipments.  Many different 
policies can be used when ordering product including Reorder 
Point/Reorder Level based on forecasted day’s supply, fixed frequency and 
quantity, and Economic Order Quantity (EOQ).  The following example 
illustrates the impact of ordering patterns on inventory levels.  A basic 
policy of Reorder Point/Reorder Level quantities will be used. 

Background 
The simple example of one distribution center (DC) ordering one product 
from a single source will be used.  The DC places orders with the factory 
based on the level of inventory it is currently holding.  Currently the 
ordering pattern at the DC results in stock-outs and poor customer service.  
Demand that must be met by the DC is forecasted as shown below. 

        
Figure 6-9: Demand Profile 
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The reorder policy is shown below in Figure 6-10 with the DC placing an 
order when the inventory level reaches the reorder point.  An order is 
placed to replenish up to the reorder level while taking into account what is 
already on order.  The system is also constrained by a lead-time for the 
delivery of orders and the number of trucks that can be utilized at any time.  
An initial inventory of 30 units is assumed. 

 
Figure 6-10: Reorder Policy 

Analysis 
Given the demand profile and the reorder policy it is possible to assess 
whether the DC was able to meet demand over the 50-day period.  On 
running the model for 50 days, the Inventory Chart and Stock Out Report 
below that the DC is not able to meet the demand placed on it.  The Stock 
Out report shows that the DC was short of demand on many of the days in 
the simulated period by a significant number of units.  The Inventory Chart 
also shows these stock outs and the large fluctuations in inventory levels.  
The reorder policy can now be revaluated to prevent stock outs and smooth 
out inventory levels. 
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Figure 6-11: Stock Out Report and Inventory Report 

Recommendations 
By simply changing the Reorder Point and Reorder Level rules, it is possible 
to achieve no stock outs and meet demand across the period. 

 
Figure 6-12: Reorder Policy – Revised 
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Figure 6-13: Inventory Chart - No Stock Outs 

On running the model with the new ordering policy in place, no stock outs 
were observed.  The inventory chart also shows that stock levels are more 
stable across the period thus providing a safety stock should any 
unexpected demand occur.  Using the distributions provided in the 
simulation package, it is possible to generate further demand in order to test 
this new policy.  It is easy to imagine how complex reordering issues can 
become when the supply chain network is expanded beyond this simple 
example.  Many organizations have networks including many factories, 
distribution centers, and warehouses, moving hundreds of product, each of 
which has its own demand and ordering policy.  Simulation can help to play 
out the effect on the entire supply chain of altering order policies, shipping 
lead times and capacities, and many other operating rules. 

 

This model is available for download at www.visual8.com/demonstrations. 

Discussion 
1. Aside from the reorder policy, what other reasons might there be 

for the DC being unable to meet demand? Which reasons can this 
model be used to investigate? What changes must you implement 
in order to study additional reasons? 

2. What other reorder policies might benefit the DC? Design a 
spreadsheet that can be used to input its parameters to SIMUL8. 

3. How can SIMUL8 be used to study the costs and benefits of 
various reorder policies? Design a spreadsheet that compares 
results of various reorder policies. 

 



128  •  Supply Chain Case Studies Chapter 6 

Case Study: Lean Manufacturing 
In today’s economy, lean manufacturing has become a widely used strategy.  
It involves reducing inventories while maintaining high service levels.  This 
can be accomplished by adopting a “pull” method of production, with 
shorter batch runs and faster machine changeover times.  However, the 
implementation of this methodology is no simple task and without careful 
planning, it can lead to chaos with missed orders, unbalanced workloads, 
excessive machine downtime, and increased production costs. 

Lean practitioners advise that this “pull” method of producing goods takes 
a significant amount of time to implement and stabilize.  In essence, what 
they are saying is that there is a lot of trial and error to go through before 
the correct batch sizes, buffer levels, and changeover frequency is worked 
out for each of the parts produced.  One way to expedite this process is to 
use a simulation model of the manufacturing process. 

Many consultants are now providing their clients with simulation models to 
demonstrate the potential benefits of introducing lean techniques and using 
the same tool to identify the optimal batch sizes and work-in-process 
inventory levels of intermediate stocks.  These lean manufacturing 
simulation models can quickly show the flow of work through the plant and 
help to identify bottleneck processes and buffer level requirements between 
stations.  

Simulation models can be used to examine warehouse design issues as well 
as on-going operating practices to improve efficiencies and productivity 
levels.  Indeed, a popular application of this technique is to examine the 
capacity of the warehouse operation to handle a predicted volume of 
received goods or shipment of orders within a specific timeframe.  These 
performance evaluation models typically lead to changes in the operation 
that eliminate bottlenecks that constrain the system’s ability to meet 
workload. 

Background 
A large manufacturing company producing plumbing parts using high-grade 
copper material was keen to reduce finished goods inventory levels in the 
field by adopting a more responsive method of production.   
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In the past, the company manufactured finished goods in large product 
runs or batch sizes to replenish stock levels at their distribution centers and 
warehouses.  Maintaining field inventories in this way helped them to 
achieve high customer service levels and low unit costs, but their stock 
holding costs were excessive.   

 
Figure 6-14: Lean Cell Simulation Screen Capture 

Problem 
In an attempt to reduce supply costs, management decided to adopt a lean 
cell manufacturing approach that could supply smaller quantities of product 
to the field at a much faster rate than before.  This would mean more 
frequent machine changeovers and potentially higher levels of work-in-
process.   

Since certain finished products were produced from common formed parts 
and these in turn were produced from common blank parts, the idea was to 
stage product at different levels of completion across the manufacturing 
cells.  Using a pull system the system was to be self-regulating. 

External demands for product would be drawn from finished goods at the 
plant, creating an internal demand for their replenishment.  These 
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manufacturing orders would ripple across the production cells, converting 
formed parts to final product, and in turn, blank parts to formed parts. 

The challenge for the lean production team was to determine which parts 
should be staged at each level of production, appropriate buffer sizing, and 
the number of bins or Kanbans should be held at each manufacturing cell.  
A simulation model of the process proved to be extremely valuable for this 
analysis.  

Analysis 
Analyzing historical demand patterns for the various finished products and 
establishing their part families, the project team was able to develop a rough 
plan of bin size for each part type as well as the number of bins.  By feeding 
this information into a simulation along with machine change-over times 
and finished goods demand, the project team could analyze the production 
flows across the manufacturing cells. 

 
Figure 6-15: Lean Cell Simulation Model Parameters 

Through repeated experiments with the simulation model, the team was 
able to establish the correct buffer level by part and replenishment bin size.  
Adjusting demand levels or changeover times would also show how 
sensitive the system was to small system changes or production delays.  
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Recommendations 
The following results summary provides some of the performance 
information that the team used to measure the effectiveness of their 
recommendations.  Reading from the top table down we see the number of 
external orders that were placed on the plant from the distribution center 
(DC) and the number that were fulfilled.  The response time is shown by 
the production lead-time, which is measured in hours. 

 
Figure 6-16: Lean Cell Simulation Model Results 

Machine loading is provided in the second table for each of the machines in 
the cells.  We can see the number of parts produced and the utilization of 
each cell, and for each of the machines, the frequency and percentage of 
time they were in a set-up state.  

Lastly, the table at the bottom of the report provides information on the 
number of bins that were required at each stage of manufacturing, their 
overall capacity, and the frequency of replenishment.  The average lead-time 
to replenish the part bins is also provided along with the internal service 
level for the delivery of part bins measured against an acceptable supply 
lead-time. 
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This simple but effective use of simulation demonstrates the power of this 
technique in warehouse setting.  One can conduct sensitivity analysis on the 
results by running a number of trials or by adjusting the parameters in the 
warehouse simulation.  Running a simulation scenario takes no more than a 
few seconds but provides valuable insight into operations and how to 
satisfy projected workload levels. 

Discussion 
1. Would you have chosen the same KPI's as those used in this 

analysis? Why or why not? 

2. How could you improve the power of this simulation by changing 
the way demand is simulated? 

3. Aside from lean manufacturing, can you think of another area of 
application of a pull system? Can this model still be used? What 
would you change? 
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Chapter 7:  Operations Scheduling 
Case Studies 

Overview 
As described earlier, simulation is a useful technique for analyzing the 
potential workings of newly planned or current operations.  Having created 
a detailed simulation of the manufacturing operation, however, it is possible 
to use the same model to determine the best loading and sequencing of 
work across machines.  Just as the tool can be used to answer “what-if” 
questions on machine reliability or resource availability, the tool can also be 
used to investigate the lead-time to produce specific orders or to help 
determine the best sequence of work to minimize changeovers. 

In this way, we turn the use of the simulation tool from one that is used to 
examine the “what-if” probabilistic outcome of a system to one that is 
more deterministic and helpful to predict the timing of work in the system.  
Using the model to simulate the execution of work orders or jobs launched 
into the production system in a particular sequence, we can show the 
outcome in terms of completion dates, resource utilization, changeover 
times, etc.  The tool then becomes helpful in determining the best sequence 
of work given the constraints within the process and the performance 
objectives management wishes to satisfy. 

One of the key advantages to this approach is the simulation model’s ability 
to reflect reality and to adhere to the hard production rules as well as the 
softer management preferences in executing the work.  The results from the 
simulation will be feasible given that process times, product routings, 
process rules, and resource availability are correctly specified.  Another 
significant advantage is the inclusion of the variability of the parameters in 
the model in order to produce realistic predictions.  Naturally, any of these 
input parameters can be easily changed within the simulation to show the 
affect on performance levels.   
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Indeed, with increasingly powerful computers and nearly unlimited size of 
simulation models, coupled with access and seamless linkage to ERP 
databases, simulation is now being used to develop efficient and feasible 
production schedules.  Advanced versions of these applications are being 
used for adaptive planning and scheduling, where the system automatically 
updates the schedule based on feedback of shop floor information and new 
orders. 

In the following examples, we demonstrate the above concepts and 
practices through a number of simulation-based production planning and 
scheduling applications. 
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Case Study: Production Planning and 
Scheduling 
 The head of Operations at a large ground beef processing production plant 
wanted to improve the scheduling process.  He knew that the operations 
were interrelated, and implementing new processes would be laborious.  He 
needed to first understand the impacts of any change to the decision 
process on overall production before going ahead with implementing any 
changes. 

Background 
The basic flow pattern of beef is that it feeds from other production areas 
at the beef plant into the ground beef processing area and onto subsequent 
ground beef production.  Since ground beef processing is reliant upon raw 
materials flowing from other areas of the plant, the company employs a 
reaction-based planning system.  In this way, personnel watching the flow 
of materials were given the responsibility of meeting customer orders.  This 
resulted in excessive product waste, as well as high overtime requirements 
for ground beef processing that was continually reacting to outside 
influences.  Further inquiry revealed that one person had the decision-
making capability for the entire process.  He had developed the scheduling 
rules through experience and most of this knowledge was undocumented.   

The operations within the area are governed by parameters such as shift 
patterns, material flows, beef types, and production rates on a minute-by-
minute basis.  A set of constraints were discovered that govern decision 
making, from using old beef first, to meeting customer order requirements, 
to minimizing waiting time for material flow, to minimizing different 
changeover types at all the different operations.  A total of 45 influencing 
factors were identified! 

It was clear that the scheduling function required the ability to see how 
different scheduling rules would influence the operation.  The process was 
complex enough that it would be difficult to anticipate the results of any 
small change.  Ideally, scheduling should be able to make informed 
adjustments to the operation to react to the changing operational climate. 
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Problem 
As mentioned above, before the undertaking of this simulation project, the 
ground beef processing was scheduled by a lone individual in an ad-hoc 
manner, based on his perception of the urgency of various orders and the 
available beef on hand.  This, of course, led to many production 
inefficiencies as incorrect decisions were made.  For example, often pre-
ground beef was not used due to the need to process other beef to satisfy a 
certain order.  At other times, the exact opposite would occur.  Namely, in 
order to prevent spoilage, the manager would elect not to meet certain 
deadlines.  Often overtime 
would be required to meet 
these deadlines, greatly 
reducing the company’s 
profit margins.  Therefore, 
the problem facing the 
operations manager was to 
determine how to schedule 
ground beef production, 
removing these 
inefficiencies, while meeting 
customer demand. 

Analysis  
Initially, a high-level simulation model was developed to investigate the beef 
flows from other production areas at the plant into the ground beef 
processing area, and the subsequent ground beef production.  Because of 
the number of factors influencing production in the area of concern, a 
detailed simulation model of the ground beef processing unit was 
developed to analyze the impacts of different decisions made within the 
unit.  The process of developing the model required further investigation of 
plant processes in order to develop control logic that would function the 
same way as the plant’s operations.  The simulation allows the user to adjust 
any or all of these operating parameters and re-run the simulation for 
further analysis.  This entire processing unit can be simulated over a daily 
production cycle within a few seconds. 

By providing the production planner with the ability to influence decision 
factors with weighting preferences, the operations department can direct 
the decision according to the operational climate at the time.  This 



Operations Scheduling Case Studies Business Applications  •  137 

Copyright Visual Thinking International 2007 

scheduling capability was then applied to transform the simulation into a 
powerful production planning and scheduling system. 

By linking the simulation system to the current order management system 
as well as the material flow database, current orders and expected material 
flows were imported into the simulation.  With this up-to-date information 
the simulation could deploy scheduling decisions through the use of a 
weighted algorithm to make informed scheduling decisions throughout the 
processing unit.  By executing these decisions through the simulation, not 
only could a detailed schedule of events at each key process be generated, 
but performance reports were able to provide feedback to the user about 
how well the plan performed.  This provided the necessary information to 
analyze the impact of the individual decision factors and their importance 
on influencing the scheduling decisions. 

Recommendations 
The detailed production planning system that has been developed is now 
deployed on a daily basis across more than 16 plants within the 
organization.  Each plant has its unique set of decision rules and 
preferences that are used daily to provide the detailed operational schedules 
that are executed on the plant floor.  As a result, the detailed decision rules 
that once were held with specific floor personnel have been captured and 
they are evolving with time, as off-line analysis provides the end-user with 
the capability to improve the process.  Thus, the ground beef-processing 
area’s schedule can now be determined far in advance using the simulation.  
Through informed proactive scheduling routines, a reduction in waste, 
improved customer due date conformance, and reduction in overtime 
requirements, millions of dollars a year are saved across these plants. 

Discussion 
1. The simulation study identified 45 factors influencing the 

manager’s scheduling decision. Can you think of four quantitative 
factors? Can you think of four qualitative factors? 

2. How does one simulate qualitative decision making rules? 
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Case Study: Bill of Materials 
Simulation-based planning and scheduling applications are fast becoming a 
popular method for ensuring production schedules actually work on the 
shop floor.  By using simulation, it is possible to make real-time decisions 
on many conflicting issues such as minimizing inventory, reducing change-
over times, satisfying batch constraints, accommodating machine down-
times, and meeting order due dates.  In order to effectively manage all these 
hard and soft production rules it is essential to have a dynamic set of sort 
and selection routines with relational database capabilities, and a multi-
criteria search facility.  These are required to manage all the data contained 
within the order books, product tables, bills of materials, process sheets, 
and inventory data files.  Simulation based planning and scheduling 
provides these necessary capabilities.  The following is a simple example of 
how these facilities can be utilized. 

Background 
When writing code for planning and scheduling lots, many loops are 
required for looking up times for jobs.  Although SIMUL8 can execute 
code very quickly, like all software packages, large loops are quite time-
consuming.  With an extended set of simulation code routines, it is possible 
to extract required information from spreadsheets with even thousands of 
rows in the quick and efficient manner necessary for planning and 
scheduling applications. 

The following example uses SIMUL8-Planner (www.simul8-planner.com), a 
SIMUL8 add-on developed by Visual8, to facilitate a dynamic search and 
extraction of information using indexed tables - a special form of 
spreadsheets that automatically sorts rows according to a specified column.  
Using the ranging and table indexing features the user can quickly sort and 
search through a spreadsheet to select the required information. 

This is demonstrated using the following simple SIMUL8-Planner example 
problem: 

Problem 
A basic assembly operation produces nine different products.  Each 
product is assembled according to a simple bill of materials of parts that are 
produced under a "just-in-time" policy.  
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The objective is to complete the orders in the sequence found in the Order 
Book.  In most cases, assembly takes longer than production of the 
required parts, so it is possible to construct a simple dynamic scheduling 
rule.  Each time parts are received in Assembly, work is scheduled for the 
production of the parts needed for the next order.  To do this, SIMUL8-
Planner's ranging function is used to quickly extract the information from 
the Bill-of-Materials spreadsheet (indexed on Product) to find which parts 
and quantity are required to make the next product. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 7-1: BOM - Input Spreadsheets 
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Analysis 
The code below shows how the SIMUL8-Planner routines are used to 
quickly target the parts and quantity required.  They are then added to the 
parts storage area. 

 
Figure 7-2: BOM - Creating a New Order 

Get First Row in Range finds the first row in the indexed table or spreadsheet 
called ss_BOM across the range set by the input variable int_product that is 
used for the minimum and maximum range parameters.  Therefore, if 
int_product were set to 3, the row reference returned in the variable 
"int_row" would be 8 for the example shown alongside. 

Get Next Row in Range, which appears in the bottom line in the diagram 
above, finds the next row in the range int_product to int_product, which 
for product 3 would be row 9.  This is repeated until there are no further 
rows in the range defined, i.e. int_row will be returned as 0. 

The use of “ranging" in this way provides fast access to specific rows in a 
spreadsheet satisfying certain criteria such as a product number or range of 
numbers, a time window, a minimum to maximum job duration, or a 
particular order range.  In more advanced applications, a composite index 
can be used made up of several factors such as order due date and delivery 
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zone. This would be useful, for example, in a warehouse picking and 
shipping situation, for example.  

Returning to the above example, the scheduled production is executed by 
SIMUL8-Planner to produce the Gantt chart shown below.  Bars are color-
coded by product so that the parts required to produce the products can be 
tracked as they are produced and assembled. 

 
Figure 7-3: BOM – Gantt 

The standard method of searching through a spreadsheet using looping 
commands is fairly effective for small sets of data, but this is not the case 
when a spreadsheet contains thousands of orders downloaded from an 
ERP system referencing a large products table requiring multiple 
combinations of sub-assemblies, parts and materials.  This is when 
SIMUL8-Planner's ranging routines and indexed tables provide a powerful 
data handling combination within SIMUL8.  Not only is coding greatly 
simplified, but also the use of indexed tables provides a fast and efficient 
method for working with large sets of information. 

Discussion 
1. Can you think of other areas where SIMUL8-Planner’s unique 

functionality would be useful? 

2. What feature in SIMUL8 (Professional Version 9+) can be used to 
determine if multiple loops are causing unnecessary delays in 
processing time? 
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Case Study: Ensuring Schedule 
Feasibility 
Background 
One of the main reasons for the trend toward simulation-based Planning 
and Scheduling systems has been the capability of the system to actually test 
the schedule at a shop-floor level prior to implementation.  This ensures the 
plan is actually feasible at the detailed operational level.  Most high-level 
ERP systems or algorithmic scheduling tools cannot provide the level of 
detail that a simulation of operations can.  As a result, whether using 
simulation as the base for Production Planning and Scheduling, or using it 
to test the feasibility of a production schedule, simulation can play an 
important role in daily planning. 

Problem 
Daily production plans are generated at an Assembly Line Plant by its ERP 
system, which are handed to the shop floor at the beginning of each shift.  
At the end of each shift, the shift supervisor advises the plant manager of 
the current situation and the plan is re-generated based on the current 
conditions.  Typically, orders have been missed from the schedule and will 
now be moved onto the next shift.  The Plant Manager is aware of this 
frequent occurrence and would like to investigate the causes of these 
missed orders. 

By developing a simulation of his six assembly processes, the plant manager 
was able to view the production schedule prior to its implementation on the 
shop floor. 

Analysis  
A simulation was developed of the six processes, and associated processing 
times, travel times, changeovers and storage capacities, as can be seen in the 
table: 
 
Product\Process 1 2 3 4 5 6 

1 12.5 10.2 11.2 14.1 12.7 11.1 
2 11.5 13.4 14.2 9.3 12.2 11.9 
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Product\Process 1 2 3 4 5 6 
Change Time 10 240 15 20 15 15 
Travel Time .5 .3 .7 .3 .9 .1 

Storage Capacities - 1 2 1 1 1 

Figure 7-4: System Parameters 

As this is a slightly un-balanced line with limited work-in-progress 
capacities, it is important to schedule products down the line efficiently.  
The following is Monday’s production schedule for the 8-hour shift: 
 

Product Quantity 

1 320 
2 420 
1 180 
2 340 
1 170 
2 100 
1 270 
2 150 

Figure 7-5: Initial Production Schedule 

To run this schedule through the simulation, it is necessary to complete a 
piece of logic to ensure that the correct product is being placed on the line.  
The following is an example of this code created within SIMUL8 and 
executed at the Work Entry Point of the mode: 

 
Figure 7-6:  SIMUL8 Example of Schedule Logic 
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Recommendations 
With this particular schedule, the line will not be able to meet its 
requirements.  See the Schedule menu, completion report.  This is due to a 
combination of line changeovers and line imbalances causing assembly 
stations to become blocked or starved.  A more efficient strategy is to 
create a schedule wherein similar products are processed continuously, with 
minimal changeovers to other product types.  Creating groups of related 
product types avoids this level of starvation and blockages, and gets all 
orders completed on time. 

 
Figure 7-7:  System Imbalance 

By reviewing the performance report under the Schedule menu, it is 
possible to see the level of imbalance within the system.  By implementing 
the following schedule, it is possible to meet the daily requirements: 
 

Product Quantity 

1 400 
2 760 
1 440 
2 250 

Figure 7-8: Operational Production Schedule 
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This model is available for download at www.visual8.com/demonstrations. 

Discussion 
1. Where are the bottlenecks?   

2. What causes bottlenecking in this process?   

3. Why are they able to produce more parts with the second schedule?  

4. Does the manner in which work is fed into the system affect the 
results? Discuss. 

5. What model changes would make all schedules equal? 

6. If the changeover time were reduced to zero, what would be the 
throughput of the original schedule? The second schedule? 
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The third and final section of this textbook serves as a practical guide to 
readers for developing their own simulations.  It covers almost all of the 
basic objects and elements necessary to build basic yet powerful simulation 
models.  Some of the more advanced modeling techniques, which are often 
unique given the process being modeled and which are covered to a certain 
degree in the chapter on Visual Logic, are left for the reader to discover by 
working with SIMUL8 and trying the various functions. 

If the reader can define and verbalize a process and the rules governing it, 
the system can be simulated using SIMUL8.  There can be thousands of 
ways to configure a simulation of a given process. This section of the 
textbook will help readers to navigate through the various dialog boxes and 
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options in SIMUL8 to find the appropriate button that will make their 
models function properly. 

The chapter immediately following this summary page provides a visual 
overview of the basic simulation objects – Work Entry, Storage Bin, Work 
Center, Work Exit, and Resource – and indicates specific pages that discuss 
a given topic.  This chapter is an indispensable guide for SIMUL8 model 
developers and is correspondingly marked at the upper right sides of the 
pages. 
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Chapter 8:  Quick Reference Guide 

Work Item 
Description 
Work items are the ‘moving’ parts of a simulation model.  They are used to 
simulate the ‘flow’ of items through the simulated process.  They can 
represent assemblies, sub-assemblies, transport equipment, people, paper, 
or anything else being processed by the simulation. 

Properties 

• Labels (attributes) 

• Work Item image 

• Size 

• Advanced - multiple Work Item Types 

Common Uses 
As mentioned above, Work Items are used to simulate the moving parts of 
a process.  Some common examples of Work Items are as follows: 

• Products - parts, assemblies, sub assemblies… 

• People - patients, patrons… 

• Information - work orders, documents… 

• Equipment - vehicles, transportation… 

Work 
Item 
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Visual Reference Guide – Work Item 
 

 

 

 

Name of this type of Work Item.  Change it to 
something meaningful in the simulation model 
e.g.: Customer, Engine, Product, Payment, 
Order, Patient, Claim, Parcel, etc. 

Options for creating multiple Work Item 
types (Only recommended for simulation 
models with very large numbers of Work 
Items per Work Item type). See Work Items 
on page 187. 

This list shows 
the labels 
attached to this 
type of Work 
Item.   See Work 
Item Labels on 
page 207. 

Add/Remove the highlighted label 
from the above list.  

Select the image used to show a 
Work Item.  See Graphics / Images 
on page 385. 

Size: 
This is the length of the Work Item.  
(This information affects how much 
space it uses on a Conveyor.  See 
Conveyors on page 287.) 
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Work Entry Point 
Description  
Work Entry Points are objects that create or generate Work Items in the 
simulation model.  They are typically the starting point of a process or sub-
process where moving objects enter the simulation.  Users can specify the 
rate at which Work Items arrive here.  Work Entry Points are active objects 
as they push work into the model. 

Properties 

• Name  

• Inter-arrival times – time between Work Items entering the system 

• Results - results about the object 

• Batching – number of Work Items arrive at each time interval  

• Routing Out - disciplines by which the work leaves the object 

• Label Actions - Work Item label values changed here 

• Graphics - change the object’s appearance 

Common Uses 

• Order arrival point 

• Process start point, feeding process output 

• Incoming telephone calls 

• Door through which people/patients arrive 

Work 
Entry Pt. 
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Visual Reference Guide – Work Entry Point 
 

 

 

 

      

 

                 

Switches on/off the warning messages if 
SIMUL8 thinks the user has made a 
mistake and this Work Entry point is 
blocked. 

The name of this Work Entry point - change it to something 
meaningful in the model.  The title display can be changed in the 
simulation window by clicking Title in the Graphics button dialog. 

This defines the Work 
Item Type that this Work 
Entry point brings in to 
the model. 

Sets up what this 
Work Entry point is to 
do to labels on Work 
Items as they leave 
the Work Entry point.  
See Label Actions on 
page 209. 

Normally the first arrival 
will be at the time 
sampled from the 
distribution. If checked 
an additional arrival will 
occur immediately when 
the model starts running 
(at time zero). 

Check this when work 
enters the simulation 
only when required (i.e. 
when a Work Center it 
feeds is ready for it) 

Batching tells this 
Work Entry point to 
deliver Work Items in 
groups. See Batching 
on page 272. 

Access the 
performance 
measures that have 
been collected as the 
model ran.  See 
Results on page 299. 

The Memo button lets the user add detailed 
documentation about each simulation. 

Enter the inter-arrival 
time of Work Items here: 
usually the mean, or 
average, value of the 
random numbers to 
supply - but not always - 
see the label above the 
box. 

Click the arrow in this 
field to select the type of 
statistical distribution 
used to supply these 
values as the model 
runs.  See Distributions 
on page 213. 

Change the image used 
to show a Work Entry 
Point and the Current 
Image. See Graphics / 
Images on page 385. 

Describes how the 
Work Entry point 
distributes Work Items 
to the next stage in the 
process.  See Routing 
Out Page 267. 

Use this button for activity-based 
costing analysis. See Financeon page 
321. 
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Storage Bin 

Description  
A Storage Bin is an object in which Work Items can ‘queue’ up.  They act as 
buffers/queues in between steps in a process or as storage areas for 
inventory or work-in-process. 

Properties 

• Name  

• Capacity - limits the number of Work Items that can ‘fit’ in Storage 
Bin 

• Shelf Life – number of time units before Work Items ‘expire’ 

• Min Wait Time – minimum time Work Items must stay in Storage 
Bin 

• Results - results about the object 

• Start-Up – initial contents of the Storage Bin on model start 

• Contents – displays the Storage Bin’s current contents 

• Graphics - change the Storage Bin’s appearance 

Common Uses 

• Feeding Queues, buffers in between processes, Inventory… 

• Storage/Holding Areas 

• Waiting/Drying areas 

• Kanban System 

• IVR Waiting Lines 

Storage 
Bin 
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Visual Reference Guide – Storage Bin 

A check here indicates that there is 
no limit on the number of Work Items 
that can be in this Storage Bin. 

Number of time units before items in this queue 
become "out of date.”  Out of date items can be 
removed by Work Centers that have "Expired only" 
as their Routing In discipline. See Selection 
Method on page 257. Double-click this field to use 
a label on the item rather than a fixed value. 

When Work Items 
enter a prioritized 
Storage Bin, they 
are sorted into order 
of the values in a 
label.  Higher value 
labels are defaulted 
to the front of the 
queue.  When 
checked, a list of 
available labels will 
be displayed.  See 
Priority on page 
245. 

Lets user specify 
what is in this 
Storage Bin (queue) 
at the start of the 
model run - Saves 
having to wait a 
long time for the 
model to reach 
normal operating 
conditions. 

Use Last-In-First-
Out rule to 
sequence Work 
Items through this 
Storage Bin.  If this 
is checked then the 
item at the front of 
the queue is always 
the one that arrived 
in the queue most 
recently. Not 
relevant if the bin is 
prioritized on a 
label. 

The name of the Storage Bin (queue). 

Results information can be categorized by Labels on Work 
Items.  If option is clicked, the user will be asked for a label 
name that will contain numbers to be used for categorization.  
See Segregating Results on Labels on page 307. 

Use this button for activity-
based costing analysis.  
See Finance on page 321. 

Access the 
performance 
measures that have 
been collected as 
the model ran.  See 
Results on page 
299. 

Change the image and/or type of 
icon (tank, queue, graph, etc.) that 
represents a Storage Bin. See 
Graphics / Images on page 385. 

Use High Volume/BPR options.  The quantity label will be used to account for 
capacity and the display of current contents. See Special Labels on page 210. 

The minimum time a 
Work Item must 
stay in the Storage 
Bin.  See page 190. 
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Work Center 
Description  
Work Centers are where Work Items are processed.  Usually, some time is 
taken to perform the task and sometimes this requires one or more 
resources. 

Properties 

• Name  

• Timing - time to process Work Items set via a distribution 

• Results - results about the object 

• Resources - set Resource requirements to perform task 

• Efficiency - specify breakdowns, repairs 

• Routing In - how Work Items enter the Work Center  

• Routing Out - disciplines by which the work leaves the object  

• Label Actions - Work Item label values changed here 

• Priority – how this Work Center competes against others for 
resources 

• Replicate – a simple way to copy the Work Center 

• Contents – displays the Work Center’s current contents 

• Graphics - change the Work Center’s appearance and animation 

Common Uses 

• Process Tasks 

• Machines 

• Work Item manipulation – Labels, batch size, routing…. 

Work 
Center 
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          Visual Reference Guide – Work Center 

 

 

 

 
 

 

The name of the 
Work Center.  
Change this to 
something 
meaningful like 
CNC Machine, 
Help Desk, or 
Operating Room, 
etc. 

Timing dictates timing intervals – 
i.e. Standard, Jobs Matrix, or Cycle 
Matrix. Click button for details.  See 
Alternative Routing/Timing 
Methods on page 275. 

High Volume converts the 
timing information by 
multiplying the Timing for 
the Work Center by the 
value in the Work Item's 
Quantity Label. See Special 
Labels on page 210. 

Describes how the Work 
Center distributes Work 
Items to the next stage in 
the process. See Routing 
Out on page 267. 

Replicate is a simple way to copy a 
Work Center. See Copying Objects on 
page 204. 

When highlighted, view Work Items, and their properties, 
that are currently in this Work Center. 

Accounts for 
scheduled down-time 
at Work Center. See 
Calendars on page 
200.  

Enter the first parameter of 
the distribution here; usually 
the mean, or average, value 
of the random numbers to 
supply - but not always - 
see the label above the box. 

Click the arrow in this field 
to select the type of 
statistical distribution used 
to supply these values as 
the model runs. See 
Definition on page 213. 

Access the performance measures 
that have been collected as the model 
ran.  See Results on page 299. 

Use this button to input 
costs for activity-based 
costing analysis.  See page 
321. 

Change the images that represent this 
Work Center and its various states. See 
Graphics / Images on page 385. 

Set floating Resources (labor, jigs, 
tools, etc.) required to do work at this 
Work Center. See Resources on page 
231. 

Determines how this 
Work Center 
competes against 
others for 
resources. See 
Priority on page 
245. 

Accounts for unscheduled 
down-time at the Work 
Center. See Efficiency on 
page 251. 

Dictates what Work Center 
is to do to labels of Work 
Items as they depart. See 
Label Actions on page 209. 

Describes where and how 
the Work Center receives 
its work. See Routing In on 
page 257. 
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Work Exit Point 
Description  
Work Exit Points provide a means for Work Items to leave the simulation 
model.  SIMUL8 records overall and summary Work Item process statistics 
at these points. 

Properties 

• Name  

• Results - results about the object 

• Graphics - change the object’s appearance 

• Halt Model at Limit – stops model when number specified is 
reached 

Common Uses 

• End of process 

• Gathering end of run results 

• Stopping model when a certain number of Work Items complete 

 

Work Exit 
Point 
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Visual Reference Guide – Work Exit Point 
 

Name of the Work Exit Point - 
change it to something meaningful 
like Products Complete or Patients 
Recovered. 

Results information can be 
categorized by information in 
the Work Items.  If clicked, the 
user will be asked for a label 
name that will contain 
numbers to be used for 
categorization. See 
Segregating Results on 
Labels on page 307. 

The number of Work Items 
arriving at this Work Complete 
Point before model automatically 
stops. This facility enables the 
user have the model stop when 
a certain number of Work Items 
have been processed. If this is 
checked, model may not reach 
the end of its normal Results 
Collection Period.  See 
Results Collection Period on 
page 165. 

Results based on Quantity label. See 
Special Labels on page 210. 

Access the 
performance 
measures that 
have been 
collected as the 
simulation ran. 
See Results on 
page 299. 

Change the 
image that 
represents a 
Work Exit Point. 
See Graphics / 
Images on page 
385

Use this button to specify 
revenues for activity-based 
costing analysis.  See  
Monetary units can 
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Resource 
Description  
Resources are items in the model that Work Centers can be set to require 
before Work Items can be processed.  Thus, they represent either staff or 
special tools.  Work Centers that have a Resource requirement cannot begin 
work until both a Work Item and the specified Resource are available.  
Resources can also be ‘shared’ between multiple Work Centers, favoring 
Work Centers with the highest Priority setting. 

Properties 

• Name  

• Number Available – specify the number of this Resource type 
available 

• Shift Dependent – have the Resource availability follow shift 
patterns  

• Pool Resource – ‘Pool’ one or more Resource types 

• Results - results about the object 

• Travel – travel time for Resource movements between objects 

• Graphics - change the object’s appearance and visual behavior 

Common Uses 

• Process Operator 

• Workers or staff required 

• Parts required by operation, such as a tool or key 
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Visual Reference Guide – Resource 
 

Shows the list of shifts and the 
number of this Resource available 
during each shift. 

A Resource Pool is a 
list of SIMUL8 
resources that are 
available to take the 
place of other 
resources. When 
checked, Work 
Centers that require 
this Resource can be 
given any Resource 
from the list of 
members. See Pooled 
Resources on page 
234. 

Specify the Members of a 
Resource Pool (i.e. Add/remove 
Resources to/from pool.) 

Shows the availability of Resource at all times. 
This number can be changed during a run, but 
resources that are currently at Work Centers will 
stay there until their work is finished. Grayed out 
when Shift Dependent is checked. See Creating 
and Attaching a Resource on page 231. 

When checked the 
number of resources 
available can be 
different in each shift. 
See Shifts on page 
241. 

Name of the Resource – e.g. Press 
Operators, Power, Fork Trucks, etc. 

Use this button to specify 
revenues for activity-based 
costing analysis.  See page 
321. 

Change the image that 
represents a Resource. See 
Graphics / Images on page 
385. 

Access the 
performance 
measures that 
have been 
collected as 
the simulation 
ran. See 
Results on 
page 299. 

Specify 
Resource 
travel times 
manually, 
automatically, 
or in a matrix. 
See Traveling 
Resources on 
page 236. 

Automatically adjusts any 
Work Center that requires this 
Resource to the maximum 
number of resources available 
where replicate is allowed. 
See Replicate on page 195. 
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Chapter 9:  Starting Up 

The Start-Up Screen 
The start-up screen, as shown below, is displayed each time SIMUL8 is 
opened.  Choices of opening a recent model, creating a new simulation, or 
using a sample simulation as a starting point are available.   
 

 
Figure 9-1: Start-Up Screen 

To create a new blank simulation, click on Simulation under Create New.  A 
number of file types, including Visio, XML, BPEL, SDX and Witness files, 
can also be imported under Create New.  Additionally, choosing to open 
one of the sample simulations listed under Create from Samples can serve 
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as a good starting point for a simulation, and help save on simulation 
development time. 

Setting Clock Properties 
When setting up a simulation, it is important to set a number of clock 
properties.  Time units should be selected to best represent the working of 
the simulation.  For example, if process times are a few seconds, the time 
units should be set to seconds rather than hours.  The number of hours per 
day and days per week should be defined, as well as the total running time 
for the simulation.  There are also a number of different formats for 
viewing the simulation clock as well as speed and warm up time options. 

The simulation clock shows the simulation progress as it runs.  The clock 
display can be moved around the main simulation screen or can be docked 
with the other toolbars.  There are a number of properties of the simulation 
clock that can be set.  Select Clock > Clock Properties to edit these 
properties.   

 
Figure 9-2: Accessing Clock Properties 
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Figure 9-3: All Clock Properties  

Time Units 
The simulation can be set to run in seconds, minutes, hours, or days.  This 
will apply to the model running time as well as parameters entered 
throughout the model. 

Time Format 
The clock displayed on the main screen can be shown in a number of 
different formats. 

1. Simple unit count from zero – displays the count of time units as 
specified 

2. Time Only – displays the time 

3. Time & Day – Displays the time and day of the week (see Days for 
further options) 

4. Digital – Displays the time in digital format (select from HH:MM, 
HH:MM.000, HH:MM:SS, HH:MM:SS.000) 

5. Clock Face – Displays the time in clock face format 
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Days 
If Time & Day has been selected from the Time format options, the 
following options will be available. 

1. Day – Displays the day of the week 

2. Day, Week – Displays the day of the week and the week number 
starting with “Week 1.” 

3. Mon, Tue, Wed… - If checked, will display abbreviated weekday 
name, otherwise will display numbers 1-7.  The first day of the 
week is considered as Monday. 

4. Days per week – Sets the number of days per week that the 
simulation will run. 

Running Time 
This is used to determine the period for which the simulation model will 
run.  The start time for each day the simulation will be running should be 
entered in HH:MM format.  The number of hours and minutes that the 
simulation will run each day can then be entered in HH:MM format.  The 
Warm Up Period and Results Collection Period can be specified. 

Warm Up Period 
This is the amount of time allowed for the simulation to reach a steady 
state.  The simulation will begin to collect results after the warm up period 
has been completed.  Note that the simulation clock will start counting 
during the Warm Up Period. 

 
Figure 9-4: Warm Up Period Dialog Box 



Starting Up SIMUL8 Reference  •  165 

Copyright Visual Thinking International 2007 

Results Collection Period 
This is the amount of simulation run time following completion of the 
Warm Up Period.  The total amount of time that the simulation will run for 
is, therefore, Warm Up Period + Results Collection Period.  The option 
‘Include in displayed clock time’ dictates whether the clock should reset at 
the end of the Warm Up Period or if the clock runs continuously into the 
Results Collection Period. 

 
Figure 9-5: Results Collection Period dialog box 

Simulation Speed 
The simulation running speed can be altered using the Speed scrollbar.  
This can be docked or moved around the main simulation window.  The 
arrows can be used or the square can be dragged to speed up or slow down 
the simulation animation.  This operates in much the same way as other 
scroll bars such as MS Word™ or Excel™. 

 
Figure 9-6: Changing simulation speed 

Simulation Preferences 
Simulation Preferences determine the general properties of the simulation 
model being developed.  There are a number of properties that can be set 
by selecting File > Preferences.   
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Figure 9-7: Undo Preferences 

The Undo preferences allow the user to speed up SIMUL8’s interactive 
capabilities.  However, by removing the Enable Undo, previous actions will 
not be saved, removing the ability to return to previous states within the 
model and remove mistakes. 

 
Figure 9-8: Distance Preferences 
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These options allow the user to: 

1. Change between meters and feet as the unit of distance 
measurement throughout the model.  This also alters the text 
provided in user inputs and reports. 

2. Travel Times can be automatically calculated based on an 
AutoCAD layout.  Typically, this function is not used.  It is advised 
that at the beginning of a model building exercise this feature is 
switched off and Set as the Default option. 

3. Resources that are shared between Work Centers can have travel 
times associated with the movement between these objects or not.  
When Resources are attached to Work Items as they travel through 
a sequence of Work Centers, more computer memory is required.  
Therefore, it should only be selected when necessary. 

 
Figure 9-9: Files Preferences 

These options allow the user to: 

1. Only save the basic model – this will remove all results collected 
within the model, including results from multiple runs stored 
within internal spreadsheets. 

2. Include Titles in exported data - When exporting data to other 
spreadsheets, it is advisable to include the titles as well as the data.  
If sending information to already formatted and titled spreadsheets, 
this option can be switched off to save time. 
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3. By saving the Random Number Stream, the simulation will always 
run with the current number stream allowing the user to compare 
eliminate the effects of different random number streams while 
developing the model.   

4. Provides a list of simulation objects in text format for exporting to 
another package, as opposed to copying the actual simulation 
objects for exporting to another simulation model. 

5. Flash screen is typically used for templates created from SIMUL8.  
If the template is a resalable product, then the product logo can be 
flashed in front of the user as the model is opened.  By clicking on 
Select File, the standard Windows™ browser will be opened.  
Preferred formats for files are JPEG or BMP.  

6. As simulation models can be saved as XML as well as standard S8 
(SIMUL8) format, the option is provided to save as preferred. 

 
Figure 9-10: Results Preferences 
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These options provide the user with control of the results being saved 
within the simulation model: 

1. Allow users to add new items to the Results Summary 

2. Ignore the startup contents of queues in final Results Summary 
statistics. 

3. Change the Results Synchronization Period, this changes the 
numbers of updates provided on the on-screen charts as accessed 
within the individual Results sections of simulation objects. 

4. Set results synchronization to take place after all other events have 
taken place in a given Results Synchronization Period. 

5. Govern resource statistics collection. 

6. Use a random number generator external to SIMUL8. 

7. By switching off the option to Store Run / Trial Results for 
Comparison, it is possible to speed up the execution of simulation 
runs.  This is especially useful if when exporting results to Excel™, 
or other packages and saving them there. 

8. Options for results stored from trial are set to default only as the 
average figures; this minimizes the amount of data that needs to be 
stored. 

9. Allow multiple PCs to collect simulation data for faster results 
collection and analysis. 

 
Figure 9-11: Results Export Options 

All automatic exporting functions are kept under File > Preferences > 
Results > Result Export Options.  This provides the ability to export any 
results held within the Results Summary of the model currently open.  All 
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these results will be exported line by line after each run or trial depending 
upon which option is chosen at the right hand side of this dialog box. 

 
Figure 9-12: Speed Preferences 

By selecting the Keep Visuals Constant option, the simulation will run with 
animations determined by the speed bar.  The Keep Clock Constant will 
alter the graphical requirement in order to keep the clock as constant as 
possible.  This is more consistent with real-life, but requires extra computer 
memory while running the model. 

 
Figure 9-13: Automation Preferences 

SIMUL8 has the ability to help the user develop models with smart logic 
that adjust the names of Storage Bins to the corresponding Work Center 
that it feeds.  For example, if a queue leads to a Work Center named 
Milling, its preceding Storage Bin will automatically be named Queue for 
Milling.  Of course, this is far more intuitive than multiple Storage Bin 
names of “Storage Bin 1” or “Storage Bin 2,” etc. 
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Smart logic will also help the user by automatically linking simulation 
objects as they are created.  When there are multiple routing options and 
complex systems, it is sometimes more useful to switch this option off, 
especially if the Jobs Matrix is going to be utilized. 

 
Figure 9-14: Display Preferences 

The display preferences provide the following options: 

1. Default settings for the toolbars consisting of the File + Edit, 
Speed, Run and Build tools placed along the top of the screen with 
the Graphics and Style tools available along the bottom of the 
screen. 

2. The default library window provides the user with options for 
graphics, as simulation objects are created on the screen.  This is 
especially useful when a model is being created as a sales tool. 
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3. An assistant is available for questions as the model is being created, 
very much like the paper clip from Microsoft Office.  Generally 
most simulation users prefer to use the Help provided from the 
menu bar so this option defaults to the switched off mode. 

4. The next four options all pertain to the use of arrows connecting 
objects within and between sub windows.  By keeping the mouse 
inside a sub window, it restricts the connectivity provided by the 
routing arrows.  The next three options are graphical 
representations between objects, showing dotted lines joining 
objects within sub-windows to objects below in other sub windows 
– sometimes these arrows can be misleading as they appear to 
connect to nothing, hence there is an option to switch the 
functionality off. 

5. In SIMUL8 Release 12, a new graphical interface was created for all 
the tool bars and the simulation objects.  The old interfaces are still 
supported for those who favor the previous style. 

      
 Figure 9-15: Release 1-9 Interface 

 
 Figure 9-16: Release 9+ Interface 

 
Figure 9-17: Release 12+ Interface 

6. The route arrows throughout a simulation window are by default 
displayed while the model is developed and are hidden while the 
model is running.  Most models with multiple routings can become 
visually clumsy with the routing arrows switched on; hence, it 
defaults to the off position. 

7. Using SIMUL8 Release 12 graphics, default object images can be 
selected to suit a business, call center, health care, or manufacturing 
simulation model. 
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8. Adjust the appearance of queues using the Storage Graphic Tank 
Color Scheme drop down options. 

9. When using a scroll mouse and/or the buttons to the side of the 
zoom capability, the zoom features will step through the 
percentages.  To change the zoom capabilities, enter a different 
step value here. 

10. In the results sections of simulation objects, there are graphs that 
can be displayed during the simulation run.  These will update 
every ‘x’ seconds of clock time – not simulation clock time.  
Change this option to update faster. 

 

 
Figure 9-18: Finance Preferences 

The Finance Preferences allow the use of different currencies.  Use the 
letter “e” to represent a Euro.  The € will appear in all of the corresponding 
Finance displays. 

 
Figure 9-19: Continuous Preferences 

These options allow the user to determine the continuous process default 
values for units.  When creating continuous process simulations, few trigger 
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points exist for Visual Logic.  A System Dynamics Slice determines the 
frequency of Visual Logic calls, and therefore the model accuracy.  To 
increase model accuracy, decrease the time slice variable. 

 
Figure 9-20: Compatibility Preferences 

The Compatibility Preferences allows the user to decide which features are 
shown and used.  It also allows users who are accustomed to certain 
features and logic from prior versions to continue using these older options. 
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Figure 9-21: Spell Preferences 

These options allow the user to decide when and if the automatic spell-
check is applied.  In addition, these options allow Visual Logic debugging, 
and can define whether the stack (i.e., the hierarchy of functions calling 
each other) is tracked automatically, or whether the user must turn on this 
tracking when desired. 

Toolbars 
SIMUL8 provides a number of toolbars that can be switched off or on and 
are dockable.  To access these toolbars, select Tools > Toolbars from the 
main menu bar.  These toolbars provide the ability to control various 
aspects of the simulation, such as providing graphics running the model, 
building, and saving the model. 

 
Figure 9-22: Accessing Toolbars 
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File/Edit Tools 

 
Figure 9-23: File + Edit 

This toolbar allows the following capabilities: 

1. Open – Allows browsing to open another simulation model.  This 
will close the current simulation model and prompt to save the 
current model if it has not already been saved. 

 

 
Figure 9-24: Open Simulation Browsing 

2. Save – If the simulation model has been previously saved, the 
changes will be saved to replace the previous model.  Otherwise, 
the Save As dialog box will provide the ability to browse for a 
location and name for the model.   
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Figure 9-25: Save As Dialog 

3. Print – The current screen can be sent to the printer.  The option 
to print to file is also available.  The file will be saved under 
Examples/Others within the SIMUL8 directory 

4. Undo – The last action or change to the simulation model will be 
reversed.  This is available as long as the Undo capability is enabled 
and will set the simulation clock to 0 unless specified otherwise (see 
the Simulation Preferences section on page 165).  The previous 20 
actions are stored and can be reversed.  A particular action can be 
selected by using the Edit menu options.  If an earlier action is 
selected, all changes made to the model after this action will also be 
reversed.  The option to Redo is also provided here to reverse the 
changes of the last Undo.  

 Use Ctrl+Z to  
undo  
 

 Use Shift+Ctrl+Z   
to redo  
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Figure 9-26: Edit Menu 

5. Zoom – The size of the active window content can be altered.  The 
+ and - buttons incrementally increase and decrease its size.  
Entering a number inside the edit box can also set the size of the 
window content. 

6. VR Simulation– Click on this button to convert your 2-D 
simulation to a 3-D one!  Click again to revert back to a 2-D view. 

Simulation Speed 

 
Figure 9-27: Speed Bar 

This toolbar is used to control the animation speed during the simulation 
run.  (See the section on Simulation Speed on page 165.)  Setting it to the 
far right shuts off animation completely and runs the simulation to the end 
as quickly as possible. 

Run Tools 

 
Figure 9-28: Run Tools  

This toolbar provides control for running the simulation model and viewing 
results: 

 Use the mouse 
wheel inside the 
active window to 
change the size of 
window contents  
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1. Reset Clock to Start – Sets the simulation clock back to 0. 

2. Step – Moves the simulation to the next timed event. 

3. Run – Runs the simulation model at the current speed.  A number 
of drop-down options are also provided. 

 
Figure 9-29: Running Options 

• Run with new random numbers – Resets the simulation and 
runs it at the current speed with a different set of random 
numbers. 

• Trial (multiple runs) – Conducts a trial. 

• Run max speed to full time – Runs the simulation until the end 
of the results collection period at the fastest possible speed. 

• <<Back 10 minutes, <Back 1 minute, >Forward 1 minute, 
>>Forward 10 minutes – Moves the simulation instantly back 
or forward by the given number of minutes. 

 
Figure 9-30: Go to time Dialog 

• Go to Simulation Time… - Moves the simulation instantly on 
to the time specified in the input box provided. 

 Ctrl+B to move the 
simulation back 1 
minute  
 

 Ctrl+H to move the 
simulation forward 1 
minute  
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• Step (1 event) - Moves the simulation on to the next event. 

4. Run a Trial and Display Results– Automatically runs a trial using 
the current random number stream and displays the Results 
Summary at the end. 

5. Make Time Graph of selected objects – Displays a chart showing 
the content of the selected objects over the course of the results 
collection period. 

6. Show Data Sheet – Displays the spreadsheet information store 
currently set as the main sheet. 

7. Results Summary – Displays results summary sheet.  (See the 
section on Results Summary on page 299.) 

8. Financial Summary – Displays the Income Statement for the last 
simulation run, including revenue, cost and profit information. 

 
Figure 9-31: Simulation Assistant 

9. Simulation Assistant – SIMUL8 continuously monitors the 
simulation model.  If SIMUL8 recognizes the opportunity to 
provide any relevant advice to help with modeling, the Simulation 
Assistant button will light up on the toolbar.  Clicking the button 
will display the Simulation Assistant.  Advice is summarized and, in 
some cases, the options to view further detail or background 
information are available.  In addition, the option is provided to 
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prevent the Simulation Assistant from giving the same or any 
advice again. 

Build Tools 

 
Figure 9-32: Build Tools  

This toolbar contains the basic simulation objects to construct a simulation.  
These will be discussed in more detail in Chapter 2 Creating and Navigating 
in SIMUL8.  The two right-most buttons are options to switch on or off 
the route arrow drawing mode and the viewing route and Resource arrows. 

Options: 

1. Create Work Entry Point 

2. Create Storage Bin 

3. Create Work Center 

4. Create Work Exit Point 

5. Create Resource 

6. Route Drawing Mode 

7. Show/Hide Route Arrows 

Build Tools 2 

 
Figure 9-33: Build Tools 2 

This toolbar contains the Conveyor object and any other objects included 
in installed SIMUL8 Plug-ins (i.e., load/unload point, vehicles, etc). 
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Graphics Palette 

 
Figure 9-34: Graphics Palette 

The Graphics Palette provides the capability to customize models with on-
screen static graphics and data.  The arrow button, which selects or moves 
graphic objects, is also used to exit any of the graphic editing buttons. 

To add a graphic to the window, click the button to select the graphic.  The 
graphic is placed on the main screen by clicking to position the first handle, 
then dragging and releasing to position the second handle.  Click on a 
graphic to see the handles appear.  The graphic can then be moved or 
resized.  To select more than one graphic at a time, hold down the Ctrl key.  
Graphics can also be deleted with the delete key. 

The following graphics can be added to the main window. 

1. Box – Box outline 

2. Solid Box – Box outline and fill 

3. Rounded Box – Box outline with rounded corners 

4. Rounded Solid Box - Box outline and fill with rounded corners 

5. Circle – Circle or oval outline 

6. Solid Circle - Circle or oval outline and fill 

7. Line – Straight line 

Other items, which can be added to the main window, can also be moved, 
resized, and deleted in the same way as the previous graphics. 

 
Figure 9-35: Visual Data 

8. Visual Data – This interesting and useful feature displays a text or 
numerical Information Store on screen that updates as the 
Information Store changes over the course of the simulation.  To 
add Visual Data to the screen click on the button, click on the 

 To lock images on 
the screen and 
prevent accidental 
editing, close the 
Graphics Palette.  

 A number variable 
must be created in 
the Information Store 
before it can be 
displayed on the 
screen  
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screen and select the required variable from the drop-down list 
provided. 

9. Write Text – Position a text box as with other graphics and then 
type text into the box. 

10. Load Graphics from Disc – Click on the button, click on the 
screen and browse the background images.  Images should be 
saved in .bmp or .jpeg format.  Images can be moved but must be 
resized with a graphics package. 

11. Floor, Wall, and Static Object – Click on one of these buttons and 
place the object onto the main window.  These objects will 
supplement your simulation image when you click on the “VR 
Simulation” button in the File/Edit toolbar. 

12. The Snap to Grid button provides assistance in position and 
aligning graphics. 

13. Rotate – This button rotates the selected image 90 ˚ clockwise. 

14. Flip – Creates a mirror image of the selected image, across the 
horizontal axis. 

15. Mirror – Creates a mirror image of the selected image, across the 
vertical axis. 

16. Edit – Brings up the SIMUL8 Image Editor Dialog box for direct 
image editing. 

Style Palette 

 
Figure 9-36: Style Palette 

The Style Palette provides the capability of formatting graphics, data, and 
text as outlined in the previous section. 

1. Color Palette - The color palette is provided for use with graphics 
from the previous section. 

2. Line Color Box - To alter the color of the graphic outline, click on 
the Line Color box (left box in Figure 9-36) and select a color from 
the palette. 
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3. Fill Color Box - To alter the color of the graphic fill, click on the 
Fill Color box (right box in Figure 9-36) and select from the color 
palette. 

 
Figure 9-37: Text Font and Color 

4. Font Size and Color – This option is provided for editing Visual 
Data and Text.  Font type, style, size, effects, and color can be 
selected.  

5. Include Arrowheads on Lines – This is used only in conjunction 
with the line graphic and when checked adds an arrowhead to the 
selected line. 

6. Line Thickness – This option can be used to increase or decrease 
line thickness for any of the graphics from the previous section. 

Using the toolbars provided allows the ability to build, save, and run models 
quickly.  In addition, models can be customized to represent particular 
operations by utilizing the capability of the Graphics and Style Palettes. 

Keeping Updated 
SIMUL8 is a constantly evolving product.  As manufacturing, production, 
and work flow systems change, a list of additions and alterations within 
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SIMUL8 exist.  As a result, all SIMUL8 users are encouraged to keep their 
copy of SIMUL8 up-to-date. 

This is facilitated through free upgrades available to all users within a 
version release.  These can be found at http://www.simul8.com/upgrades/.  
Users who have downloaded a new release will be included in the 
notification list for all subsequent new releases. 

New version releases of SIMUL8 are typically available after a one-year 
period.  A full list of new features and functionality will be provided at the 
time of release.  Normally at this time, there will be no longer any new 
releases of the previous version made.  Users can opt to upgrade or to 
remain with their current version depending upon the usefulness of the new 
features.  It is advised that users keep up to date with any new features 
released in subsequent builds within a version, as often the new features will 
resolve a programming issue currently faced by users.   

The SIMUL8 User Café is one of the most valuable resources for 
discussing new features within SIMUL8, their application, and any potential 
problems, with other users as well as the SIMUL8 Support Team.  A 
member of the SIMUL8 support or development team will answer any 
questions on bugs within the software.  This can be found at 
http://www.simul8.com/cafe/. 

The Help menu contains several options for obtaining up-to-date help in 
creating SIMUL8 simulation models: 

 
Figure 9-38: Help Options 
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Some of the Help options provide access to different areas within the Help 
Files.  Examples Libraries are provided to show users how certain features 
can be used within the modeling environment.  Show me How Movies 
provide the user with systematic guides to building basic models.  
ASK.simul8.com provides access to the on-line Knowledge base and the 
user café.  The About option will provide information on the Version 
Number, and if the version # is double-clicked it will provide the Build 
Number.  If the Build Number shown is less that the current Build Number 
available on the web the user should download the latest release.  After 
downloading a new release, the user should examine Latest Changes to see 
what new features, functions, and commands are now available. 

If the Help file does not provide the desired answer, call support on 1-800-
878-3373. 
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Chapter 10:  
SIMUL8 Basics 

Introduction to Objects 
SIMUL8 simulations are built using the basic objects provided in the Build 
Tools and Build Tools 2 toolbars.  This section introduces these objects 
and their basic properties. 

  
 

            2        3      4        5        6                 7 

Figure 10-1: Basic Objects 1 

1. Work Items 
The most fundamental SIMUL8 objects are called Work Items.  These 
move through the model and represent the entities to be processed, such as 
widgets in a factory, phone calls in a call center, or patients in a hospital.   

 
Figure 10-2: Work Item Properties 
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1. The name of this Work Item type.  This can be changed to 
something relevant to the simulation. 

2. Labels – Shows the labels relevant to this Work Item type.  They 
are added automatically when a label is created but can be added or 
removed. 

3. Image – An image can be selected to represent the Work Item type.  
See Graphics / Images on page 385. 

4. Size – A size is specified for use with Conveyors.  Double-clicking 
on feet opens the Preferences dialog for changes the default length 
unit for the simulation. 

5. Advanced – This allows Work Item types to be added, deleted, or 
browsed. 

Multiple Work Item Types 

There are two methods for distinguishing between items traveling 
through a SIMUL8 simulation.  The most common and popular 
method is to use labels.  However, it is possible to have multiple Work 
Item types.  As opposed to distinguishing between different types of 
product, these would distinguish between a product and a vehicle, for 
example.  Each Work Item type will have the same properties as 
introduced above.  Multiple Work Item types slow down a simulation 
and are not recommended for large models. 

2. Work Entry Points 
A Work Entry Point is where Work Items enter the simulation model.  
Here they can be specified to arrive at a certain rate and have set label 
values.  Examples of Work Entry Points are a dock where inventory arrives 
at a warehouse, a telephone that introduces customers’ inquiries into a call 
center, or a door through which patients enter a clinic. 

 Since all properties 
of a Work Item can be 
manipulated using 
labels (i.e. graphics 
and size), multiple 
Work Item types are 
rarely used.  
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Figure 10-3: Work Entry Point Properties 

1. The name of this Work Entry Point – This can be changed to 
something meaningful for the model.  It can be displayed in the 
simulation window.  Click Title in the Graphics button dialog. 

2. Input Work Item Type - Defines the "Work Item Type" that this 
Work Entry Point brings in to the model. 

3. Inter-arrival Times - Enter here the inter-arrival time of Work 
Items.  Parameters required will change depending on the 
distribution selected. 

4. Distribution - This dropdown provides a number of statistical 
distributions used to supply these values as the model runs.  Users 
can also create their own, as explained in Chapter 12: Distributions. 

5. First at Start Time – Normally, the first arrival will be at the time 
sampled from the distribution.  If this box is checked, an additional 
arrival will occur as soon as the model starts running. 

6. Unlimited Arrivals - If this box is checked, work enters the 
simulation exactly when required (i.e. when a Work Center it feeds 
is ready for it) 
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7. None – Turns off the work entry point from bringing work items 
into the model. 

8. File – The user can determine the exact simulation time at which 
work enters the model by checking this box and selecting a .csv file 
to use.  In addition, the user can set a work item label to be a value 
also defined in the file.  The .csv file must be formatted in the 
following way: 

 

 

 

 

 

 

The label name must be exactly the same as the label name within 
SIMUL8.  The .csv file must be closed before running the 
simulation model. 

9. Finance – Adds a capital cost and/or a cost per unit for each work 
item that enters the simulation. 

10. Erase – Deletes the Work Entry Point. 

11. Ignore hints about lost Work Items - Switches on/off the warning 
messages if SIMUL8 thinks the user has made a mistake that causes 
blocking of this Work Entry Point. 

12. Memo - The Memo button lets the user add detailed 
documentation about each simulation object.  When text is entered 
in the Memo area, the information will appear as pop-up text on 
mouse-over, so users can quickly understand what the Work Entry 
Point represents.  

13. Results - The Results button accesses the performance measures 
that have been collected as the model ran. 

14. Batching - The Batching button tells this Work Entry Point to 
deliver Work Items in groups of the size specified. 

Simulation Name   

< name> Inter-arrival Time <label name> 

 0.5 1 

 0.6 2 

 … … 
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15. Routing Out - The Routing Out button describes how the Work 
Entry Point distributes Work Items to the next stage in the 
process. 

16. Label Actions - Label Actions determines what changes to make to 
the Work Item’s labels as they leave the Work Entry Point. 

17. Graphics - The Graphics button changes the properties of the 
Work Entry Point’s image and title.  

18. Current Image – Shows the present screen display for the Work 
Entry Point. 

3. Storage Bins 
A Storage Bin is where Work Items can queue or be stored between 
process steps.  Examples would be an in-basket, waiting room, inventory 
holding, or telephone call on-hold. 

 
Figure 10-4: Storage Bin Properties 

1. The name of this Storage Bin – this can be changed to something 
meaningful for the model.  It can be displayed in the simulation 
window.  Click Title in the Graphics button dialog. 

2. Capacity - A check here indicates that there is no limit on the 
number of Work Items that can be in this Storage Bin. 
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3. Shelf Life - Number of time units before items in this queue 
become "out of date.”  Out of date items can be removed by Work 
Centers that have "expired only" for their "routing in.”  Double-
click this field to use a label on the item rather than a fixed value.  

4. Min Wait Time – The minimum time a Work Item must stay in a 
Storage Bin.  This can be set to follow a distribution, label or 
variable by clicking on the ‘…’ button.  Extremely useful for 
simulating drying or cooling Work Items. 

5. Prioritize - When Work Items enter a prioritized Storage Bin, they 
are sorted into order of the values in a label.  The highest values are 
placed nearer the front of the queue.  When the box is checked, a 
list of available labels will be displayed.  

6. LIFO - Use Last-In-First-Out rule to sequence Work Items 
through this Storage Bin.  If this is checked, the item at the front of 
the queue is always the one that arrived in the queue most recently.  
Not relevant if the bin is prioritized on a label.  

7. High Volume – Use BPR / high volume options.  The quantity 
label will be used to account for capacity and the display of current 
contents.  Speeds up the simulation considerably. 

8. Segregate Results – Results information can be categorized by 
labels of the Work Items.  If this option is clicked, the user will be 
asked for a label name that will contain the categories by which to 
segregate. 

9. Finance – Adds a capital cost and/or a cost per item per minute for 
each work item waiting in the storage bin. 

10. Erase – Deletes the Storage Bin. 

11. Memo - The Memo button lets the user add detailed 
documentation about each simulation object.  When text is entered 
in the Memo area, the information will appear as pop-up text on 
mouse-over, so users can quickly understand what the Storage Bin 
represents. 

12. Results – The Results button accesses the performance measures 
that have been collected during the model run. 

13. Start-up – Lets the user specify the quantity and label values of the 
Storage Bin (queue) at the start of the model run.  This saves the 

Minimum wait time 
only functions when 
using labels as part of 
the reference if Work 
Items flow into the 
Storage Bin. If they 
are added using 
Visual Logic, no wait 
time will be applied.  
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need for Warm-up Time in certain situations as it quickly simulates 
normal operating conditions. 

14. Contents – Provides detail on the Work Items currently in the 
Storage Bin.  Quite useful for troubleshooting a simulation 

15. Graphics - The Graphics button changes properties of the Storage 
Bin’s image and title.  

16. Current Image - Shows the present screen display for the Storage 
Bin. 

4. Work Centers 
A Work Center is where Work Items are processed.  Typical characteristics 
of a Work Center include work inflow, process time, and work outflow.  
Some common examples are a desk, machine, or office.   

 
Figure 10-5: Work Center Properties 

1. The name of this Work Center – This can be changed to 
something meaningful for the model. 
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2. Timing – By default, timing is determined by the statistical 
distribution chosen directly below.  Click the button to use the Jobs 
Matrix or Cycle Matrix (Page 271) instead. 

3. Processing Time - Enter the time to process Work Items next.  
Parameters required will change depending on the distribution 
selected. 

4. Distribution - This dropdown provides a number of statistical 
distributions used to supply these values as the model runs.  Again, 
users can create their own, too. 

5. High Volume - Indicates that each Work Item entering the Work 
Center is actually a batch of Work Items, the quantity of which is 
defined by the Work Item’s Quantity label.  The High Volume 
check box converts the timing information by multiplying the 
processing time for the Work Center by the value in the Work 
Item's Quantity Label.  

6. Finance – Adds a capital cost and/or a cost per minute for each 
work item processed at the work center. 

7. Erase – Deletes the Work Center. 

8. Memo – The Memo button lets the user add detailed 
documentation about each simulation.  When text is entered in the 
Memo area, the information will appear as bubble text on mouse-
over, so that end-users can quickly understand what is represented 
by the Work Center. 

9. Results – The Results button accesses the performance measures 
that have been collected as the model ran. 

10. Resources – Set the floating resources (e.g. labor, jigs, tools, etc.) 
required to do work at this Work Center. 

11. Efficiency – Sets up the breakdown parameters for this Work 
Center. 

12. Routing In – Describes where the Work Center gets Work Items 
and how they are collected. 

13. Routing Out - Describe how the Work Center distributes its 
finished work to the next stage in the process. 

14. Label Actions - Label Actions determines what changes to make to 
the Work Item’s labels as they leave the Work Entry Point. 



SIMUL8 Basics SIMUL8 Reference  •  195 

Copyright Visual Thinking International 2007 

15. Priority - Lets the user determine how this Work Center competes 
against others for Resources or Work Items. 

16. Replicate - Replicate is a simple way to copy the Work Center.  Full 
Work Center facilities are not available if this option is chosen.  
(Instead, copy objects on the screen by dragging them or use the 
Duplication Wizard for full facilities.) 

17. Contents – Provides detail on the Work Items currently in the 
Work Center. 

18. Graphics - The Graphics button changes the image used to show a 
Work Center.  

19. Shifts – Sets the times this Work Center operates and its behavior 
during a shift change.  See page 241. 

20. Current Image - Shows the present screen display for the Work 
Center. 

21. On State Change – An access point for Visual Logic (to be 
discussed in more detail later) every time that the state of the work 
center changes. 

5. Work Exit Points 
A Work Exit Point is where Work Items can leave the simulated workplace.  
This must occur in order for SIMUL8 to record overall Work Item process 
statistics. 

 
Figure 10-6: Work Exit Properties 

 Change the 
image of a Work 
Center depending 
on its state 
(working, blocked, 
etc.) through Work 
Center Properties  
Graphics.  
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1. The name of this Work Exit Point – This can be changed to 
something meaningful for the model.  It can be displayed in the 
simulation window - click Title in the Graphics button dialog. 

2. Finance – Adds a capital cost and/or a revenue for each work item 
completed at that work exit point. 

3. Erase – Deletes Work Exit Point. 

4. Halt Model at Limit – Number of Work Items arriving at this 
Work Exit Point that automatically stops the simulation run.  If 
this is checked, model may not reach the end of its normal run.  
This facility enables the user to have the model stop when a certain 
number of Work Items have been processed. 

5. Segregate Results – Results information can be categorized by 
information in the Work Items.  If this option is clicked, the user 
will be asked for a label name that will contain numbers to be used 
for categorization. 

6. High Volume – Results will be based on the Quantity label. 

7. File – The user can determine the exact simulation time at which 
work exits the model by checking this box and selecting a .csv file 
to use.  In addition, all label values will be recorded.  The .csv file 
must be closed before running the simulation model, and can be 
opened again when the simulation is finished running. 

8. Memo – The Memo button lets the user add detailed 
documentation about each simulation.  When text is entered in the 
Memo area, the information will appear as bubble text on mouse-
over. 

9. Results – The Results button accesses the performance measures 
that have been collected as the model ran. 

10. Graphics - The Graphics button changes the image used to show a 
Work Exit Point.  

11. Current Image - Shows the present screen display for the Work 
Exit Point. 
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6. Resources 
A Resource is a special object that may be required by a Work Center in 
order to operate.  Examples are doctors required for surgery, workers at a 
machine, a receptionist at a desk, or a tool necessary for a specific task. 

 
Figure 10-7: Resource Properties 

1. The name of this Resource – This can be changed to something 
meaningful for the model.  It can be displayed in the simulation 
window - click Title in the Graphics button dialog. 

2. Number of this type of Resource available – When shifts are not 
used, the number of this type of Resource available for the 
duration of the simulation. 

3. Shift Dependent – When checked, the number of Resources 
available can be different in each shift. 

4. Shifts - Shifts allow the user to control the availability of a 
particular Resource at different times of the day or week.  See page 
241. 

5. Pool Resource – A Resource pool is a list of SIMUL8 Resources 
that are available for use at this Work Center.  When checked, 
Work Centers that require this Pool Resource will be provided a 
Resource from the list of members.  

6. Auto-adjust replicate levels – All Work Centers where this 
Resource is used will be adjusted to handle the maximum number 
of Resources available (where replicate is allowed). 
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7. Finance – Adds a cost per resource unit and/or a cost per resource 
unit per minute. 

8. Erase – Deletes Resource. 

9. Memo – The Memo button lets the user add detailed 
documentation about each simulation.  When text is entered in the 
Memo area, the information will appear as pop-up text on mouse-
over.  This can be used to easily provide an end-user with more 
insight into the function of the resource. 

10. Results – The Results button accesses the performance measures 
that have been collected as the model ran. 

11. Travel – Allows travel times to be set for Resources moving 
between different Work Centers where they are required. 

12. Graphics - The Graphics button changes the image used to show 
this Resource.  

13. Current Image - Shows the present screen display for the Resource. 

14. Find – Shows the present location of the Resource. 

15. Availability – Sets the percentage availability of the Resource, and 
the Resource’s average absence time.  Options are also available for 
detailed availability setup. 
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7. Conveyors 
A Conveyor is used to move Work Items around the simulation.  It has a 
certain amount of space for Work Items and moves them along its length 
from one end to the other.  The number of Work Items that can be held is 
dependent on the length of the Conveyor and the size of the Work Items. 

 
Figure 10-8: Conveyor Properties 

1. The name of this Conveyor – this can be changed to 
something meaningful for the model. 

2. Length – The length of the Conveyor (combined with its 
speed) affects how long it takes Work Items to travel from one 
end to the other.  The Length is also used with the "size" of 
Work Items to consider how many can fit on to a full 
Conveyor.  

3. Speed – How fast the Conveyor is moving relative to the time 
and size units.  This affects how long it takes a Work Item to 
travel from one end of the Conveyor to the other. 

4. Accumulating – Accumulating Conveyors are powered roller 
type Conveyors where all Work Items keep moving until they 
have all accumulated behind the item at the front of the 
Conveyor.  Otherwise, all Work Items stop when an item 
reaches the front until it leaves Conveyor.  

 Double-click on 
the units beside the 
Length or Speed 
input box to change 
units  
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5. Allow Gaps – If unchecked, the Conveyor will stop if no work 
is available to feed it until work arrives. 

6. Erase – Deletes Conveyor. 

7. Memo – The Memo button lets the user add detailed 
documentation about each simulation.  When text is entered in 
the Memo area, the information will appear as bubble text on 
mouse-over. 

8. Results – The Results button accesses the performance 
measures that have been collected as the model ran. 

9. Efficiency – Sets up the breakdown parameters for this Work 
Center. 

10. Routing In – Describes where the Conveyor gets Work Items 
and how they are collected. 

11. Routing Out – Describe how the Conveyor distributes its 
finished work to the next stage in the process. 

12. Label Actions - Sets up what this Work Center is to do to 
labels of Work Items as they leave the Conveyor. 

13. Contents – Provides detail on the Work Items currently in the 
Conveyor. 

14. Graphics - The Graphics button changes the image used to 
show this Conveyor.  

15. Current Image- Shows the present screen display for the 
Conveyor. 

The basic objects outlined in this section provide the building blocks to 
create an endless range of simulation models emulating a variety of different 
systems.  The following section will discuss an important feature that relates 
to many of the objects presented here. 

Calendars 
This section is included here as it is a useful function for determining the 
availability of many of the simulation objects previously discussed in this 
chapter.  The calendar is also used for setting the schedule for the entire 
plant or business being simulated.   The calendar is accessible through the 
Clock command menu. 
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Figure 10-9: Calendars 

Click on the drop down menu for the simulation start date to view an actual 
calendar.  Select a different month using the right and left arrows. 

 
Figure 10-10: Calendar Simulation Start Date selector 

Use the initial dialog box to create any number of calendars for the 
simulation and to edit any previously created calendars.  

 
Figure 10-11: Calendar Block out Periods 
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After clicking on new, set the properties of the schedule.  Check Main 
Calendar to apply this schedule to the entire plant.  If the schedule applies 
to specific objects and not to the entire plant, uncheck Main Calendar and 
instead check one or more of the objects in the list to the right.  

 
Figure 10-12: Calendar Unavailable Time Block 

The actual dates are set using manual add and inserting the dates as desired. 

Now that the basic simulation objects have been presented, the next section 
will describe how to build a basic simulation model using the objects 
described. 

Building a Model 
With SIMUL8, it is possible to quickly build a working simulation model 
and begin using it to analyze operations.  This section details how to build a 
basic simulation flow by placing objects on the simulation screen and 
linking to create a flow.  

Adding Objects to the Main Screen 
Objects can be quickly added to the main screen by clicking on the required 
object on the Build Tools 1 or Build Tools 2 toolbar.  Clicking on a location 
on the main window then adds that object to the screen.  As objects are 
added SIMUL8 may automatically create links. 

Moving Objects 
Objects can be moved around the simulation window by selecting an object 
or group of objects, dragging, and dropping it on a new location. 

Linking and Unlinking Objects 
As mentioned in the previous section, objects are often automatically linked 
by SIMUL8.  To view links between objects, click the Show/Hide Arrows 
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button on the Build Tools 1 toolbar.  Links can also be viewed via the 
Objects command menu and selecting Links.  This is particularly useful for 
larger models or those with graphics or titles hidden. 

 
Figure 10-13: Links 

1. To switch on or off the Route Drawing Mode, select the button on 
the Build Tools 1 toolbar.  This changes the cursor to a black 
arrow that can be used to link or unlink objects.  When clicking 
and holding the mouse button on an object, a black arrow and “?” 
will appear.  Dragging across the screen to another object will 
display a larger black arrow when a legitimate link has been made.  
Releasing the mouse button then makes or breaks the link. 

2. For quick editing of links, the same click, drag, and release method 
can be used when not in Route Drawing Mode.  This is achieved 
by holding down the Shift key. 

3. Clicking on a routing arrow to select, and then pressing delete can 
also be used to quickly erase links. 

Alignment and Spacing 
Objects can be selected by clicking and dragging to enclose them.  The 
objects selected will appear with a dotted line around them. 

 
Figure 10-14: Selecting Objects 

 To quickly link and 
unlink Objects, hold 
down the Shift key  
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To align objects, right click within the box and select Align from the menu.  
To create equal spacing between each object, right click on the selected 
objects and select Space Equally from the menu.   

 
Figure 10-15: Right Click Object Menu 

Copying Objects 
There are a number of ways to copy objects and place them on the screen. 

1. Select an object or group of objects.  Right click on the selected 
objects and select Copy from the menu.  Right click and select 
Paste from the menu.  The new objects will be placed directly on 
top of the original objects.  They can now be dragged to a new 
location, if desired. 

2. As above but use Ctrl + C to copy and Ctrl + P to paste. 

3. Select an object or group of objects.  Hold down the Ctrl key and 
drag objects to the required position on the screen. 

 
Figure 10-16: Copying Objects 

 Hold down Ctrl 
while clicking and 
dragging to quickly 
copy objects  
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4. Select an object or group of objects.  Right click on the selected 
objects and select Duplication Wizard from the menu.  Enter the 
number of copies required.  Enter the number of pixels to 
increment the position of the objects with each copy along the X-
axis (horizontal) and the Y-axis (vertical).  Newly created objects 
can be placed within a new group.  The group will be automatically 
named. 

 
Figure 10-17: Duplication Wizard 

Sub Windows 
Sub-windows can be created for a hierarchical model or simply to tidy-up 
large or complicated models by compartmentalizing areas.  Objects are 
selected by dragging a box around them.  The right-click menu option, 
Create a Sub-Window, can then be selected.  Sub-windows can be created 
inside other sub-windows. 

 
Figure 10-18: Sub Window 
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The Sub Window properties can be viewed by right clicking anywhere 
inside the window and selecting Window Properties from the menu or by 
clicking on the S8 logo at the top left of the window and selecting Window 
Properties.  Properties can also be accessed for a closed Sub Window by 
right clicking on the Sub Window and selecting Sub Window Properties 
from the menu. 

 
Figure 10-19: Sub Window Properties 

1. The name of this Sub Window.  This can be changed to something 
relevant to the simulation. 

2. Background – Select a background color for the Sub Window.  
This helps keep the simulation tidy. 

3. Graphics 

• Title with image – Displays the name of the Sub Window on 
the main screen. 

• Invisible – Hides the Sub Window. 

4. Image - An image can be selected to represent the Sub Window. 

Using the model building techniques outlined it is possible to create many 
types of models from large to small and simple to complex.  The following 
chapters detail how the features in SIMUL8 can be used to further develop 
and customize simulation models. 
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Chapter 11:  
Work Item Labels 

Definition 
In SIMUL8 Work Entry Points create Work Items, which then travel 
through the simulation and are processed by Work Centers before leaving 
the simulation through a Work Exit Point.  Work items can have individual 
pieces of information physically attached to them.  This can be information 
such as color, size, and product type, or can be special labels, such as image 
and quantity.  SIMUL8 refers to this information as Labels.  Labels can be 
used to simply carry information about the Work Item, trigger changeovers 
at Work Centers, product routings from Work Centers, different process 
timings at Work Centers, and many other activities. 

Creating Labels 
Labels are created by selecting Objects > Labels.  A list of the available 
labels will appear with a few options: 

 
Figure 11-1: Available Labels and Options 

 Preface all 
labels with “lbl_” 
when assigning 
names to labels 
(i.e. use a naming 
convention)  
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By clicking either New or Properties, the following dialog will appear.  
Labels can be either Text or numerically based.  Text Labels are not as 
useful as numerical values and take up more memory.  Therefore, it is 
recommended to avoid text labels. 

 
Figure 11-2: Label Properties 

Once a Label has been created, it will be automatically attached to the Work 
Item the first time it is set.  Labels are set to numerical values to represent 
different production information.  For example, if a car assembly plant 
produces 5 different colors, each car is painted on completion and a 
changeover time is associated with the cleaning of the painting operation 
for a color change a label is required to note which color each assembly 
requires.  This requires ONE Label, such as lbl_color.  Using ‘Label 
Actions’ found in Work Entry or Work Center dialogs, this Label should be 
set to a 1, 2, 3, 4, or 5, as shown below. 

 

Color Name lbl_color value 

Black 1 
White 2 
Red 3 
Navy 4 
Green 5 
Figure 11-3: Example Table of Labeling Representation 

Some users will attempt to create five different Labels, one called lbl_Black, 
lbl_White, etc.  There is no need for this inefficient use of labeling.  For 
example, changeovers can be triggered by a change in the value of a label.  
Therefore, there should be one label representing the information, such as 
case color.  As this value will then differ for various colors, it can easily be 
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checked to determine if a changeover will occur.  This can not be done 
efficiently, if there is a different label for each color. 

Label Actions 
All labels can be set using label actions or Visual Logic.  If a label has not 
been set to any value, it will default to empty or zero.  Label Actions can be 
found in the following places: 

 Work Entry Points 
 Work Centers 
 Conveyors 
 Storage Bin - Initial Conditions under Start-Up 

 
Figure 11-4: Label Actions Button 

By selecting the Label Actions options in any of these dialogs, the following 
screen will appear: 

 
Figure 11-5: Label Actions Options 

Click on Add to bring the label into the list box.  Once it is available in the 
list box, it is possible to change the properties of the label.  Different 
actions can be taken on different labels.  Most of the options for Label 
Actions apply to Numerical labels, these are: 

1. Increment – this action will add the value one to the current value 
of the label.  This is useful for tracing how many times a Work 
Items has been through a certain location or type thereof. 



210  •  Work Item Labels Chapter 11 

 

2. Decrement – This action will remove the value one from the 
current value.  This is useful for counting tasks remaining. 

3. Set to - This is the most often used option.  This will set the label 
to a numerical value according to the distribution set.  One of the 
most popular actions is to use a probability distribution where the 
label is set to a numerical value according to a percentage 
probability.  If this is used at a Work Entry Point, the distribution 
will be sampled every time a Work Item arrives in the system, 
labeling each item with its own corresponding value. 

4. Add to and multiply by - Both of these functions perform 
mathematical calculations on the value already contained within the 
label. 

5. Time Stamp - This stamps the simulation clock time onto the 
Work Item.  It is particularly useful if the completion time is 
recorded at a later date.  Use this stamp on work entry, if time in 
the system is to be calculated individually on completion of all 
work. 

6. Unique - This stamps a unique numerical identifier onto each Work 
Item. 

7. Ask VB: - this sends a signal to VB or VBA, which calls a macro to 
decide what the label should be.  This option is not recommended 
as calling an external program will significantly slow down the 
simulation run time.  Visual Logic should be used instead. 

Once the label has been stamped with an initial number, this value will 
remain on the individual Work Item until it either leaves the system or 
the value is altered through subsequent label actions or Visual Logic 
code. 

Special Labels 
There are a number of labels within SIMUL8 that are designed for a special 
purpose.  When these labels are created, a message will appear to check 
whether the label should be that the label should be used for its assigned 
purpose.   
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Figure 11-6: Special Labels - Simulation Assistant 

If the user checks ‘Yes,’ the following labels and definitions will apply: 
 Quantity 
 Image: 
 Priority 
 Due 
 Work Type 
 Job 
 Length 

Quantity label is designed for operations producing large numbers of 
product, for example bottling plants, semi-conductor productions.  The 
Work Item will actually represent a batch of items corresponding to the 
number on the Quantity label.  Storage Bins and Work Centers have ‘High 
Volume’ check boxes.  Checking these boxes will ensure that each 
individual piece is processed and not the Work Item. 

Image: is designed to alter the image of the Work Item.  This feature is 
quite tricky, but very helpful.  The label should be a combination of ‘Image:’ 
and the name of the images.  For example if the images are called Type1, 
Type2, Type3, etc, then the label should be called ‘Image:Type.  To alter the 
image of the Work Item by using this Special Label, it should be set to 1, 2, 
or 3 respectively.  By setting the label value, the image of the Work Item 
will automatically change to the images called Type1, Type2, and Type3.  
This is case and space sensitive. 

Priority and Due labels are used in accordance with Interruptible Work 
Centers, an option under Routing In.  In order to interrupt work at a Work 
Center, there must be a Work Item waiting with a Priority label of a value 
higher than the one currently being processed.  In order for the Work 
Center to remember the remaining processing time left on the interrupted 
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Work Item, the Due label must be present.  SIMUL8 will stamp the Due 
label automatically with the time remaining on the Work Item. 

Work Type and Job are two label types that are created automatically by 
SIMUL8 if the Jobs Matrix is in use.  The Jobs Matrix will use the work 
type and job number to determine where the next processing is to take 
place.  The user need not alter them. 

Length is used in conjunction with Conveyors to determine what length of 
the Conveyor each Work Item will take up, determining overall capacity on 
the Conveyors.  This is only required if there are different lengths according 
to different product types. 
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Chapter 12:  
Distributions 

Definition 
Statistical distributions are the heart of simulation.  In SIMUL8, they are 
essentially ‘number generators’ used anywhere timing and number values, 
fixed or variable, are required.    

Random numbers are what distributions use to ‘return’ or ‘sample’ values.  
Each distribution in a simulation model uses a separate stream of random 
numbers; this allows the user to make a change in one area of a model 
without affecting other areas.  These streams are a product of a starting 
random number ‘seed’ that does not change unless the user specifies the 
model to do so.  This means that a model will produce the same results 
repeatedly, until some aspect of it is changed.  SIMUL8 has 30,000 sets of 
random numbers available for use! 

Distributions, using the aforementioned random number streams, return 
values within a range specified by the shape of a probability graph.  The 
classic example is a ‘Bell Curve’ or Normal Distribution (Figure 12-1).  The 
bell shape of its graph shows that the highest concentration, or probability, 
is at the middle or average.  The width parameter of this particular 
distribution is given by its Standard Deviation.   
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Figure 12-1: Normal Distribution Bell Curve 

In this example, the average is 10 and the standard deviation is 2.5.  This 
distribution would return most of its values between 8 to 12 with the 
majority around 10, or the average.  Occasionally it will return a number 
from its far extremes, between 2 to 8 or 12 to 18.  One way to think of 
distributions are like a set of ‘loaded’ dice – thrown repeatedly, they will 
show certain numbers more often than others. 

This element of variability in the values that a distribution ‘dynamically’ 
generates, used in a process model, is what gives simulation an enormous 
advantage over ‘static’ spreadsheet calculations. 

Choosing a Distribution 
SIMUL8 has many, many choices for setting distributions, which can be 
confusing to some users.  So before looking into the distributions options, 
consider the importance of the distribution. If the model in development is 
a high-level capacity planning model, the answer is probably not much.  If 
this is the case, choose something simple like an average distribution and 
then when the model is complete, test the assumption made. 

If there is data available on the process and a distribution can be fitted, it is 
recommended that a package such as Stat::Fit™ for SIMUL8 be used to 
identify the distribution. 
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Typical Distribution Choices and 
Justification 
When objects are created within SIMUL8, there is always a default value 
and distribution selected within the object.  These distributions change 
depending on what object is selected and what the distribution represents.  
The following is a list of the different places a distribution is used and the 
default type assigned, along with a reason behind the choice. 

1. Work Entry Inter-arrival Rates – Exponential – The Exponential is 
the popular choice for arrival rates due to its random nature.  It is 
bound by a lower value.  The bulk of the arrivals occur earlier than 
the average time but there is some chance of an arrival occurring 
far later than the average.  This is typical of arrivals as most arrivals 
will arrive on time, but occasionally situations cause the arrival to 
err on the late side.   

 
Figure 12-2: Exponential Distribution for Inter-arrival Rates 

2. Work Center Process Time – Average – The average distribution is 
a commonly used distribution that is similar to the Normal 
distribution, which assumes a bell curve.  This creates some 
variability around an average value.  The standard deviation is 
automatically set to 25% of the mean. 
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Figure 12-3: Average Distribution Bell Curve for Process  

3. Mean Time to Breakdown  – Exponential 

4. Mean Time to Repair  – Erlang 

 
Figure 12-4: Erlang Distribution Example for Repair  

Standard Distribution Types 
As mentioned previously, distributions are defined by the shape of their 
graphs.  SIMUL8 employs a number of different types of standard 
distributions.  The most commonly used types are: 



Distributions SIMUL8 Reference  •  217 

Copyright Visual Thinking International 2007 

Average: 

An Average distribution, unique to SIMUL8, is a Normal distribution, 
with a Standard Deviation that is 25% of the Average.  Average 
distributions are useful in simulations where little data is available to 
justify the use of a particular statistical distribution; therefore, it is used 
quite commonly for process times.  This is the default distribution used 
in SIMUL8 Work Centers. 

Parameters:  1 - Average.  (St Dev is 25% of Average) 

Fixed: 

A Fixed distribution is not really a distribution but is a ‘fixed’ or static 
value that does not change.  It is commonly used for machine process 
times or to ‘set’ fixed values. 

Parameters:  1 – Fixed Value 

Normal: 

The classic ‘Bell Curve’ shape distribution.  Returned values are 
centered on the average with an even chance of falling on either side of 
the average, or mean.  It is used to simulate durations where variability 
is low – 95% of sampled values are within the mean plus or minus 2 
Standard Deviations. 

Parameters: 1 – Average, 2 – Standard Deviation 

Triangular: 

A Triangular distribution has a graph that looks like a triangle.  It has 
three points, an upper and lower bound, and mode.  It can be ‘skewed’ 
so that it returns values closer to one of its bounds. 

Parameters:  1 – Lower, 2 – Mode, 3 – Upper 
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Figure 12-5: Triangular Distribution 

Rounded Uniform: 

A Rounded Uniform distribution uniformly returns only ‘whole’ or 
integer numbers between 2 points.  There is an even chance that the 
value will be any integer between its upper and lower bound.  No 
samples will occur outside this range. 

Parameters:  1 – Lower Bound, 2 – Upper Bound 

 
Figure 12-6: Rounded Uniform Distribution 

Uniform: 

A Uniform distribution is the same as a Rounded Uniform distribution 
except it returns ‘real’ or decimal values. 
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Parameters:  1 – Lower Bound, 2 – Upper Bound 

 
Figure 12-7: Uniform Distribution 

Exponential: 

Exponential distributions, also known as Negative Exponential, are 
used mainly for simulating arrival times where one arrival is 
independent of the next.  Since this distribution has its ‘peak’ at zero, 
the majority of samples will be less than the average with a few 
returned values that will be quite large.  This equates to a pattern where 
arrivals occur in ‘bunches’.  For example, an arrival rate of 30 items per 
hour exponentially has items arriving not 1 every 2 minutes, but 
bunched together in clusters followed by long gaps averaging 30 per 
hour over time. 

 A good place to use an Exponential distribution would be for 
customers arriving at a store or patients arriving at a hospital.  This is 
the default distribution for SIMUL8 Work Entry Points. 

Parameters:  1 – Average 
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Figure 12-8: Exponential Distribution 

Erlang: 

An Erlang distribution is essentially comprised of two Exponential 
distributions back to back.  It has two parameters, an average and K.  
At K = 1 it is the same shape as an Exponential distribution.  At K = 2 
it resembles an extremely left-skewed ‘Bell Curve’ cut off at 0.  As K 
increases, it approaches a Normal distribution, but will never sample a 
value less than 0. 

Parameters:  1 – Average, 2 – K 

 
Figure 12-9: Erlang Distribution 
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Some less commonly used Standard Distributions are as follows: 
Log Normal 
Weibull 
Gamma 
Beta 
Pearson V 
Pearson VI 
Gauss 
Binomial 
Poisson 
Negative Binomial 
Bernoulli 
Geometric 

Distribution ‘Fitting’ software such as Stat-Fit® can be an extremely useful 
way of determining what distribution to use for a given a set of data. 

Standard Distributions in SIMUL8 
As mentioned earlier SIMUL8 employs distributions wherever timing and 
number information is required.  A distribution panel in an object’s dialog 
box looks like figure 2.  It will appear wherever a distribution is needed to 
set a value. 

 
Figure 12-10: Selecting a Distribution 

To change the distribution type and parameters, simply pick the standard 
distribution type from the drop down list and fill in the desired parameters. 
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Some of the areas that distributions are used in SIMUL8 are as follows.  
Understanding this list will provide the reader with a good understand of 
simulation. 

Work Entry Point 

� Work Item inter-arrival times 

� Batch Size (*must be whole-number generating distribution) 

� Label Actions – Set to, Add to, Mult by: 

Storage Bin 

� Minimum Wait time 

� Start-Up Label Actions 

Work Center 

� Work Center process timing 

� Efficiency (Detailed) – Time Between Breakdowns, Time to Repair 

� Change-over time 

� Batch Size (*must be whole-number generating distribution)  

� Label Actions – Set to, Add to, Mult by: 

User-Defined Distributions in SIMUL8 
SIMUL8 also provides the means to create several different types of user-
defined distributions.  An easy way to create, erase, and manage user-
defined distributions is found under Tools/Distributions on the main 
toolbar (or use the Ctrl-D shortcut).  When selected, a list of all user-
defined distributions contained in the model appears. 
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Figure 12-11: All Distributions 

To create a new distribution, click the ‘New’ button and the following 
dialog will appear. 

 
Figure 12-12: Creating User-Defined Distribution 

 

Named Distribution 

The Named Distribution permits the user to create a distribution, which 
can be altered using Visual Logic.  The parameters of the Named 
Distribution are the same as when using the standard distributions, but also 
enable the use of Pre-Sample Logic.   
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Figure 12-13: Named Distribution Parameters 

Pre-Sample Visual Logic is used to make a decision prior to the sampling of 
the process time of an event, typically to assign a process time based on a 
rule. 

Probability Profile Distribution 

The Probability Profile Distribution allows the user to create distributions, 
according to a probability of a certain return value. 

 
Figure 12-14: Probability Profile Distribution 

The user can define unlimited numbers of profiles, with associated 
probabilities.  The probability profile will be a discrete distribution.  These 
distributions are often used to set work labels, so as to associate a discrete 
number with a product type, color, or any other attribute on the Work 
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Item.  To read more about labels, please read Chapter 11: Work Item 
Labels. 

Combination Distribution 

The Combination Distribution provides the user with the capability to use 
several shapes to serve as a combined distribution.  Named Distributions 
are added to the list, and the combined distributions provide the range for 
the random number sampled.  See below where two named distributions 
provide the range for the Combination Distribution. 

 
Figure 12-15: Combination Distribution with an Exponential and Normal Curve 

Time Dependant Distribution 

The Time Dependant Distribution permits the user to use different Named 
Distributions dependent upon the time of day.  The user adds a time slot 
and defines the Names Distribution to be sampled from during that period, 
until the next defined time slot. 

 
Figure 12-16: Time Dependant Distribution 
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By selecting the Change Slot option, the user creates a time slot, with an 
associated Named Distribution as can be seen below. 

 
Figure 12-17:  Creating a New Time Dependant Distribution Time Slot 

This distribution is often used for altering arrival patterns over the course 
of a day.  For example in a call center, inter-arrivals rates can change as 
often as hourly, and the impact of these changes on workload is significant.  
Another example might be truck arrivals during the day, which might be 
frequent in the morning, sporadic in the afternoon, and practically non-
existent in the evenings and over-night.  The time dependant distribution 
provides a quick facility to set-up this complex arrival pattern. 

Time Absolute Distribution 

The Time Absolute Distribution provides the user with the facility to define 
a time when an event will take place, with variation around that time.  The 
user defines a time, and a Named Distribution will provide the variability 
around that time. 

 
Figure 12-18: Time Absolute Distribution 

To add or change the time slot, the user clicks on the appropriate option 
and makes the modification to the time slot or the Named Distribution 
which will be sampled from. 
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Figure 12-19: Changing the Time Slot for a Time Absolute Distribution 

A good application for this distribution type is the scheduled arrival of an 
item, for example a mail drop, or truck arrival.  The mail drop might be 
expected at 9:00 AM but will arrive between 8:30 AM and 9:30 AM, so the 
user could use a Normal Distribution to provide the schedule variance. 

Label-Based Distribution 

The label-based distribution simply states that the time associated with this 
event will be read from the label value on the current Work Item.  The user 
simply states which label this value should be read from.  The label value 
should be set previously. 

 
Figure 12-20: Label-Based Distribution 

External Distribution 

The External Distribution provides the utility to pick up the information 
required from an Excel™ spreadsheet or VB program.  This utility has been 
available within the SIMUL8 from the days prior to the existence of the 
Information Store spreadsheet inside SIMUL8.  During a simulation run, to 
maintain a good run speed, it is not advisable to communicate with an 
external package for distribution purposes.  It is much more efficient to 
import the data from an external source on Reset Visual Logic and then to 
grab this data during the simulation run, as described in the next section. 
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Figure 12-21: Referencing an External Source for Distribution Values 

Access Information Store 

Reads distribution parameters from Information Stores (SIMUL8’s internal 
spreadsheets).  This option provides the easiest facility to do so.  Simply 
state the location of information in the Information Stores; it is possible to 
use complex calculations, such as label-based row locations, too 

 
Figure 12-22: Access Information Store Distribution 

Double-clicking on the gray element in this option will access the Formula 
Editor for placing the location of the distribution time. 
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Figure 12-23: Enter the Spreadsheet Location for Access Information Store 
Distribution 

As this option has no variation, often Pre-Sample logic and Named 
Distributions are used to read from spreadsheets and apply variability in the 
number sampled. 

Bounded Distributions 

If the user wishes to exert some control over a number sampled from a 
distribution, the bounded distribution provides the necessary features.  The 
Bounded Distribution provides all the features of a Named Distribution 
with Standard distribution parameters, and pre-sample logic.  However, the 
Bounded Distributions allows the user to constrain the random number 
sampling by applying lower and upper bounds. 

 
Figure 12-24: Bounded Distribution Parameters 
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By entering a number in one of the bounds and checking the Resample 
option, the user bounds the distribution.  This is especially useful with 
distributions such as the Exponential, which can move towards infinity. 

Using Pre-Sample Logic 

One of the most powerful uses of Distributions is the ability to alter the 
Distribution parameters based on a rule.  Once a Named Distribution has 
been created, all of its parameters, including type, can be altered using 
Visual Logic.  Below is a small example using Pre-Sample logic to alter the 
processing time at a Work Center based on a product label.  A Work Center 
processing Product 1 will incur Normal 10, 2.5 minutes, while Product 2 
will incur Exponential 12.  The Named Distribution, dis_Processing Time, 
is altered using the following Pre-Sample Logic. 

 

 
Figure 12-25: Using Pre-Sample Logic to alter a Processing Time 

To learn more about Visual Logic, using If statements, the Formula Editor, 
and creating Commands, refer to Chapter 25:Visual Logic.   
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Chapter 13:  
Resources 

Definition 
Resources are one of the main SIMUL8 build objects, as introduced in the 
resource explanation on page 197.  These objects are not used to create part 
of the workflow in the model; they are used to operate Work Centers.  The 
most obvious examples of this are people: an operator required to operate 
machinery, doctors required for surgery, telephone operator at a call center 
desk, etc.  Other examples could be tooling: machines dies, incubators at 
hospitals, etc.  The reason for introducing Resources into the simulation 
model is that these Resources will restrict the workflow by their availability.  
If it can be assumed that a Resource would be permanently available to 
operate the Work Center, there is no need to introduce this dimension. 

Creating and Attaching a Resource 
Clicking, dragging, and dropping a Resource icon into the simulation 
window creates a resource. 

 
Figure 13-1: Create a Resource 

Once a Resource has been created, it needs to be attached to an individual, 
or multiple, Work Centers.  There are two methods for attaching Resources 
to Work Centers; the first requires drawing an arrow between the Resource 
and the Work Center, while holding down the shift key.  No arrow will be 
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drawn, as in normal workflow objects, but a message will appear, stating 
that the Resource requirements have been added to the Work Center. 

 
Figure 13-2: Adding a Resource 

The second method for adding a Resource requirement to a Work Center is 
to double-click on the appropriate Work Center and access the Resources 
option. 

 
Figure 13-3: Resource Requirements 

By clicking Add within this section, a list of all available Resources will be 
accessed.  Select the appropriate Resource(s) required to operate the Work 
Center.  Shift Patterns for a Resource working at a Work Center can be set 
in the Resource properties dialog.  See Shifts on page 241. 
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Detailed Resource Requirements 
Once a Resource is selected at a Work Center, many options can be detailed 
for the use of that Resource.  The first is the manner in which the Resource 
is picked up and released.  These options can be seen in Figure 13-3: 
Resource Requirements.  If a Resource is required before a Work Item can 
be picked up, the first option should be selected.  As this is the most 
common request, this is the default option and covers everything from 
ensuring a call desk operator is available before a call is accepted from the 
queue to ensuring an operator is available before a piece of work can be 
loaded onto a machine. 

If a Resource is required to remain with the Work Item even when the 
downstream operation is blocked, the second option should be unselected.  
This is most commonly deselected when the downstream operation is a 
Conveyor and the Resource is required to move the item onto the 
Conveyor. 

If a Resource should remain at the Work Center until there is no more 
work to be done, select the third option.  Once a Resource arrives at the 
Work Center, it will not leave until the queue feeding that Work Center is 
empty.  This can be useful in situations where the number of Work Centers 
requiring a Resource is greater than the number of available Resources, as it 
will prevent Resources from rapidly moving from Work Center to Work 
Center trying to complete work. 

In some instances, a Work Center can be operated by more than one of the 
same Resource.  Clicking on the Detail button as seen in Figure 13-3: 
Resource Requirements will access these options. 



234  •  Resources Chapter 13 

 

 
Figure 13-4: Resource Requirements Detail 

By altering the Min. and Max number required, the Work Center will use as 
many Resources as available within that number range.  The more 
Resources picked up by the Work Center, the faster the Work Center will 
operate.  Twice as many resources will do the work in half the time; three 
times the resources, in a third of the time, and so on. 

Options are also available for using the Resource sequentially.  For 
example, if the simulation model is emulating an assembly line, or work cell, 
where the same Resource type operates all the Work Centers, it is possible 
to have the Resource currently selected follow the Work Item down the 
line, or around the work cell.  If this is the case, the second option requiring 
the Resource at this Work Center (but do not release the Resource) should 
be selected.  At the end of the line or cell, the third option should be 
selected to release the Resource back into the pool of available Resources. 

Pooled Resources 
If a Work Center can be operated by any one of a number of possible 
Resource types, a Resource Pool is required.  A Resource Pool is a 
collection of available Resources, which is attached to a Work Center in the 
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same manner as a regular Resource.  One member of the Resource Pool is 
drawn to the Work Center. 

To create a new Resource, first select the Pool Resource option found 
under Resource Properties. 

 
Figure 13-5: Resource Properties 

Clicking on the Members button will open the Members dialog box. 

 
Figure 13-6: Pooled Resource Member 

In the example above, the Pooled Resource has both Resource 1 and 
Resource 2 available to complete the Work Center operation.  Timing at the 
Work Center can be over-written by the Timing stated in the Members 
dialog.  These are exceptionally useful when trainees are available to operate 
a Work Center, but at a slower speed, the timing can be entered as a delay 
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factor (original value x 100 %) or as the actual new timing at the Work 
Center, as in the figure below. 

 
Figure 13-7: Pooled Resource Timed Delay by Resource Type 

Resource Priority 
Priority allows the user to specify the preference as to which Resource 
should be drawn to the Work Center.  The list sequence defines that 
SIMUL8 will always attempt to use the Resource listed first; it will only use 
the second listed Resource if the first is not available.  By switching to 
Circulate, SIMUL8 will assume that there is no preference as to which 
Resource is selected and will circulate evenly between the options. 

Traveling Resources 
When a Resource is available to work several different Work Centers, there 
can be travel time involved.  This means that the Resource would not be 
available to operate the Work Center until the travel time has been 
completed.  Double-clicking on the Resource, then Travel accesses travel 
times for Resources. 
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Figure 13-8: Resource Travel Times 

All animation can be switched off if required, as this could potentially slow 
down the model execution.  Travel times can also be updated automatically 
when Work Centers are moved, or an overall speed can be defined.  Note if 
a speed is defined, care must be taken in the placement of objects within 
the simulation model 

All Individual Journey Times can be specified by selecting the ‘From’ 
location, defined as a SIMUL8 simulation object, and the ‘To’ location, then 
entering the time (the units will change according to the defined simulation 
units).  By selecting the Always check box, only the one-way travel times 
need to be specified.  Click on ‘Matrix of all journey times’ to see the 
complete matrix; this will display all journey combinations. 

 
Figure 13-9: Resource Travel Time Matrix 
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Not only can Journey Times be specified between Work Centers, but also 
from the Resource to the Work Center.  This would be used if the Resource 
has a dispatch point where it/he/she returns to until it is required. 

By accurately including all the detailed traveling requirements, shift 
availabilities, and detailed Resource task requirements it is possible to 
evaluate the total impact that Resources will have on the throughput of the 
system. 

Resource Availability 
Resource Availability models the time that a Resource is not available to 
perform work.  It is similar in concept to Work Center Efficiency.  There 
are two options for inputting Availability information: auto and detailed. 

The auto option (see figure 13-12) requires that an availability percentage be 
entered to determine for how much time the Resource will be unavailable.  
An average absence time can also be input if desired.  If this is left as “?”, 
an average absence time will automatically be generated by the simulation 
based on factors such as the length of the Results Collection Period.  
Average absence length is calculated according to an Erlang 2 distribution. 

 
Figure 13-10: Auto Resource Availability Settings 

Selecting the detailed option allows modeling of more sophisticated 
resource behavior.  As with Work Center Efficiency, distributions can be 
input for both time between absences (either mean time between absences 
or mean cycles between absences) and time to return.  Multiple absence 
types can be set up by creating a new absence type in the list on the right of 
the dialog (see Figure 13-13). 
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Figure 13-11: Detailed Resource Availability Settings 

Detailed resource availability can be useful for modeling situations where 
resources must take specified breaks after a certain amount of working 
time, or when there are several types of breaks taken through the day (for 
example “long” and “short” breaks). 
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Chapter 14:  
Shifts 

Definition 
Shifts are used to schedule the availability of both Resources and Work 
Centers.  During a simulation run, there may be times of greater availability 
of certain Resources or Work Centers.  Instead of removing these entities, 
which is quite a complex process, simply set their availability by time of day 
and week by creating shifts. 

Setting Availability - Shifts 
Shifts can be created once a Resource or Work Center to which they apply 
has been created.  For resources, check the Shift Dependent checkbox.  For 
Work Centers, check the Shifts checkbox in the lower-right corner of the 
dialog box shown on page 156.  Alternatively, proceed directly from the 
main menu under Clock > Shift Work Patterns. 

 
Figure 14-1: Resource Properties 
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This opens the shift availability dialog box, which contains a list of all the 
shifts that have been created for every type of Resource and Work Center.  
Click on the Shift Work Patterns button to add new shifts.  

 
Figure 14-2: Shift Patterns 

Shifts are defined by their start and end time, and by the days of the week 
to which they apply.  Shifts that apply to specific dates must be input using 
the calendar feature discussed on page 200.  Start and end times are entered 
in 24-hour clock time units, and daily patterns can be selected as 
appropriate from the Days options.  

 
Figure 14-3: Shift Properties 

SIMUL8 governs the shift change events, altering the number of the 
Resource type or Work Centers available according to the figures set in the 

 Shift Patterns can 
be applied to both 
Resources and Work 
Centers  
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Shift Availability Dialog, accessed through the Shifts button as seen in 
Figure 14-4: Shift Availability below.  After the shift has been created, shift 
availability can be set.   

 
Figure 14-4: Shift Availability 

For resources, there is no limit to the availability.  Entering a figure in the 
‘Number of this type of resource available’ box will provide that number of 
Resources for the entire simulation run time.  However, for a given Work 
Center, there are only two options: available or not.  Therefore, numbers 
greater than 1 should not be used. 

Changing Between Shifts 
When changing between different Shifts, there are different methods for 
handling these.  The user is provided the choice between methods within 
the dialog displayed in Figure 14-5: Shift Patterns, on the ‘Behavior’ tab. 

 
Figure 14-5: Shift Patterns - Behavior 

When a shift changes, typically, a task will be in the process of being 
completed.  The decision that has to be made is whether the task is 
completed or not.  Typically, if the product being processed has a limited 
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shelf life or the cycle is short, the task will be completed before the 
Resource or Work Center is released from a shift.  Sometimes this will 
result in a utilization of a Work Center or Resource of over 100%, but this 
is solely due to the extra work that is completed after a shift has ended. 

However, if tasks can be suspended at the end of a shift, then two options 
are available and will be chosen depending upon the urgency of the job re-
start.  If the first option is chosen, SIMUL8 will continue to look for a 
Resource or Work Center to commence the job every time one is available.  
The second option will allow the job to wait until another shift change 
occurs.  By restarting ASAP, SIMUL8 will call many more events than 
waiting until the next timed shift change event.  If model speed is a 
concern, the latter is the preferred option. 

 

Visual Logic 
Though we will deal with Visual Logic in another section, it is important to 
note that Shift Patterns provide a Visual Logic access point, both On Shift 
Start and On Shift End. 

 

 
Figure 14-6: Shift Patterns – Visual Logic Access 
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Chapter 15:  
Priority 

Definition 
Priority in SIMUL8 has many different connotations. One simulation object 
may have priority over another for a number of different reasons.  Priority 
could be used for determining the order in which Work Centers receive a 
shared Resource, the order in which Work Items are processed, or even 
which Work Center has control over the routing of Work Items. 

Work Center / Resource Priority 
If a Resource is attached to several Work Centers and one Work Center is 
more critical to the overall throughput than others (i.e. the system 
bottleneck), then it is important that this Work Center receives the 
Resource before any others do.  In order to accomplish this each Work 
Center is given a priority value.  Clicking on the Work Center Properties 
and then the Priority button will access the Priority dialog where the 
options of Fixed, Label and Combined by Multiply are given.  These 
options are described in detail below. 

 
Figure 15-1: Work Center Priority Options 

1. Fixed value - The Work Center with the highest priority value will 
receive the Resource first.  For example, Work Center 1 has a 
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priority value of 60 and Work Center 2 has a priority value of 50.  
If Work Centers 1 and 2 both require the same Resource, then 
Work Center 1 will obtain the Resource first, because it has the 
higher priority value.  Note that all Work Centers will start with a 
default value of 50, giving no preference.  The minimum value is 
zero, and maximum value is one hundred. 

2. Label value –Resource priority can also be determined by a label.  
With this option, the Work Center that is waiting to process an 
item with the highest label value will receive the Resource first.  
For example, if the Queue for Work Center 1 has a Work Item 
with a lbl_Importance value of 5, but the Work Item in the Queue 
for Work Center 2 has a lbl_Importance value of 3, then Work 
Center 1 will receive the Resource first. 

 
 Figure 15-2: Priority by Label (lbl_Importance) 

3. Combined by Multiply value – This option will take a combination 
of the Fixed value associated with the Work Center and the label 
value of the item about to enter.  For example if Work Center 1 
has a priority of 70, and a Work Type label value of 1 then its 
combined priority value is 70×1=70.  Similarly, if Work Center 2 
has a priority of 60 and a Work Type label of 2 then its combined 
value would be calculated as 60×2=120.  However, the maximum 
priority value is 100, so the value given to Work Center 2 is actually 
100.  In this example, Work Center 2 will receive the Resource 
since it has the higher combined priority value. 

Routing Out 
Priority can also be give to the path Work Items take when exiting a Work 
Center.  This type of priority is unrelated to resources.  A list of the objects 
to which the Work Center may route work is given in the Work Center 
Routing Out dialog.   When the Priority Routing Out discipline is chosen, 
this list represents the priority sequence, or the order in which routing out 
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objects are preferred.  For example, in the figure below Queue 1 is given 
preference because it is the first object listed.  As such, Work Items will 
always flow into Queue 1, unless it is blocked (i.e. at capacity).  In the case 
that Queue 1 is blocked, preference will be given to the next object listed, 
and Work Items will flow into Queue 2. 

 
Figure 15-3: Prioritizing Work Center Routing Out 

The priority sequence can be changed by using the up and down hand 
arrows to change the object order.   

Routing In 
A priority sequence can also be assigned to a Work Center’s Routing In 
objects.  Preference will be given to objects in the order they are listed.  
Consider the example shown in the figure below.  In this example, Work 
Items enter Work Center 1 from one of two storage areas, with preference 
given to Storage Area 1.  This means that Work Center 1 will accept Work 
Items from Storage Area 1 before accepting Work Items from Storage Area 
2.  Only when Storage Area 1 is empty will Work Center 1 accept items 
from Storage Area 2.  
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Figure 15-4: Routing In Properties - Priority Setting 

The opposite of the Priority option is the Passive option, which gives the 
previous simulation object control over whether or not the Work Center 
should accept work.  The previous simulation object cannot be passive, i.e. 
a Storage Bin, as it would be incapable of making decisions for the Work 
Center.  Allowable feeding objects would include a Work Center routing 
out based on priority, or a Conveyor pushing Work Items in. 

Label / Work Item Priority in Queues 
SIMUL8 will allow work to be prioritized within a queue based on a label.  
In earlier versions of SIMUL8, this would have to be a label called Priority, 
however now any label can be used.  By clicking on a Storage Bin / Queue’s 
Properties and checking the box marked Prioritize, a list of potential labels 
will appear.  To prioritize according to a label, select the appropriate label.  
SIMUL8 will now sort all Work Items in the queue according to the label 
value, from highest first to lowest.  Alternatively, the user can choose to 
sort according to a reverse priority, where labels are sorted from highest to 
lowest. 

 



Priority SIMUL8 Reference  •  249 

Copyright Visual Thinking International 2007 

 
Figure 15-5: Prioritize a Storage Bin 

Note that the Storage Bin must be populated by another simulation object.   
If the Visual Logic command ‘Add to Queue’ has been used to populate the 
queue, the command will result in a non-sorted queue. 

Interrupting a Work Center 
The label called Priority has a special meaning in SIMUL8 and is used to 
determine the priority of items for interrupting a Work Center.  A Work 
Center can actually be interrupted by another Work Center that is holding a 
Work Item with a higher priority label.  The current Work Item will be 
pushed into a Storage Bin (specified at the Interruptible check box) until 
the prioritized work has been completed. 

 
Figure 15-6: Interrupt a Work Center with a Priority Work Item 
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When the Priority label is created, a warning is displayed, advising the user 
that the Priority label has a special meaning in SIMUL8.  If the user elects 
to continue, the Priority label will be activated for use in this context.  

 
Figure 15-7: Accepting Priority Label's Special Meaning 

Consider the example where Work Center 1 feeds Work Center 2.  Work 
Center 2 is set to route interrupted items to Queue 2, an unrelated queue.  
Work Center 2 is processing a low-Priority Work Item when a Work Item 
with a higher Priority exits Work Center 1.  Since the item waiting to enter 
Work Center 2 has a greater Priority value than the item currently in it, the 
low-Priority item will be interrupted.  Work Center 2 will send the 
interrupted Work Item to Queue 2, and receive the priority item from 
Work Center 1 immediately.  

When the high-Priority item is complete, the low-Priority work will 
continue from where it was interrupted.  To accomplish this, a Work Item 
label called Due must be created.  Like the Priority label, the Due label has a 
special meaning.  It will store the remaining working time for the 
interrupted Work Item.  A small piece of Visual Logic must be executed to 
do the following: 

IF Due > 0 Then 

 Set Distribution Work Center Timing:  Fixed, Due, 0, 0, 0 

End if 
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Chapter 16:  
Efficiency 

Definition 
Efficiency options are provided in the Work Center and Conveyor objects 
to provide a method of simulating downtime.  The efficiency option works 
by preventing objects from working during all available simulation time.  
The Efficiency feature can accommodate Mean Time To Failure (MTTF), 
Mean Cycles Between Failure (MCBF), Mean Time To Repair (MTTR), and 
other such statistics. 

Automatic 

 
Figure 16-1: Auto Efficiency 

To set auto efficiency, a percentage is entered to determine how much time 
the object will spend broken down.  An average repair time can be entered.  
If this is left as “?,” the simulation will automatically repair the object at a 
rate that is consistent with its working speed.  SIMUL8 calculates 
automatically MTBF figures and uses negative exponential distributions for 
MTBF and Erlang 2 distributions for repair time. 
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Detailed 

 
Figure 16-2: Detailed Efficiency  

Detailed efficiency allows more control over the timing and nature of 
breakdowns and repairs to Work Centers and Conveyors.  It is possible to 
specify how often a breakdown will occur and how long it takes to repair 
the Work Center or Conveyor. 

Time between Breakdowns 
The time between each breakdown can be specified using any of the 
distributions available in SIMUL8 or using a specially created distribution.  
See the section on  Distributions on page 213. 

1. Time or Cycles – MTBF is selected to specify the amount of time 
between each breakdown that occurs.  MCBF (Mean Cycles 
Between Failures) is selected to specify how many cycles occur 
between each breakdown.  This means that a number of Work 
Items or batches will be processed before a breakdown occurs. 
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2. Only count busy time – This option is used in conjunction with the 
MTBF option.  If the box is checked, only working time will be 
counted when calculating the time between failures.  If the box is 
not checked, elapsed time will be counted when calculating the 
time between failures. 

 
Figure 16-3: Time between Breakdowns 

Time to Repair 
The time taken to repair when a breakdown occurs can also be specified 
using any of the distributions available in SIMUL8 or using a specially 
created distribution.  See the section on  Distributions on page 213. 
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Figure 16-4: Time to Repair 

1. Resources – Resources may be required to repair the object.  
Resources can be added or removed as required.  For each 
Resource, further detail can be specified.  See Chapter 13: 
Resources. 

2. The detail button sets the minimum and maximum number of 
Resources to be allocated for the repair.  If more Resources are 
available, the repair can be completed more quickly.  See Chapter 
13: Resources. 
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Figure 16-5: Repair Resource Requirements 

3. The display button allows the Resource to be displayed beside the 
Work Center when it is being used there.  The Display at Work 
Center check box allows this option to be switched off or on.  The 
position of the Resource in relation to the Work Center can be set 
automatically or by using the X and Y coordinates. 

 
Figure 16-6: Repair Resource Display 

When a breakdown occurs 
When equipment breaks down, there are a number of options that can be 
selected to control how Work Items are processed. 

1. Close feeding queues – Any Storage Bins that feed the object will 
stop receiving Work Items. 

2. Stop work immediately – The Work Center will not complete 
processing the current Work Item before breaking down. 

3. Extend breakdown by time to empty queue – This option is 
available if ‘Stop work immediately’ is not checked.  It allows the 
processing of the Work Item to be completed before the object 
becomes unavailable.   
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Breakdown Types 
Equipment may have more than one type of breakdown.  For example if a 
machine has two working parts, each of which fails according to its own 
rules, this can be represented by adding a second breakdown type.  One 
part might break down after a number of cycles and require only a short 
time to repair.  The other part may break down after a certain amount of 
working time and take a long period of time to repair. 

A breakdown type can be added by clicking the “New” button, and 
removed with the delete button on the keyboard.  Specifications for each 
breakdown type can be entered separately by selecting from the “Available 
Breakdown Types for this object” list box.  Current Breakdown Type 
Name displays the breakdown type that has been selected.  This box can be 
used to change the name of the breakdown type. 

 
Figure 16-7: Efficiency Breakdown Types 

Visual Logic 
Visual Logic is available for breakdowns.  It can be used either when the 
breakdown occurs, on start of the repair, or when the repair has been 
completed. 
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Chapter 17:  
Routing In 

Definition 
Routing In describes the method of selecting Work Items at a Work Center 
from the upstream objects. 

When building a simulation model, it is crucial to accurately capture the 
processing rules for work in the system.  The simulation must be capable of 
managing how items are selected at a Work Center.  For example, certain 
items may be of higher priority, or a Work Center may be required to 
collect and assemble a certain number of different items. 

There may also be information that must be known before selecting a piece 
of work.  One example is the type of work the Work Center is able to 
process.  Another example is whether or not there is somewhere to send 
the Work Items after processing.  

Set-up or changeover times must also be considered when an item or 
number of items has been collected at a Work Center.  Changeover times 
can be dependent on a number of different factors including the type of 
work, and how many items have been processed since the last changeover. 

Selection Method 
The selection method On Routing In to a Work Center allows the users to 
apply rules or decisions on how to feed that Work Center.  Objects, which 
feed the Work Center, can be viewed in the Selection Method tab.  Objects 
can be added to or removed from the list using the routing arrows on the 
main simulation screen or the Add and Remove buttons provided. 
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Figure 17-1: Selection Method 

Priority 
The priority option will ensure that the Work Center gives priority in 
descending order to objects in the list.  This means the Work Center will 
attempt to collect from the first object listed.  If no items are available, it 
will move on to the second object on the list and so on.  The pointers to 
the left of the Selection Method tab allow priorities to be changed. 

Collect 
The collect option is used when the Work Center is required to take several 
specific Work Items from different objects on the list.  This is useful when 
modeling a station that assembles a collection of parts.  For each of the 
items on the list, a collect number can be specified.  This number 
determines how many Work Items of each type are required in order for 
the items to be processed.  There are further options provided to control 
the collection of the required Work Items. 

1. Do not collect until all available – If checked, none of the Work 
Items required by the Work Center will be routed in until all of the 
required items are available.  If unchecked, items will be routed 
into the Work Center as they become available, but will not be 
processed until all have been routed in.  Note that this does not 

 When collecting 
and assembling 
multiple Work Items, 
final label values are 
set to the highest of 
the collected values 
unless otherwise 
specified.  
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affect the processing time.  Processing only begins after all required 
Work Items have been collected. 

2. Match – Only items that have the same value for the specified label 
will be collected. 

3. Assemble – All of the Work Items collected will be combined 
together to form a single Work Item.   

When multiple Work Items are assembled, the user must define how the 
time in system for the resulting assembled Work Item is calculated.  This 
definition impacts the time-in-system results, which can be found in the 
results summary or the Work Exit Point results. 

1. First Collected – The entry time to the system stamped on the first 
Work Item routed in is used. 

2. First in List – The time stamped on the first source item on the list 
is used. 

3. Youngest – The time stamped on the item that has been in the 
system the least amount of time is used. 

4. Oldest - The time stamped on the item that has been in the system 
the longest amount of time is used. 

5. Set to Now – The time is set to the current simulation time. 

When the Assemble option is checked, the user also has the option of 
setting all labels of the assembled product according to three rules: 

1. Highest – The Assembled product takes the highest label values 
from each of its parts. 

2. Lowest – The Assembled product takes the lowest label values 
from each of its parts. 

3. Selected – The Assembled product takes the label values of the 
part coming from the selected upstream operation. 

 The maximum 
collect number is 
10,000 if using 
manual input  

 The maximum 
collect number is 
32,000 when set in 
Visual Logic  
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Figure 17-2: Routing In Collect Selection Method 

Passive 
The passive option is used to prevent the Work Center from pulling Work 
Items in.  If this option is selected, the Work Center will not actively route 
in Work Items but will simply wait until items are pushed into it much like a 
Storage Bin.  This is commonly used when one Work Center feeds another 
and the flow is to be determined by the upstream Work Center. 

Expired Only 
This option will allow the Work Center to route in only those items that 
have surpassed their shelf life as defined in an upstream storage bin.  This is 
useful for reworking expired Work Items before returning them to the 
system, or sending them on to an “expired item” Work Exit Point. 

Oldest 
The Work Center will route in the Work Item that has spent the longest 
time in the system. 
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Youngest 
The Work Center will route in the Work Item that has spent the shortest 
time in the system. 

Longest 
The Work Item will be routed in from the object on the list containing the 
largest number of Work Items (generally the storage bin with the longest 
queue). 

Circulate 
Items will be routed in from each of the objects on the list in turn.  If the 
Ignore Starved option is checked, the Work Center will move on to the 
next object on the list when there are no Work Items available.  If this 
option is not checked, the Work Center will wait to route in a Work Item 
before moving on to the next object on the list. 

 
Figure 17-3: Routing In Circulate Selection Method 

Locked 
Only the highlighted object on the list will be used to route in Work Items 
when the locked option is selected.  To prevent the Work Center from 
routing in from any of the objects on the list, select this option and 
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immediately click OK.  To select a particular object for routing in, select the 
option and click on one of the objects on the list before clicking OK.  This 
option is most commonly utilized through Visual Logic to switch off 
certain storage areas. 

Cycle Matrix 
This option routes in to the Work Center according to the cycle matrix.  See 
the section on Cycle Matrix on page 279 for more information. 

Options 
Special options are provided to allow further control over the routing in of 
Work Items to the Work Center.  These include the ability to stop working 
on the current item in favor of another, use labels to batch in a number or 
sequence of Work Items and prevent the Work Center from routing in 
Work Items until it has a clear exit to route them out. 

 
Figure 17-4: Routing In Options 

Interruptible 
This option means that if a Work Item with a higher priority is ready for 
processing, the Work Item currently being processed is sent to a Storage 
Bin to await completion.  This is useful when certain work has precedence 
and is used in situations where scheduling is important. 

Use Label Batching 
The values of the selected label are added together on available Work Items.  
Items are routed in if the total value of their labels is between the minimum 
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and maximum levels.  The Use button determines which label should be 
used. 

 
Figure 17-5: Routing In Label Batching Options 

Batch by Type 
The Work Center will attempt to route in items with the same label value as 
the last Work Item it processed.  When there are no more items with this 
label value available, it will move on to the next Work Item.  This is 
commonly used to minimize the number of changeovers required.  If the 
‘Use fixed value’ option is checked, the Work Center will only route in 
Work Items that have a specific label value. 

 
Figure 17-6: Routing In Batch by Type Options 

Wait Until Exit Clear 
The Work Center will not route in any Work Items until the exit route for 
the Work Item is able to accept it. 

Changeovers 
Work Centers have the ability to allow a changeover or set up time.  This 
will be set either when the Work Item has been collected or after a certain 
amount of working time has elapsed.  The timing for changeovers can be 
set using the distributions provided in SIMUL8 or using a pre-created 
distribution. 
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Figure 17-7: Routing In Changeover 

No Setup Time 
There will be no setup time applied. 

Every Nth Work Item 
The number entered will determine how many items are processed before 
the changeover time will be applied.  For example, if 4 is entered, the Work 
Center will process 4 Work Items and then require a changeover or setup. 

When Label Changes 

 
Figure 17-8: Routing In Changeover When Label Changes 
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When the value of the selected label changes, the changeover time is 
required.  This might be useful if we are processing different product types 
or items that require painting different colors. 

After Working Time 
The changeover will be required when the Work Center has completed the 
specified amount of working time. 
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Chapter 18:  
Routing Out 

Definition 
Routing Out describes the method through which Work Items are moved 
from a Work Center to the downstream objects when work is complete at 
the current Work Center. 

Routing Discipline 
The Routing Out disciplines are available at Work Entry Points, Work 
Centers, and Conveyors.  This chapter discusses Routing Out methods for 
a Work Center.  The same methodology, however, generally applies to 
Work Entry Points and Conveyors as well. 

Ignore Blocked Routes 
Several potential disciplines exist for routing out to multiple destinations.  If 
the check box for ‘Ignore Blocked Routes’ is activated, routes to 
destinations that are blocked (i.e. Storage Bins at capacity or Work Centers 
not ready for more Work Items yet) are ignored.  Instead, the Work Center 
will attempt to move Work Items to the next available destination given the 
current routing discipline. 
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Figure 18-1: Routing Out Disciplines 

Circulate 
Circulate moves Work Items in an incremental fashion in the order shown 
in the list, much like dealing out a deck of cards.  When the end of the list is 
reached, the Work Center will route Work Items to first item in the list if 
possible.  The user can change the routing order by selecting a destination 
from the list and pressing the ‘Move Up List’ (finger pointing up) or ‘Move 
Down List’ (finger pointing down) button to rearrange the list. 

Uniform 
The Uniform discipline for routing randomly distributes the output from 
the Work Center among the choices with a uniform probability.   

Percent 
Using a percent for moving Work Items from a Work Center will distribute 
the work from the Work Center to the choices with probabilities equal to 
the values specified by the user. 

 Leaving the 
‘Ignore Blocked’ 
option unchecked 
could block the Work 
Center 
unnecessarily  



Routing Out SIMUL8 Reference  •  269 

Copyright Visual Thinking International 2007 

 
Figure 18-2: Routing Out - Percent Discipline 

To specify the percent routed to each object, select the destination from the 
list and type the percent in the field beside the ‘Percent’ heading.  If the 
exact percent is not known and instead a ratio has been estimated, type the 
ratio values for the desired destinations and then press the ‘=100’ button to 
automatically calculate percentages.    

Priority 
The Priority option routes Work Items according to the order in the list.  
Output from the Work Center will always go to the first object in the list 
(i.e. highest priority) unless it is at capacity or otherwise blocked.  If the first 
destination is unavailable, work will be routed to the next in the list and so 
on until an available destination is found.  As before, the user can rearrange 
the priority list by selecting destinations from the list and moving them up 
or down using the up or down buttons. 

Label 
For complete control of where Work Items go, Label-based routing should 
be used.  It allows the user to specify the exact destination of Work Items 
based on the numeric value of a label. 
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Figure 18-3: Routing Out – Label 

In the above list of potential destinations, if the designated label on a Work 
Item has a value of 1 then the Work Item will be routed to “Queue for 
Work Center 3”, if the value is 2 then the destination is “Storage Area 8”, 
and if the value is 3 then the Work Item is sent to “Storage Area 9”.  Note 
that in this case if the value on the label is anything greater than 3 the Work 
Item will be sent to Storage Area 9.  If the label is set to 0, the Work Center 
then becomes blocked.  

Press the ‘Detail’ button to specify which label determines the routing.  

 
Figure 18-4: Routing Out –Label Details 
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Shortest Queue 
When the Shortest Queue option is chosen, the current Work Item is 
routed to the object in the list that contains the fewest Work Items.  No 
option is available for blocked routes since the Work Center automatically 
defaults to ignore them. 

Passive 
Passive routing is used when the user wants the Work Center to be treated 
as a passive object.  More specifically, the current Work Center does not 
actively move Work Items out from it when work is complete.  Instead, the 
object downstream must actively route in Work Items from the current 
Work Center. 

Jobs Matrix 
The Jobs Matrix is a method of setting routings in a multi-product, multi-
stage process such as that found in a Job Shop.  See  Alternative 
Routing/Timing Methods on page 275 for more information. 

Cycle Matrix 
The Cycle Matrix is used when the emphasis is not on the flow of work, but 
rather the sequence of steps taken at a Work Center.  See the section in  
Alternative Routing/Timing Methods on page 275. 

Travel 
To set the travel time from the current Work Center to a specific 
destination, select an object from the list and press the ‘Travel’ button.  The 
following dialog box will appear where the user can input the exact travel 
time in the current simulation time units.  

 
Figure 18-5: Routing Out – Travel Time 

 Note that Shortest 
Queue routes to the 
destination object 
with the least Work 
Items and NOT the 
smallest proportion of 
capacity  
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Note that the travel time input is not available for Conveyors, since they are 
meant to take work items directly to their destination.  Travel Time is only 
available from Work Centers to Storage Bins or Work Exit Points. 

All travel times in the simulation can be set to zero through File > 
Preferences > Distance.  See Simulation Preferences on page 165. 

Batching 
Batching is a method of splitting one Work Item into multiple duplicate 
Work Items, as if it were a batch of similar parts.  The default is “Fixed 1”, 
meaning that for every Work Item that enters a Work Center or the 
simulation through a Work Entry point, one exits.  (Note: when items are 
collected, they are assembled into one Work Item by default, and a single 
item is routed out.)  Press the ‘Batching’ button to view the dialog below. 

 
Figure 18-6: Routing Out – Batching 

In general, a fixed distribution is used for batching out at a Work Center or 
Work Entry Point.  However, a user can employ any distribution in the list 
including named distributions and probability profiles.  The number of 
Work Items leaving the Work Center will always be a whole number and all 
label values will be identical to the original Work Item.  If the check box 
‘Use for High Volume Quantity’ is selected, the batching value will be 
applied to the Quantity label instead of the number of duplicate Work 
Items.  Note that batching is not available at Conveyors. 

 Create a user-
defined distribution 
to use for the batch 
size  
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Routing Out Options  
Note that these options are available only at Work Centers and not Work 
Entry Points or Conveyors.  Press the ‘More >>’ button to access the 
Routing Out Options for the Work Center. 

 
Figure 18-7: Routing Out – Work Center Options 

Visual Logic  
Visual Logic can be accessed through the ‘On Work Complete,’ ‘Before 
Exit,’ and ‘On Exit’ buttons (See chapter on Visual Logic on page 345). 

Exit Work Item Type  
When Work Items leave the Work Center, they can be converted to a 
different Work Item type.  Note that multiple Work Item types must be 
available for this feature to function.  The default, recommended approach 
is for the Work Item type to remain the same as when it entered. 

Index with Group 
This feature is used when Work Items only move when the last Work Item 
in a group of objects is ready to be moved.  See section on Indexing with a 
Group on page 298 for more detail. 
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Hold Work 
When the ‘Hold work here until more input work is ready’ option is 
checked, Work Items are not allowed to leave the Work Center unless a 
new Work Item can be routed in from an upstream object. 
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Chapter 19:  
Alternative Routing/Timing Methods 

Definition 
Several options exist for routing out from a Work Center or Work Entry 
Point without using routing arrows.  These methods allow the user much 
greater control over the flow of Work Items within a simulation model.  
The three main alternatives are using a Look Up table, a Jobs Matrix, or a 
Cycle Matrix. 

Jobs Matrix 
The Jobs Matrix is useful for handling situations in which there are a large 
number of locations to which work can flow, including multiple repeat 
passes through the same Work Centers, or many ways of performing the 
same task on an item of work.  The Jobs Matrix itself is a table of 
information that controls complex routings and timings when multiple 
product types exist. 

 Alternative 
Routing Methods 
can be used in a 
simulation alongside 
conventional flow 
routing  
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Figure 19-1: Example Simulation Screen Capture for Jobs Matrix 

To access the Jobs Matrix, select Objects > Jobs Matrix. 

 
Figure 19-2: Jobs Matrix 

Each row in the table represents a job or a task at a certain stage for a 
specific work type.  The columns in the matrix have specific meanings. 
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Work Type 
Work Type is the name of a special label on the Work Item.  Its content is 
used to distinguish between the different types of work or products.  In this 
case the simulation contains three types of work numbered 1, 2, and 3. 

Job 
Again, Job is the name of a special label on the Work Item.  Every time the 
Work Item is processed by a Work Center that uses the Jobs Matrix for 
timing information, this label is automatically incremented by one.  In this 
case, Work Type 1 enters Work Center 2 on two different occasions but at 
different stages in the process (i.e. Job 2 and 4).  Job can be interpreted as 
the task number for the Work Type. 

Location 
Location is the name of the Work Center that will do the work for the 
specified work type at the specified stage.  Type the name of a Work Center 
or double-click the cell to choose from a list of Work Centers. 

Timing 
Timing is the amount of time the job will take to process.  Enter a number 
here for a fixed value or double-click the cell to choose a named 
distribution.  This time will only be used if the Work Center has been set to 
use the Jobs Matrix for Timing by clicking the Work Center’s Properties > 
Timing > Use Jobs Matrix radio button.  

 
Figure 19-3: Jobs Matrix Timing 

The properties dialog for the Work Center will appear as below when the 
Jobs Matrix timing is used in lieu of specifying a processing time. 
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Figure 19-4: Jobs Matrix Timing Selected 

Changeover 
If the Work Center is set to use a changeover time for routing in and the 
Jobs Matrix for timing, the time or distribution in the changeover cell of the 
Jobs Matrix will be used when changing over.  Set the Jobs Matrix cell 
contents to -1 to instruct the Work Center to use its own changeover 
information.   

Routing Out 
All work centers using the Jobs Matrix, as well as the Work Center that first 
sends work items into the Job Shop, should have their route out disciplines 
set to “Jobs Matrix”. This will ensure that jobs move through the model as 
detailed in the Jobs Matrix table.  The only exception to this rule is for the 
Work Center that is performing the final Job in the Job Matrix.  In this case 
the route out discipline will be set as required to move the product to the 
next object in the model (i.e., a Work Exit Point). 
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Cycle Matrix 
The Cycle Matrix is used when the emphasis is placed on the sequence of 
steps taken at a Work Center instead of on the flow of work.  It is 
particularly useful when a Work Center is used for doing a series of tasks 
but the user does not want to represent each task as a separate Work 
Center. 

The Cycle Matrix defines the cycles of activity at each Work Center that 
uses the Cycle Matrix.  Set a Work Center to use the Cycle Matrix using the 
Work Center’s Timing Orientation dialog and in the Work Center’s 
Properties > Routing Out > Cycle Matrix. 

 
Figure 19-5: Cycle Matrix Timing 

After setting the Timing Orientation to Cycle Matrix, the following dialog 
will be shown for the Work Center Properties. 
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Figure 19-6: Cycle Matrix Timing Selected 

 
Figure 19-7: Cycle Matrix Routing Out 

Access the Cycle Matrix through Work Center Properties > Routing Out > 
Detail, through the menu Objects > Cycle Matrix, or with the Ctrl-K 
shortcut.  Each row represents a stage in the list of tasks that a Work 
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Center cycles through.  Rows that relate to one Work Center are always 
collected together in the Cycle Matrix. 

 
Figure 19-8: Cycle Matrix  

Immediately after the simulation is reset, each Work Center using the Cycle 
Matrix will attempt to perform the first task listed for it in the list.  After a 
Work Center has completed its last task in the Cycle Matrix, it will start 
again at the first row in its list. 

Work Center 
Work Center shows the name of the Work Center.  Click the cell and type 
the name of the Work Center or double-click the cell and select from a list 
of available Work Centers. 

If a cell is blank, it assumes the same Work Center as the row above it in 
the matrix. 

Task Number 
The Task Number is a positive integer number and is usually the sequence 
number in which the Work Center does work.  For example, each row in 
the Cycle Matrix for a Work Center will have a value one higher than the 
previous.  However, this number is only used by SIMUL8 to cross-
reference between rows and SIMUL8 will search all the rows for the value it 
needs.  So there is no requirement to number the tasks sequentially.  The 
Task Number is similar to Job in the Jobs Matrix. 
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Description 
The description can be any text that acts as a reminder about the task.  It is 
not referenced by SIMUL8 when running the model so there are no 
formatting restrictions. 

Task Type 
Task Type describes the kind of task to be performed.  Type the text name 
of the task or double-click to choose from a list of available types.  The 
Task Type affects the meaning of some other Cycle Matrix columns. 

Double-click a cell in this column to choose one of the following task types. 

 
Figure 19-9: Cycle Matrix Task Types 

The following Task Types are available: 

UNLOAD FROM 

This Command takes a Work Item into the Work Center from the 
simulation object listed in the “From/To” column.  If the “Work Type” 
and/or “Job” columns are empty, any Work Item may be loaded from the 
specified objects (using priority rules defined externally to the Cycle 
Matrix).  Otherwise the “Work Type” and/or “Job” columns are used to 
check the labels of the Work Items available in the specified object and only 
Work Items that match will be loaded.  (Work Type must match the value 
in the Work Item’s label “Work Type” and Job must match the value in the 
Work Item’s label “Job”) 

The Time column determines the time taken to perform the loading 
operation. 
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If the Work Item is not available for loading, the Work Center will wait in 
this stage until it is able to start the loading time.  (See Waiting % result 
column below). 

LOAD TO 

Send the Work Item to the simulation object listed in the From/To 
column.  If this route is blocked, time is recorded in the Waiting% result 
column as shown below. 

WORK 

Work for the amount of time in the Time column (the time may be a 
reference to a distribution or calculation). 

If the WORKTYPE and/or JOB columns are non-zero, the labels of the 
Work Item will be tested.  If they do not match, this task will be skipped.  
This lets the user specify several different tasks to select from depending on 
the nature of the work to be done. 

WAIT BEGIN 

Do nothing until the simulation object in the From/To column is in the 
State in the State column.  The state can be defined with a generic state 
such as “EMPTY” or “LOADED” or may be a Task Number listed for the 
referenced Work Center elsewhere in the Cycle Matrix.  A Work Center can 
reference itself for this type of task.  For example WC1 might WAIT until 
WC1 is LOADED because some other Work Center in the Cycle Matrix 
has a task that will LOAD TO WC1. 

Values in the State column must be positive. 

WAITEND 

Do nothing until the simulation object in the From/To column has 
completed the State in the State column.  If the simulation object in the 
From/To column is not in the specified state when this row of the Cycle 
Matrix is entered, wait until the simulation object in the From/To column 
is in this state and then wait until it is complete. 

“EMPTY” and “LOADED” (see WAIT BEGIN above) are not supported 
for this type of task. 

Values in the State column must be positive. 
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GOTO 

Instead of going to the next row in the Cycle Matrix, go to the task number 
in the State column.  The number may be a variable or calculation.  If the 
result of the calculation is -1, the Work Center will wait in this state.  If the 
result of the calculation is 0, the Work Center will go to the next task in the 
list whatever its task number.  Immediately before the calculation is 
evaluated, the Visual Logic in the Visual Logic column will be obeyed. 

Work Type 
This cell can be left blank or set to an integer value to specify the required 
value in the Work Item’s “Work Type” label.  (See LOAD TO above) 

Job 
This cell can also be left blank or a set to an integer value to specify the 
required value in the Work Item’s “Job” label.  (See LOAD TO above) 

From/To 
For tasks that communicate with other simulation objects, this column 
contains the name of the simulation object.  Type the object name or 
double-click the cell to select from list of available objects. 

Time 
This cell is used to specify the time for the stage of the cycle.  As always, 
the time units are specified in SIMUL8’s Clock Properties menu.  
Alternatively, specify the name of a Named Distribution to be sampled to 
obtain the time, or the name of a Global Data Item variable that will 
contain the time, or a calculation to obtain the time. 

State 
Used to specify a stage to wait for, depending on the content of the “Task 
Type” column, see above.  It must be text or a Task Number that some 
Work Center must be in. 

For example if the Work Center should wait until “MyOtherWorkCenter” 
is in its cycle matrix row that contains “26” in column “TaskNumber” then 
enter 26 in the State column and WAIT in the TaskType column.  
Alternatively, if the Work Center should just wait until 
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“MyOtherWorkCenter” is empty then enter “EMPTY” in the TaskType 
column. 

Permitted values for State are any positive integer value, “EMPTY” or 
“LOADED.” 

(Note that “EMPTY” and “LOADED” are not supported for WAITEND 
Task Types) 

Image 
This specifies the image to be displayed while the Work Center is in this 
stage.  Type the name of the SIMUL8 Image (from Graphics > Images list) 
or double-click the cell in the Cycle Matrix to select from the available list.  
Leave this column blank to have SIMUL8 use the images listed in the 
normal Work Center/ Graphics image animation dialog. 

Stage 
If the simulation has been run and the Work Center has referenced the 
Cycle Matrix to decide what to do next, this column will indicate with an 
arrow the currently active stage of the cycle at the Work Center.  (This is a 
read-only cell). 

Waiting% 
This section holds some of the results data.  The percentage of time the 
Work Center has spent in this stage but not actually performing the stage 
because the Work Center had to wait to start the stage.  For example, for a 
LOAD stage the Work Center will record waiting time in the stage if the 
required Work Item is not available to load.  This is a read-only cell. 

Active% 
This is another section that holds results data.  The percentage of time the 
Work Center has been working in this stage.  For some stage types, this will 
always be zero.  For example, WAIT type stages, where as soon as the 
waiting reason is satisfied, the Work Center moves to the next stage in the 
cycle.  This is also a read-only cell. 

Cycles 
This is another section that holds read-only, results data.  This is the 
number of times the cycle has been started. 
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Chapter 20:  
Other Objects 

Conveyors 
Conveyor Properties 
Many of the basic Conveyor constructs were introduced in the SIMUL8 
Basics chapter.  This section will discuss those concepts in greater detail.  
As stated previously, a Conveyor moves Work Items within the simulation 
model from one point to another.  In simulation terms, a conveyor is a 
cross between a Work Center and a Storage Bin.  This is because it takes a 
certain amount of time to move from beginning to end and there can be 
many items in the object at once, each at a different point in the process. 

By specifying Conveyor length and speed and Work Item length, the 
Conveyor determines the number of Work Items it can hold and the length 
of time it will take to travel from one end to another. 

Picking and Placing with Conveyors 
As a Conveyor does not always move Work Items from one distinct place 
to another, there can be many pick up and place at points on the conveyor.  
More advanced features can be used in conjunction with Conveyors.  By 
linking a Work Center to a Conveyor, both on routing in and on routing 
out, new features can be accessed to control the routing. 

To feed a Conveyor at a specific place on the Conveyor, go to the Work 
Center Properties and Routing Out.   
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Figure 20-1: Routing Out to a Conveyor 

By selecting the Conveyor in the list of routing out options, the ‘Place At’ 
button will become active.  By clicking on this button, it is possible to state 
where the Work Center lies in relation to the end of the Conveyor.  As 
always, the distance units are set under File > Preferences > Distance. 

 
Figure 20-2: Conveyor Pick Up/Drop Details 

Select the check box and then state the number of feet this Work Center is 
from the end of the Conveyor.  Note that this refers to the end where items 
leave the Conveyor, not where they enter the Conveyor.  The simulation 
model will now route Work Items out of this Work Center and on to the 
Conveyor three feet from the end, it will travel three feet on the Conveyor 
and then continue downstream. 

Picking Work Items from a specific point on a Conveyor requires some 
adjustments to be made to the Work center on Routing In.  By opening the 
Work Center Properties, and selecting the Routing In option, the following 
screen should be available. 
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Figure 20-3: Routing In from a Conveyor 

By selecting the Conveyor, the Place At button should become active.  
Select this option to access the dialog seen in Figure 20-2: Conveyor Pick 
Up/Drop Details.  This allows the user to state where to pick Work Items 
from when feeding from a Conveyor. 

This feature should be used in conjunction with the Pick Area as defined in 
the Conveyor Properties.  The pick area defines the area around the 
placement of the Work Center from which the Work Item can be picked 
up.  For example if the pick area is one foot, and the Work Center Pick Up 
point is specified as four foot from the end of the Conveyor then the Work 
Center can collect items from 3-5 foot from the end of the Conveyor. 

If the Pick and Place functions described here are not available, check Help 
> About to see which Version of SIMUL8 is running.  If it is less than 
Version 10 and these features are required, an upgrade is required. 
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Figure 20-4: Conveyor Pick Area 

Tanks and Pipes 
Although continuous flow or liquid management has been available in 
SIMUL8 Professional for some time, Tanks and Pipes are new features 
within SIMUL8 Standard.  Tanks and Pipes are used specifically for 
modeling a continuous flow of work instead of distinct Work Items or 
batches.   

Tank Properties 
A Tank is used like a Storage Bin except that the work inside it is 
undifferentiated and is measured in terms of mass instead of individual 
Work Items.  The user can specify the capacity of a tank as well as the start 
up level of contents.  The units of measurement are specified under File > 
Preferences > Continuous. 
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Figure 20-5: Tank Properties 

On the Visual Logic tab, the user has many options for times when Visual 
Logic can be triggered including: On Full, On Change From Full, On Pass 
Up (a specified mass), on Pass Down (a specified mass), On Change From 
Empty, and On Empty.  See the section on Visual Logic on page 345. 

Visual Logic is called at the following times: 

• On Full – When capacity is reached. 

• On Change From Full – When capacity was reached and then the 
contents go down to less than capacity. 

• On Pass Up – As the contents go above the specified level. 

• On Pass Down - As the contents go below the specified level. 

• On Change From Empty - When work enters an empty tank. 

• On Empty – When the tanks becomes empty. 
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Figure 20-6: Tank Properties – Visual Logic 

Creating a Tank 
Tanks can be found in the Build Tools2.  Right click on the menu bar and 
select Build Tools2 or select Objects > Advanced > Tanks to 
activate/show the toolbar. 

 
Figure 20-7: Tank Button – Build Tools2 

Pipe Properties 
Pipes allow the continuous movement or flow from one tank to another.  
Properties are as follows: 

• Flow rate – the speed at which material is loaded into the pipe. 

• Output % - the percentage of material that exits the pipe into the 
downstream tank. 

• Delay – the length of time it takes the material to travel from one 
end of the pipe to the other. 

Double-clicking the center of a pipe in the simulation window will open the 
pipe properties dialog, as will double-clicking a pipe listed in the Input 
Summary. 
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Figure 20-8: Pipe Properties 

Creating a Pipe 
Pipes are not located in the Objects menu or as a button in Build Tools2.  
Instead, Pipes are automatically created when two tanks are connected.  
When tanks are created on the screen, they will be automatically connected.  
To link or unlink the tanks, the same method is used as with any other 
objects and pipes are created or deleted as appropriate. 

 



294  •  Other Objects Chapter 20 

 

 



Groups SIMUL8 Reference  •  295 

Copyright Visual Thinking International 2007 

Chapter 21:  
Groups 

Definition 
Groups in SIMUL8 are a collection of simulation objects that either have 
similar characteristics or work together in some manner.  A good example 
of a group is a collection of three Work Centers that represent a machine’s 
loading time, working time, and unload time.  If the three Work Centers are 
grouped together and the capacity limit of the group is set to one, this 
effectively simulates one machine. 

Creating a Group 
To create a group, select the appropriate objects (Ctrl and select, or drag 
and draw a box) and then click right. 

 
Figure 21-1: Create a Group 
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Group Properties 
To see the Properties of the Group created or to create a new group, select 
Objects > Groups.   

 
Figure 21-2: Group Properties 

Once a group has been created, objects can be added, removed, erased, and 
duplicated from within the group.   

Properties of the group include: 

1. Limit the Work Items that can be held within all the objects at any 
one time.  For example if the group represents the machine’s load, 
work and unload Work Centers, then the group can only hold one 
Work Item at any one time, as above.  

2. Provide Efficiency and Breakdown details for the group.  Of 
course, this is limited to groups with Work Centers and not for 
groups with Storage Bins only. 

There are two different types of results that can be extracted from the 
group.  The most common type is the typical Work Center results summary 
provided instead for the entire group, as shown below. 
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Figure 21-3: Group Results 

However, detailed results on each individual Work Item can be tracked as 
the simulation runs.  By selecting the option to Monitor Wait / Work Time, 
SIMUL8 will automatically create labels for the Work Item flowing through 
the group that capture the waiting and working time within the group.  This 
information can be accessed through Visual Logic to create individual 
reports, or can be viewed by selecting a Work Center or Storage Bin 
contents. 

 
Figure 21-4: Waiting and Working Time Labels – Storage Bin Contents 

 



298  •  Groups Chapter 21 

 

Indexing with a Group 
Indexing is a function that is utilized heavily within the manufacturing 
industry to represent multiple inline Work Centers that are tied together.  In 
this way, work only moves from any given Work Center if all other Work 
Centers within that group have also completed their respective tasks.  Work 
will then move from each Work Center simultaneously. 

Once a group has been created, it is possible to index the line using all the 
objects within that group.  This can be accessed through Work Center 
Properties>Routing Out. 

 
Figure 21-5: Indexing with a Group 

 

 

 A group must be 
created and selected 
before any Work 
Centers can use 
indexing  
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Chapter 22:  
Results 

Definition 
SIMUL8 collects a number of results from any given simulation run.  
Results such as number of jobs completed, average time in system, etc, can 
be viewed at the end of a simulation run or a trial.   

Results Summary 
The Results Summary is a quick and convenient place to view results for a 
simulation run.  Users must specify which results should be displayed.  
There are two ways to add results to the summary.  Either click on the 
results button of any of the SIMUL8 objects and right-click the desired 
result, or click the Detail button in the Results Summary window. 

 
 Figure 22-1: Sample Results Summary 
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To view the current run’s results, open the results summary using either the 
Results Summary button on the toolbar or select Results > Results 
Summary.  The name of the simulation object is shown in the left most 
column followed by the specified result.  The right most column contains 
the result value for the current run. 

 
Figure 22-2: Accessing the Results Summary  

The left-most button at the top of the Results Summary (shown in Figure 
22-1) is used to compare results from various simulation runs.  Click the 
button to view the comparison spreadsheet.  

 
Figure 22-3: Comparison Spreadsheet 

By pressing the Compare button when viewing the Results Summary for a 
run, the program opens the spreadsheet that displays run results.  The time 
and date will be displayed as the header for the run result.  The results can 
be copied to the Clipboard using the left most button, deleted from the 
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sheet using the middle button, and options viewed using the right-most 
button. 

The second button from the left on the Results Summary dialog can be 
used to conduct multiple runs, also called a trial.  The third button copies 
the displayed data to the Clipboard so it can later be pasted into other 
applications, such as Excel™.  The fourth button from the left is used to 
preview the results sheet before printing it. 

 
Figure 22-4: Results Print Preview 

On the Print Preview window, several options are available to change the 
zoom level, move between results sheets, set up print options, print, save, 
open, or close. 
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On the Results Summary sheet, the Print button is located next to the 
Preview button and sends the results to the default printer.  The Detail 
button shows all objects in the current simulation. 

 
Figure 22-5: Simulation Objects Available for Results Collection 

The user must select a simulation object and then make a choice: add all 
results for the object to the Results Summary, view the results for the object 
(Results button), choose whether or not to collect results, auto adjust, or 
turn all results collection on or off. 

Object Results 
All of the objects on the simulation screen in SIMUL8 have standard results 
available for collection and viewing at the end of a simulation run.  They are 
accessible by double-clicking on a SIMUL8 Object and choosing Results.   

Work Entry Point Results 
The Work Entry Point Results dialog displays a few simple statistics, 
including the number of Work Items entered and number of Work Items 
lost in a case of blocking of the Work Entry Point. 
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Figure 22-6: Work Entry Results 

Storage Bin Results 
Storage Bins have considerably more results to view.  These include the 
number of Work Items in storage (current, minimum, average, maximum, 
and total entered), queuing time (minimum, average, maximum, standard 
deviation, and information about non-zero queuing time), and queuing time 
within limit.   

 
Figure 22-7: Storage Bin Results 

The contents of a Storage Bin can be graphed and dynamically displayed by 
pressing the Graph button along with selecting either “Sync with other 
results” or “Plot every change.”  Of course, “Plot every change” provides 
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greater accuracy, but it also requires more time.  See Result Charts on page 
316 for more detail. 

For Queuing Time within limit, enter a value in the field for Time limit.  A 
percentage for the number of all Work Items that have spent less than the 
time limit in the Storage Bin is displayed.  Also, pressing the bar chart 
button displays a histogram of the distribution of Work Item queuing times 
at the Storage Bin. 

Work Center Results 
Work Centers, like Storage Bins, show results for number of Work Items 
(current, minimum, average, maximum, and total number of completed 
jobs) but also display percent time results for six Work Center states 
(awaiting work, working, blocked, stopped, changeover, and off shift).   

 
Figure 22-8: Work Center Results 

Pressing the appropriate button will create charts or graphs of this data.  A 
time graph of the contents of the Work Center is shown when the “Graph” 
button is pressed.  A pie chart displaying the percentage of time spent in 
various states for the Work Center is displayed when the pie chart button is 
pressed.  The button at the bottom of the dialog sends all of the Percentage 
of time results to the Results Summary. 
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Conveyor Results 
The results displayed for Conveyors consist of the number of Work Items 
on the conveyor (current, maximum, average, and minimum number of 
items) along with a time graph of the contents, time on Conveyor 
(minimum, average, maximum, and standard deviation), and percentage of 
time the conveyor spent in different states (empty, moving, blocked, 
stopped). 

 
Figure 22-9: Conveyor Results 

Work Exit Point Results 
The Work Complete Results dialog box shows the number of Work Items 
completed, the time in system (minimum, average, maximum, and standard 
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deviation), and time in system within a user-defined limit.  Changing the 
value in the time limit field will show the percentage of all Work Items that 
leave the system within that amount of time. 

 
Figure 22-10: Work Complete Results 

Resource Results 
The Resource Results dialog shows utilization results for a particular 
Resource.  Utilization % is the average percentage of time that each unit in 
the resource grouping spent working.  For example, if there are 5 of a 
particular Resource type present and 4 of them spend the whole simulation 
working while the fifth did no work, Utilization will be 80%.  Traveling % 
works in a similar fashion, reporting average percentage of time spent 
traveling.  Clicking the Detail button will display the total time spent 
moving between each pair of locations in a tabular format.  Note that both 
of these results are calculated as a % of available time. 
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Figure 22-11: Resource Results 

The bottom of the dialog displays the number of units of the Resource that 
were in use over the course of the simulation (current, minimum, average, 
and maximum).  Pressing the Graph button displays a usage graph showing 
the number of resources in use over time. 

Segregating Results on Labels 
The results for Storage Bins and Work Exit Points can be broken down in 
finer detail by segregating the results based on a label.  To enable results 
segregation, click the Segregate Results check box in the object’s properties 
dialog. 
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Figure 22-12: Storage Bin Properties - Segregate Results 

 
Figure 22-13: Work Complete Properties - Segregate Results 

SIMUL8 will then prompt the user to choose a Label on which to segregate 
the results.  Note that a simulation can have multiple Labels, but the user 
can only segregate results based on one of the Labels.  For example, a 
product type Label will be more useful for segregation than a time stamp 
Label. 
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Figure 22-14: Select a Label for Segregation 

The simulation must be reset and run again before any segregated results 
can be collected.  The user will be asked to reset and run before attempting 
to view results again. 

  
Figure 22-15: Advice - Segregate Results 

Segregated results can be viewed after resetting and running the simulation 
again.  The user can select which category of segregated results to view 
from the dropdown menu in the Results dialog.  These results can be added 
to the Results Summary just like any other (see Customizing the Results 
Summary). 
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Figure 22-16: Work Complete Results - Segregated  

The categories for segregation will only be displayed in the dropdown list if 
there were Work Items with that label value passing through the object (i.e. 
a segregation category for 542 will not be a choice unless a Work Item with 
a value of 542 on the segregation label entered Work Complete 1).  The 
categorized and segregated results can be added to the Results Summary 
just like any other result. 

Customizing the Results Summary 
When opening a new simulation, the Results Summary will only display the 
average time in system for Work Items at a Work Exit Point.  The user can 
customize the Results Summary to show result statistics for any of the 
values displayed in the various object results.  To do this, open the results 
for the desired object and hover the mouse pointer over the desired result.  
When the mouse pointer is a black arrow with an “R” inside it, the user can 
click the right mouse button to add this specific result to the Results 
Summary. 

 
Figure 22-17: Add to Results Summary Pointer 
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Another way to customize the Results Summary is to open it, as described 
in the Results Summary section above, and press the Detail button.  Here, 
the user can choose various objects for which to collect results statistics.  
This way they can all be added from one central location instead of 
browsing through each object. 

Trials and Confidence Intervals 
The Results Summary can be opened at any time to view the results from 
the most recent simulation run.  Each simulation run will yield the same 
results if neither the Random Stream Set Number nor any simulation 
parameters have been changed.  When a simulation model has been 
validated and is ready for conducting experiments, a single simulation run is 
usually not sufficient since the user seeks to generate an expected range for 
results and not just a single data point.  Therefore, the user should conduct 
a trial that consists of multiple simulation runs with a different random 
number seed for each run.  To conduct a trial, select Trials > Conduct a 
Trial > Ok and Run the Trial. 

 
Figure 22-18: Conduct Trial 
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The user may specify the number of runs in a trial, the base random 
number set, a name for the particular trial, whether or not to have the 
Results Summary and Dashboard automatically appear at the completion of 
the trial, and the confidence interval to display. 

 
Figure 22-19: Example Results Summary for a Trial 

The Results Summary above shows a 95% confidence interval for each 
result given the specified number of runs in a trial.  To change to a different 
confidence interval, simply click the heading title and choose the desired 
range.   

Export Options 
Several options exist for exporting simulation results from the Results 
Summary to other software applications.  Choose Results > Results Export 
to see the typical export options as shown on the various tabs.  Check the 
Include in Results export box to export to the specified path. 

 Click the range 
titles to choose 
confidence intervals 
from 80 to 99.9  
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Figure 22-20: Results Export Options – MS Excel™ 

To export results to Excel™, select the Excel tab and specify the exact 
location, workbook name, and sheet name to write to.  Before running the 
simulation or conducting a trial, ensure that the particular workbook is 
currently open.  SIMUL8 can communicate with Excel™, but can not open 
an Excel file. 

 
Figure 22-21: Results Export to MS Excel™ 

Column headings will automatically be copied over from the Results 
Summary to the top row of the Excel™ sheet.  Subsequent runs or trials will 
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appear incrementally down the spreadsheet without overwriting prior 
results. 

 
Figure 22-22: Results Export Options – File 

Results from the Results Summary can also be exported to a tab delimited 
text file.  

 
Figure 22-23: Results Export to a File 

Note that no titles or headings are copied to the text file when exporting 
from SIMUL8. 

 
Figure 22-24: Results Export – Minitab 
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Results can also be exported to a Minitab™ worksheet for further data 
analysis. 

 
Figure 22-25: Results Export to Minitab™ 

Note that the titles appear in the header row of the worksheet and that the 
first run’s results appear in row 1.  Statistical data analysis using Minitab™ 
can now be performed on these results. 

 
Figure 22-26: Results Export - SIMUL8 Sheet 

The fourth option for exporting results is actually not an export but a copy 
of the data to a SIMUL8 spreadsheet.  Before selecting this option and the 
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target spreadsheet in the drop down menu, the user must first create an 
Information Store spreadsheet.  

  
Figure 22-27: Results Export to SIMUL8 Sheet 

The result of this export to a SIMUL8 Sheet is simply a copy of the values 
in the Results Summary, but unlike the Summary it will not be overwritten 
after a new run or trial, so it can be useful for comparing results. 

 
Figure 22-28: Results Export - V.I.S.A. 

The final export option is to V.I.S.A. (Visual Interactive Sensitivity 
Analysis).  Check the option and the results are automatically sent to 
V.I.S.A. as a new “alternative.” 

Result Charts 
The Results Summary shows results as numerical values of averages, total 
counts, minimums, and maximums.  For a more visual presentation of the 
results, Result Charts can be displayed.  These charts generally show the 
contents of queue(s) or Work Center(s), queuing time, Work Center’s 
percentage of time spent in various states, and time in simulation.  
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Figure 22-29: Sample Result charts 

These charts can be displayed either through the results dialog box for a 
specific simulation object or by selecting one or more objects on the screen 
and pressing the chart button.  

 Click and drag the 
edges of a chart to 
re-size the plot  
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Figure 22-30: Chart Button 

After pressing the button, the chart will appear at the bottom right hand of 
the screen.  Clicking and dragging the chart with the left mouse button 
allows the user to place it wherever desired.  Double-clicking the chart docks 
it at the bottom of the window.  The user also has several options available 
for each chart. 

 
Figure 22-31: Right-click Chart Options 

The user can copy the data to the Clipboard so it can be pasted to Excel™, 
Minitab™, a text file, etc.  The default title displayed for the graph can be 
changed using Set Title.  The scale of the chart axes can be locked or 
rescaled at any time. 

Note that the charts will now be displayed at all times, including model 
opening, unless otherwise closed by the user.  These charts are quite 
advantageous as they are dynamically updated throughout the simulation 
run (graph synchronization frequency can be set through Simulation 
Preferences) and provide a time-based view of the results. 

Charts can be customized through the chart properties dialog box.  To 
access this dialog, open a chart as described above and then select Charts 
from the Results menu.  Select the chart to be customized and click OK.  
This dialog sets different options including chart style (e.g. line, pie, bar), 
chart color options, chart data series, axis scales, grid lines, etc. 

 Select multiple 
objects and create a 
plot of their contents 
in one chart  
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TimeView 
Viewing results charts as shown above allows a visual depiction of a specific 
result data item.  To compare several result types in one chart with a time 
scale, the TimeView feature is available.  To obtain the following window, 
click on Results > TimeView.  The dialog box will only display the first time 
a user opens TimeView.  This can be configured with the simulation objects 
that appear on the chart.  

 
Figure 22-322: TimeView Chart Contents 

The Contents dialog box allows the user to select which simulation objects 
will be shown in the TimeView chart.  Select an object by clicking on it and 
then clicking the right arrow (>) to add it to the chart.  Click on the double 
right arrow (>>) to add all available objects.  Use the move up and move 
down buttons (finger pointing up or down) to change the order that the 
various objects appear in the chart.  Click the OK button when ready to 
view the TimeView chart. 

 
Figure 22-33: TimeView Chart 

 TimeView can be 
accessed in a 
simulation either mid-
run (after stopping it 
first) or at the end of 
the run.  



320  •  Results Chapter 22 

 

The chart shows six various states (working, waiting, down, blocked, and 
setup, plus blank space for off-shift) for Work Centers and Resources (by 
color code, as shown in the key) and displays the volume of Work Items 
and/or capacity at Storage Bins and Conveyors (as red-colored area charts) 
over the simulated time.  

Press the Print button (left-most button) to print the current chart.  Press 
the Objects button to open the TimeView Charts Contents dialog box to 
reconfigure (add or remove) the results of the various simulation objects 
displayed in the chart.  Click the down arrow on the drop down list as 
another way to configure objects to be shown in the chart. 

 
Figure 22-34: TimeView Objects Selection 

Choose a criterion from the list and type the desired text data, if necessary, 
in the field to the right of the drop down list.  For example, to view all 
Work Centers in the simulation only, select Work Centers from the drop 
down list.  To view all objects that have specific text or numbers in the 
name, select the Contains: option and type the target text in the search field 
next to the list. 

Click the Percent button to view a summary of the results data in percent 
format (instead of on a time scale). 

 
Figure 22-35: TimeView Summary  
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To change the order of colors/states displayed for Work Centers, select the 
desired color/state scheme from the drop down list to the right of the 
‘Summary’ button.  If the scale (time or percentage) is not at a desirable 
size, use the ‘> <’ button to shrink it or press the ‘< >’ button to expand it.  
Press the ‘Close’ button when finished viewing the TimeView chart.  

Finance 
The Finance feature in SIMUL8 provides a quick and simple method of 
performing activity-based cost analysis.  Costs can be associated with 
various processes or queuing times through Work Entry Points, Storage 
Bins, Resources, and overhead while revenues can be associated with Work 
Exit Points or can be fixed to obtain an income/(loss) statement for the 
simulation. 

Set the properties of any of these simulation objects and press the ‘Finance’ 
button to associate costs and/or revenues to them. 

Costs 
Costs can be associated with the following simulation objects: 

• Work Entry 

• Storage Bin/Queue 

• Work Center 

• Resource 

 Monetary units 
can be changed 
to display a 
different currency 
by pasting the 
correct symbol 
into the field in 
File > 
Preferences > 
Finance.  

 Costs cannot 
be associated 
with Conveyors 
or Tanks in 
SIMUL8.  
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Figure 22-36: Financial Information - Costs 

The user can specify the following costs: 

1. Capital Cost – Cost of owning/employing the item over the 
results collection period 

2. Cost or Usage Cost (per Unit) – Cost charged for each Work 
Item that passes through the object 

3. Cost per item per minute – Carrying cost per specified time 
unit in simulation 

4. Usage Cost (per minute) – Cost, charged on a time-basis, for 
use of a Work Center 

5. Cost per unit per minute – Cost, charged on a time-basis, for 
use of a Resource 
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Revenues 
The only simulation object with which revenues can be associated is the 
Work Exit Point. 

 
Figure 22-37: Financial Information – Revenue 

The user can specify capital cost for the Work Exit Point but also revenue 
for every Work Item that departs the simulation from that point.  The 
amount of revenue to be gained per unit sold must be estimated for this 
calculation.  The revenue value, however, can be left blank, and a cost 
analysis performed instead of a profit statement. 

Overhead Costs and Revenues 
Costs or revenues that are not driven by a specific process or object in the 
simulation can be included in the financial analysis as a fixed cost or fixed 
revenue in the Overheads dialog box from the Finance menu. 

 
Figure 22-38: Finance Menu 
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Figure 22-39: Financial Information – Overhead 

Income Statement 
The income statement shows all costs and revenues specified by the user 
based on the number of Work Items and amount of time they spend in the 
system.  Select Income Statement from the Finance menu or press the 
Finance button to view the Income Statement. 

 
Figure 22-40: Finance Button 

The report defaults to only show the total costs, revenues, and the profit or 
loss.  To view more detail about costs or revenues, double-click on the 
‘Costs’ and ‘Revenue’ titles in the statement. 

 
Figure 22-41: Finance Income (Loss) Statement 

 

 Cost and Revenue 
values cannot be set 
through 
spreadsheets or 
Visual Logic.  They 
must be entered 
manually.  

 The Income/(Loss) 
Statement only 
displays financial 
results for the most 
recent simulation run 
and does not display 
results for trials / 
multiple runs.  
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The data can be copied to the clipboard by pressing the copy button 
(leftmost button) or can be printed by clicking the printer icon.  Also, the 
results data from the Income Statement can be shown in the Results 
Summary by right clicking the title of the desired result.  Press ‘OK’ when 
finished viewing the financial report. 

The costs and revenues can be accessed and edited through the Finance 
menu after initially including the simulation objects in the financial report.  
Note that selecting and pressing the ‘Erase’ button while in the dialog box 
shown below will actually erase the simulation object and not simply 
remove it from the Income Statement. 

 
Figure 22-42: Finance Costs 

Cost by Work Type 
Costs can also be segregated by work type for analysis.  This is useful in 
models where multiple work types exist, such as when using the Jobs 
Matrix.  To activate this feature, select Finance > Cost by Work Type > 
Analyze During Runs and then run the simulation model.  When the run 
has completed, select Finance > Cost by Work Type > Review, and the 
Cost by Type table will appear.  This table can help the user to learn which 
product types are more costly, which have greater cost variability, and other 
important activity-based costing results. 
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Figure 22-43: Cost by Type window 

Dashboard 
The SIMUL8 Dashboard allows the user to view Global Data Item and 
Results Summary information in a consolidated set of tables.  It also allows 
for greater flexibility than the standard Information Store and Result 
Summary dialogs, in terms of display and formatting. 

The Dashboard can be displayed by selecting Results > SIMUL8 
Dashboard.  The Input tab displays information on Global Data Items 
added from the Information Store including variable names, user memos, 
on-reset values, and a list of places where the variable is referenced. 

 
Figure 22-44: Dashboard Inputs tab 
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The Results tab displays data added from the Results Summary including 
result names, average values, and confidence intervals if a trial has been run. 

 
Figure 22-45: Dashboard Results tab 

Using the buttons to the right of the table, the user can customize both of 
these tabs.  The top two buttons add or remove rows.  The next two 
buttons move the selected row up or down within the sheet.  The square 
button controls the cell borders, while the text button controls font style 
and size.  The paint bucket fills cells with either a solid color or a pattern, 
and the bottom right button copies the sheet to the clipboard so it can be 
pasted into an external software package. 

The user can right-click a cell to add a Result or Global Data Item to the 
table, hide or un-hide a column, and to select which confidence interval he 
or she wishes to view (e.g. 95%, 99%, etc.).  
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Chapter 23:  
Information Store 

Definition 
SIMUL8’s Information Store is a repository for user-specified variables or 
data.  The user can store information in the form of numbers, text, time, 
spreadsheets, or simulation objects. 

An Information Store can also be called a Global Data Item or a variable. 

Variable Types 
To create a new variable or to edit current variables, open Objects > 
Information Store to view a list of the current Information Stores.  Press 
the ‘Properties’ button to view or edit a variable, ‘New’ to create a new 
Global Data Item, ‘Copy’ to copy a variable, and ‘Erase’ to erase the 
selected item in the list. 

SIMUL8 Data 
Every simulation will automatically have some standard items in the 
Information Store (see below).  This SIMUL8 Data is basic information 
used by the simulation to store data needed for a typical simulation run.  
The user should not adjust this data.  Instead, press the New button to 
create a new variable in the Information Store. 
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Figure 23-1: Information Store Dialog 

Number 
Naming ConventionsNumber variables are the first option in the list of 
possible Global Data Item types.  After clicking the New button, create an 
appropriate name for the variable (see Naming Conventions) and assign a 
current value for the variable, if desired.  A “reset” value can also be 
specified.  The variable will revert to this value when the simulation is reset.   

 
 Figure 23-2: Adding a New Number Variable 

 The current value 
of the variable will be 
displayed when 
passing the mouse 
over the items in the 
list  

 Recommended 
naming Convention: 
lbl_ = Label 
dist_ = Distribution 
ss_ = Spreadsheet 
int_ = Local Integer 
gbl_ = Global Integer 
str_ = Text String 
obj_ = Object 
Variable  
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If the ‘on reset’ field is left blank (rather than zero), the variable value will 
not change when the reset button is pressed. 

Text 
A text variable is an alphanumeric (text and/or numbers) string of data that 
the user can read and write to.  They cannot be used for mathematical 
calculations.  Again, the user can assign a name and the values for the 
current content of the variable and the value to take on reset.  

 
Figure 23-3: Adding a New Text Variable 

If the default “NOCHANGE” is specified in the ‘on reset’ field, the string 
value will not change when the simulation is reset. 

 

Time 
Time variables in SIMUL8 are rarely used since they provide limited 
functionality.  They are similar to number variables in that the variable 
contains a number of time units differing only in that each time the variable 
is viewed through the Information Store dialog box it is multiplied by 60.  
Otherwise, if the variable is changed through a custom dialog box or Visual 
Logic, it acts identical to a number variable.  For example if a time variable 
is set to 5 through the Objects menu and then closed, the next time it is 
opened the value will be 300, and not some other clock-formatted time 
value. 
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Spreadsheet 
The most commonly used Global Data Item for input parameters and 
simulation results is the spreadsheet.  The user only needs to specify a name 
to create the spreadsheet.  

 
Figure 23-4: Adding a New Spreadsheet 

In order to view the contents of the spreadsheet, press the View button and 
the following window will appear. 

 
Figure 23-5: Viewing/Editing a Spreadsheet 
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All cells in the spreadsheet accept alphanumeric data.  There are 256 
columns and 16,384 rows in each sheet.  When referencing the spreadsheet 
in Visual Logic, ss_Parameters[5,2] translates to the cell in the fifth column 
and second row.  

Double-click the grey colored headers to change the name that appears in 
the top column or leftmost row. 

 
Figure 23-6: Edit Header Name in Spreadsheet 

The other buttons on the spreadsheet window are used for the following 

 
1 2 3 4 5 

Figure 23-7: Spreadsheet Options 

1) Copy the current data to the clipboard 

2) Open/import an Excel™ spreadsheet to the SIMUL8 
spreadsheet 

3) Print the current sheet 

4) Edit formatting 

5) Paste the current clipboard contents to the sheet. 

Checking the Retain Format box ensures that when the spreadsheet is 
closed, user-defined formatting will not be lost. 

 16,384 rows 
can be viewed, but 
Visual Logic can 
reference 
approximately 
65,000 rows.  
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Simulation Object 
A Simulation Object is a variable that represents a specific type of Objects 
within SIMUL8.  It is similar to a pronoun.  Just as the pronoun “He” can 
take on various meanings (of different males), a Simulation Object of type 
Work Center, can refer to various Work Centers.  Object variables are used 
when properties of many objects have to be gathered.  Instead of 
referencing the Objects one by one, the variable can be repeatedly set to 
different Objects. 

Using a Simulation Object as a variable is a somewhat advanced feature 
within SIMUL8; Simulation Objects can only be set using Visual Logic.  
Typically, users employ object variables to set some aspect of an object that 
is referenced using the literal name from a spreadsheet. 

 
Figure 23-8: Adding a new Object Variable 

Along with the variable name, selected object type, and the current content, 
on reset the user can choose the type of simulation object or can select to 
‘Auto Reference’ the simulation object.  When the variable is referenced 

 Use sequential 
names (i.e. Load 1, 
Load 2, etc.) for like 
objects for easy 
referencing in Visual 
Logic. Set obj_WC = 
“Load”+int_var  
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using Visual Logic, Auto Reference sets its value to that of the calling 
object. 

 
Figure 23-9: Simulation Object Variable Auto Reference Setup 

Variables vs. Labels 
It is sometimes easy to confuse variables and labels in a simulation.  The 
key point to remember is that a variable is globally available and/or 
constant through the entire simulation (i.e. only one instance of a variable 
exists), whereas a label is a piece of datum specific to a Work Item.  For 
example, if there are currently 15 Work Items in a simulation, then 15 label 
values can exist at one time in the simulation.  Each value is associated with 
a particular Work Item.  For a variable, however, there can only be one 
global value at any specific point in time.  Hence, the items in the 
Information Store are called Global Data Items.  For example, each person 
in a room has a label called age, with a different value.  However, there can 
only be one variable representing the average age of everyone in the room. 

Erasing Variables 
When erasing variables using the ‘Erase’ button in the main Information 
Store dialog, the following message may appear. 
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Figure 23-10: Global Data In Use Message 

The variable that the user is attempting to erase is in use by Visual Logic.  
Either the piece of Visual Logic code must be modified to no longer 
reference the variable or the code must be deleted before the Global Data 
Item can be erased. 
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Chapter 24:  
Dialog Boxes 

User Interface 
When creating a simulation model, it is possible to provide a custom-
tailored, user-friendly interface with buttons, spreadsheets, and dialog 
boxes.  Dialog boxes can be called from Visual Logic or provided as a part 
of a command menu. 

Dialog Benefits 
Dialogs are extremely useful for providing user-friendly interfaces.  They 
ensure that simulations can be easily deployed allowing end-users to quickly 
change simulation parameters and options without having knowledge of 
building simulations.  Also, dialogs can be operational even if the main 
body of the simulation is password protected to safeguard the source code.  
Additionally, the use of dialogs allows the simulation administrator more 
control over the altering of these parameters by using validity checks and 
specific input options. 

Creating Dialogs 
New dialog boxes can be created by using Tools > Dialogs > List and 
Create.  This can also be accessed using Ctrl + Alt + D. 

 



338  •  Dialog Boxes Chapter 24 

 

 
Figure 24-1: Creating Dialogs 

1. Properties – Displays the properties of the dialog box.  This is 
where the dialog box controls are created. 

2. New – Creates a new dialog box and opens its properties. 

3. Erase – Erases the dialog box.  If the dialog box is referenced in 
Visual Logic, it will not erase. 

4. Copy – Creates a duplicate of the selected dialog box and opens its 
properties. 

5. Add to Menu – Adds the Dialog to the Command Menu (See 
Setup Menu and Dialog Options below) 

 
Figure 24-2: Custom Dialogs List 
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Properties – Main 
Properties contain information about the content, appearance, and 
executable actions of the dialog box.  The “Main” tab is where basic 
information about the appearance of the dialog box is specified. 

1. Main Title – The name of the dialog is entered.  This will be 
displayed at the top left of the open dialog. 

2. Preview – Displays the dialog box. 

 
Figure 24-3: Dialog Preview 

3. Picture – Allows browsing for images to display on the left of the 
dialog box in place of the standard image.  It is best to use a .bmp 
file. 

4. Show as Wizard – If this box is unchecked, the dialog box will be 
displayed with OK and Cancel buttons and no image at the side.  If 
the box is checked, the dialog box will be displayed with Back, 
Next, and Cancel buttons and the option for displaying an image. 

5. Finish Button – If this box is checked, a Finish button will be 
displayed instead of a Next button. 

6. Cancel Button – You can specify a cancel, close, or no additional 
button. 
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Figure 24-4: Dialog Properties Main 

Properties – Controls 
Control Options 
Controls allow objects to be added to the dialog box, which can serve as 
user inputs.  The objects added will sequentially appear on the open dialog 
box.  The dialog can be previewed from the Main tab. 

1. Title – Displays text for instruction, explanation, or titles.  Text is 
entered in the Text to Display box. 

2. Data Field – The user will enter Data here.  There is a validity 
check available, which can ensure that a number is entered and that 
it is of a certain range.  In the Global Data Item box, a number, 
text or spreadsheet variable can be entered where the entered data 
will be stored. 

3. Check Box – The check box will return a binary value to the 
Global Data Item selected.  The number returned will be 1 for 
checked and 0 for unchecked. 
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4. Radio Group – The radio group will return a number to the Global 
Data Item selected.  The number returned will be 1 for the first 
choice, 2 for the second choice etc. 

5. Button – If a button is added, it can be used with On Button Click 
Logic.  The name of the button will be “Dialog Name:Text on 
Button.” 

6. Object Button – The object button is used to display the properties 
of an Object. 

7. Dropdown – The dropdown will return text to the Global Data 
Item selected corresponding to the text option selected.  Only text 
is returned, not numerical values.  In the Global Data Item box, the 
name of the variable, which will receive the returned text, is 
entered.  To return numerical values, use the Radio Group. 

 
Figure 24-5: Dialog Properties Controls 

Moving and Deleting Controls 
The position of controls on the dialog box can be changed by using the up 
and down pointers at the side of the control display box.  Selecting and 
clicking on the trash icon at the side of the control box can delete controls. 
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Validity Check 
The Validity Check is used when a Global Data Item is a number.  It is 
used in conjunction with the Data Field control.  The check box “Must be a 
number” ensures that the user enters a number into the data field.  
Allowing minimum and maximum numerical values can also restrict the 
user.  If the user fails to enter a valid number, the dialog box will not close 
when the OK button is clicked until a valid number is entered. 

Properties – Visual Logic 
Visual Logic can be called at various points from the dialog box. 

1. On Open Dialog – Visual Logic will be called when the dialog box 
is opened before the dialog box is displayed. 

2. On OK Dialog – Visual Logic will be called on clicking the OK 
button on the dialog box. 

3. On Back Dialog – Visual Logic will be called on clicking the Back 
button on the dialog box. 

4. Cancel halts calling Visual Logic – If this is checked, the Visual 
Logic from which the dialog box is opened will not be completed.  
Otherwise, SIMUL8 will run through the rest of that section of 
Visual Logic. 
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Figure 24-6: Dialog Properties Visual Logic 

Setup Menu and Dialog Options 
Dialog boxes can be displayed by Visual Logic commands.  However, they 
can also be displayed when a simulation is opened or closed or inserted into 
command menus at the top of the simulation screen. 

1. Display dialog when simulation opened – The dialog box selected 
from the dropdown menu will appear when the simulation is 
opened. 

2. Display dialog when protected simulation closed – The dialog box 
selected from the dropdown menu will appear when the simulation 
is closed if the simulation has been protected using SIMUL8-
Professional. 

3. Include Command menu – The named command menu will be 
included in SIMUL8’s main command bar. 

4. Disable during run – The command menu cannot be accessed 
while the simulation is running. 

5. Name of menu – The name entered will appear in SIMUL8’s main 
command bar. 
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6. Menu – Up to three command menus can be specified.  Using this 
selection box each can be edited. 

7. Dialogs in command menu – Dialogs can be added to the 
command menu by selecting and using the left pointer.  Selecting 
and using the right pointer removes them.  The position of the 
dialogs within the command menu is changed by selecting the 
dialog and using the up or down pointers.  Dialogs can be edited by 
clicking on the edit button to the right hand side. 

 
Figure 24-7: Dialogs in Command Menu 

 
Figure 24-8: Select Dialogs 
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Chapter 25:  
Visual Logic 

An Introduction to Visual Logic 
The entire SIMUL8 functionality is not available as a simple dialog input or 
button click; there are an infinite number of configurations for a myriad of 
industries, and the basic menu options can not incorporate them all.  As a 
result, SIMUL8 has an internal programming language called Visual Logic 
to handle advanced user requirements.  Unlike many other programming 
languages, Visual Logic provides a dialog driven generation of code, thus 
allowing a non-programmer to learn and use the code easily. 

The following is intended as an introduction to Visual Logic.  Visual Logic 
is an extremely powerful programming language with many commands.  
However, as they all have dialog driven syntax, exploring can be done 
without the step-by-step guidance of a manual. 

Accessing Visual Logic 
Within SIMUL8, there are multiple events that trigger Visual Logic during a 
model run.  The majority of Visual Logic commands are used to make 
decisions or track information while the model is running.  The following is 
a list of Visual Logic commands that can be used for these purposes: 

• Work Entry Inter-Arrival Time Pre-Sample Logic 

• Work Center / Conveyor Before Selecting Logic 

• Work Center / Conveyor After Loading Logic 

• Work Center Changeover Pre-Sample Logic 

• Work Center Processing Time Pre-Sample Logic 
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• Work Center On Work Complete Logic 

• Work Center / Work Entry Batch Pre-Sample Logic 

• Work Center / Conveyor / Work Entry On Action Logic 

• Work Center Before Exit Logic 

• Work Center On Exit Logic 

• Storage Bin On Entry Logic 

• Storage Bin On Exit Logic 
Each Visual Logic command listed above is triggered by a certain event in a 
specific timed order.  The order of these events is important.  For example, 
all decisions about a Work Item’s processing time must be made before 
processing has begun, so Action Logic cannot be used to make these 
decisions.  The following important chart provides information on the 
order of these Visual Logic events as well as some examples of what they 
are typically used for: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 25-1: Visual Logic Work Center Time Line of Events 

Work Center Events  
Process Time (includes Changeover if set)Zero Time  Zero Time  

BBeeffoorree  SSeelleeccttiinngg//RRoouuttee  IInn  BBeeffoorree  
LLooggiicc  
  - Select a specific item  
  - Examine labels 
  - Set route in conditions e.g. collecting rules 
  - Set Resource Requirements 

AAfftteerr  LLooaaddiinngg  WWoorrkk  LLooggiicc  
     - Examine labels  
     - Determine processing time 

CChhaannggeeoovveerr  DDiissttrriibbuuttiioonn  
PPrree  ssaammppllee  LLooggiicc  
   - Examine labels  
   - Determine CChhaannggee time 

PPrroocceessss  TTiimmee  
DDiissttrriibbuuttiioonn  PPrree  
ssaammppllee  LLooggiicc  
 - Examine labels  
 - Determine processing 

time  

WWoorrkk  CCoommpplleettee  LLooggiicc  
- Determine routing-out  

discipline 
 - Set labels 
 - Update result statistics  

AAccttiioonn  LLooggiicc  
     - Set label values  

BBaattcchh  PPrree  ssaammppllee  LLooggiicc  
  - Distribution (Pre - Sample) 

OOnn  EExxiitt  LLooggiicc  
     - Set Individual label 

values across a 
batch 

BBeeffoorree  EExxiitt  LLooggiicc  
- Change decision rule if previous 

route had been blocked and time 
has elapsed 



Visual Logic SIMUL8 Reference  •  347 

Copyright Visual Thinking International 2007 

Special Events Visual Logic 
In addition to calling Visual Logic from specific processing stages in Work 
Centers, there are simulation events that can trigger Visual Logic.  These are 
one-off events that typically either occur once in the simulation model, or 
are manually generated, such as an on-screen button click or Dialog Box 
button click.  The following is a list of these events: 

 
Figure 25-2: Visual Logic Special Events 

These events are typically used for setting up a simulation, providing user-
friendly inputs, and calculating reports.  As a result, specific events are used 
for certain activities depending on when these events are called.  Also 
included in this list of simulation clock events are variable logic calls.  Time 
Check, Breakdown, and Repair logic are events scheduled to be triggered at 
various times during the simulation.  The following is a time line of these 
events: 
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Figure 25-3: Visual Logic Special Events Timeline 

Creating Visual Logic Code 
Once within a Visual Logic window, click the right mouse button or press 
the Insert button on the keyboard to access the list of Visual Logic 
Commands. 

Simulation Clock Events 
Start          Simulation Time                EndZero Time  Zero Time  

BBeeffoorree  RReesseett  
     - Get information from Excel 
     - Adjust ‘Work Entry’ Inter-Arrival rate distribution parameters 
     - Adjust ‘At Start Up’ inventory levels 
     - Adjust Break- down distribution parameters  

RReesseett  LLooggiicc 
     - Set ‘At Start Up’ inventory label values (see Before 

Reset) 
     - Set ‘other’ Model parameters  
     - Clear spreadsheets 
     - Reset Statistics 

EEnndd  WWaarrmm  uupp  LLooggiicc  
     - Initialize Statistics 

SSttaarrtt  RRuunn  LLooggiicc  
     - Every time Button is pressed  

SSttoopp  RRuunn  LLooggiicc  
 - Each time button pressed 
 - Update result statistics 

EEnndd  RRuunn  LLooggiicc  
 - Update result statistics  
 - Set Results In Excel 

EEnndd  TTrriiaall  LLooggiicc  
   - Update result statistics  
   - Set Results In Excel 

VVaarriiaabbllee  LLooggiicc  CCaallllss  
     - Time Check Logic (first + incremental) 
     - Breakdown (distribution pre-sample) [reset; repair] 
     - Repair (distribution pre - sample)  [break down] 
     - Button Click  
     - Dialog Box– On Open, On OK, On Back logic 
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Figure 25-4: Creating Visual Logic Code 

Almost all parameters of a simulation model can be changed from within 
Visual Logic.  All simulation objects and elements can be accessed and 
altered through the Command Menu.  The Command menu is divided into 
three main sections: 

• Object – includes all simulation objects and their properties; 

• Simulation – includes all external access commands, simulation 
controls, results collection, and special logic for calculations and 
debugging; 

• Any – includes a drop-down menu of all Visual Logic commands. 

Other elements of the Visual Logic structure include the following: 

• The Conditional Block Editor – Provided through the ‘IF’ 
statement; 
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• The Set Command – Often used for writing information to a 
spreadsheet, calculations, and setting variables; 

• The Formula Editor – Provides a list of all simulation objects, 
information stores, and mathematical functions; 

• The Loop Control – Used for creating loops; and 

• The Call Function – Used for calling generic pieces of code, 
including functions, or for sectioning large pieces of code into 
manageable sizes. 

The Conditional Block Editor 
To access the Conditional Block Editor, click on the IF option in the 
Command menu.  The Block Editor will provide both sides of an inequality 
statement as shown below: 

 
Figure 25-5: The Conditional Block Editor 

These two parameters can be changed by double-clicking on the question 
marks or by clicking the button to the right - “…”.  This will open the 
Formula Editor, which will be introduced shortly.  The top row is the test 
portion, whereas the bottom row is the parameter that it is being tested 
against.  The drop down list will provide several different equalities and 
inequalities. 

 
Figure 25-6: Equalities and Inequalities 
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The following is a sample IF statement: 

If Storage Bin 1.Count Contents > Storage Bin 2.Count Contents 

Of course, this statement checks to see if the contents if Storage Bin 1 are 
greater than the contents of Storage Bin 2.  If the statement is found to be 
true, VL code indented below the IF statement is executed.  If the 
statement is false, indented code is skipped and execution proceeds to the 
next non-indented line. 

Complex logic can also be used by clicking on the checkbox at the bottom.  
This allows for the use of AND, and OR statements (& and | symbols 
respectively), which greatly reduces the number of lines of code that must 
be written.  When typing in formulae, ensure that there is one space 
between each variable name, mathematical symbol, and number. 

The Set Command 

The Set Value Editor is opened when the SET Command is selected from 
the Command menu.  Clicking on either side of the SET command will 
open the Formula Editor.  The Set Value Editor allows parameters to be 
changed while the model is running.  It can be used to alter Label values, 
and to change the value of various Work Center or Information Store 
parameters.  It should not be used to change the values of Named 
Distributions.  This can be done with its own Visual Logic Command. 

 
Figure 25-7: The Set Command 
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Accessing Formula Editor 
Double clicking on an edit box with question marks, or clicking on the 
square button to the right – “…”– can access the formula editor. 

 
Figure 25-8: Accessing the Formula Editor 

The Formula Editor helps the user to create complex equations by 
providing easy access to three different lists: 

• Information – Information Stores including spreadsheets, variables, 
and global SIMUL8 items such as simulation time. 

• Objects – all simulation objects created, including Work Entry 
Points, Storage Bins, Work Centers, Work Exit Points, Resources, 
Conveyors, Labels, Distributions, and Information Store objects. 

• Math Functions – provides a number of mathematical functions 
which convert numbers, for example Rand[0] will convert 0 to a 
random number between 0 and 1. 

 
Figure 25-9: The Formula Editor 

The Object section has an extra list box that adapts and changes depending 
upon the properties of the Object selected on the left hand list box.  This 
second list box provides a list of all readable and/or adaptable properties of 
the Object selected. 

Double-clicking within these lists adds the clicked item to the main 
equation line.  This is much faster and more accurate than typing in object 
names, spreadsheet cell locations, and math functions from memory. 

 Sometimes the 
Formula Editor can 
be accessed from 
other edit boxes, for 
example a Process 
Time in a Work 
Center.  Double-click 
while holding down 
shift to access these 
options.  
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The Call Function 
When generic Visual Logic code has been developed to be used in more 
than one place in the simulation, it does not have to be pasted into every 
section where it will be used.  Instead, use the Call Function to execute that 
piece of Visual Logic.  This is helpful because if a Visual Logic function 
needs to be changed, the called function can be changed once, eliminating 
the need to make the change in multiple locations.  This increases model 
building speed and lowers the chance of making an error that could be 
difficult to track.  

The Call Function provides a drop-down list of all Visual Logic sections 
within the simulation model.  Select the appropriate piece of Logic and it 
will be executed when called.  Click Properties to view and edit the code 
within the Call Function.   

 
Figure 25-10: The Call Function 

The Loop Function 
When there are multiple options and using a series of If Statements is going 
to produce an extremely large piece of code, a Loop Function is required.  
This function allows the user to loop through a set of numbers or a set of 
objects.  Most likely, the user will loop through a series of numbers.  
However, by using object variables, described in Chapter 23: Information 
Store, the user can even loop through different simulation objects.  
Depending on the size of the simulation model, looping through all Work 
Centers or Storage Bins can be quite a large task, resulting in a slower 
simulation model.  Nonetheless, Loop functions used in conjunction with 
objects in the Information Store provide a powerful method for looking 
through multiple objects in a simulation. 
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Figure 25-11: The Loop Command - looping on a number variable 

In the figure above, the user is looping through a set of numbers.  The 
variable selected as the Global Data Name is the reference point from 
within the loop.  In the example above, the variable “int_1” will first start at 
the From variable (i.e., value 1), and will continue to update in increments 
of one until the To variable (i.e., value 10) has been reached.  In order to 
loop through several Storage Bins, a global Information Store object of type 
Storage Bin would be repeatedly set to the names of the desired Storage 
Bins. 

Implementing Visual Logic 
The two major pieces of information required to use Visual Logic are the 
name of the command you want to use and where you want to use it.  By 
marrying these two items together, a user can exert almost unlimited 
control over a simulation model.  This section will present some useful 
areas where model logic can be applied, and some commands which are 
frequently used in each area.  Detailed Visual Logic (VL) examples will also 
be interspersed throughout the section.  These examples will follow the 
development of a model from the initial stages through to more complex 
logic examples demonstrating results generation and graphical user interface 
creation. 
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VL Example 1 – Using the Set 
Command 
One of the first things to be integrated into a simulation model is often 
some form of variable user input.  It is much easier to implement support 
for this during the model creation stages, rather than going back and adding 
this functionality once the model is nearly complete.  User input is often 
stored in spreadsheets, where it can be easily viewed and modified.  In 
order to set model parameters according to input sheets, use the Visual 
Logic, SET command. 

The next step is to determine where the Visual Logic code should be 
inserted.  Often setting model parameters can be performed through the 
On Reset Visual Logic section.  This section is executed whenever the 
model is reset, which generally takes place before the start of a run.  Hence, 
the parameters will be set before each run and any changes the user has 
made will be incorporated.  VL Example 1 demonstrates using the SET 
command within On Reset logic. 

The following model can be used to illustrate how the set command can be 
used to change model parameters.  This model will be used throughout the 
examples in this section of the text.  In this example, user input will be 
provided to allow the setting of Storage Bin capacities. 

 
Figure 25-12: VL Example 1 Model Structure 
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1. Build the model as pictured above.  Set the Processing Time of 
Work Center 2 to 25 minutes on average.  Keep all other settings at 
their defaults. 

2. Create a new spreadsheet variable by going to the objects menu 
and selecting Information Store. 

 
Figure 25-13: VL Example 1 - Creating the User Input Sheet 

3. Name the spreadsheet (i.e., ss_Capacity Input). 

4. Enter data into the spreadsheet as follows:  
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Figure 25-14: VL Example 1 - User Input Sheet 

5. If desired, format the spreadsheet by clicking the Edit Formats 
button on the right and using the Formats menu. 

6. Display the input sheet by clicking the Show Data Sheet button on 
the Run Tools toolbar on the main screen.  Enter the desired 
storage capacities for the two Storage Bins in the appropriate cells. 

7. Use Visual Logic to set the storage capacity according to the 
spreadsheet.  As mentioned above, it is a good idea to use On 
Reset Visual Logic for this purpose.  Select On Reset Logic under 
Tools > Visual Logic Events > On Reset. 

8. Enter the code shown in the diagram below.  First, choose the Set 
Command by right clicking inside the Visual Logic Window. 

9. Enter the name of the Storage Bin into the left edit box or click the 
button to the right and choose it from the list. 

10. Choose the Max Size property from the list of properties on the 
right. 

11. In the right edit box of the Set Command dialog Box, enter the 
spreadsheet location of the Max Size data. 
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Figure 25-15: VL Example 1 - Set Command Visual Logic 

After repeating for both Storage Areas, and inserting comments, the code 
will appear as shown above.  The capacity of the two Storage Bins will now 
be set each time the simulation is reset.  The user can test this by resetting 
the model, double-clicking on one of the storage bins and examining the 
capacity. 

VL Example 2 – Setting Distribution 
Parameters  
In addition to the SET command, there are several other ways that user 
data can be incorporated into the model.  In fact, if the change to be made 
requires the specification of several parameters at once (e.g. target object, 
distribution type, average, standard deviation, etc.), then the SET command 
cannot generally be used.  Instead, use one of SIMUL8’s built-in Visual 
Logic commands, such as Set Object Distribution Type or Set Prob-Profile 
Column Parameters.  In the following example, both the Set Object 
Distribution Type and the Set Prob-Profile Column Parameters commands 
will be used to take user input data from a spreadsheet and apply it to the 
appropriate simulation objects. 

We will continue from where we left off in Example 1.  The simple model 
started above will now be set up to produce multiple products 
simultaneously.  There are a total of 4 product types to be processed on this 
line.  The proportion of production devoted to each line is set by the user 
before the simulation run.  Each product type has a different processing 
time at Work Center 1.  We would like to set all of these parameters from 
the input spreadsheet using Visual Logic, because this will allow the 
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simulation user (who may not be a simulation expert) to easily model 
different scenarios. 

1. Open the information store and double-click on the spreadsheet 
ss_Capacity Input that was created in Example 1.  Rename the 
spreadsheet ss_Input.  SIMUL8 will automatically update all Visual 
Logic references to this spreadsheet to use the new name. 

 
Figure 25-16: VL Example 2 - Renaming a spreadsheet 

2. Update the spreadsheet to include sample user input information 
for product proportions and processing times.  Check the Retain 
Format check box if you would like the columns to retain their 
width settings after the spreadsheet has been closed.  Make sure to 
leave a number of rows between the storage bin and product 
information areas of the sheet in case you want to add data later. 
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Figure 25-17: VL Example 2 - ss_Input 

3. Create a label named lbl_product.  To do this, select Labels from 
the Objects menu and click New.  Enter the name and set the label 
type as Number, then click OK. 

4. Use a probability distribution to set the product type of each Work 
Item as it arrives from the Work Entry Point.  To create a new 
distribution, select Objects > Distributions > New.  Give the 
distribution a name according to a naming convention, for example 
dispp_Product Type.  Select the Probability Profile type.  Click 
Next.  Right-click on the default probability profile that is 
displayed, select Multiple, and then select “Delete all except 2”. 
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Figure 25-18 VL Example 2 - Probability Profile setup 

5. Right click on the profile again, and select “Add to end”.  Repeat 
this step, so that you have a probability profile with four columns.  
Do not worry about the values or percentages; these will be set 
later using Visual Logic. 

 
Figure 25-19: VL Example 2 - Completed Probability Profile 
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6. The parameters of dispp_Product Type should be set at the 
beginning of each simulation run.  As in Example 1, we will use On 
Reset Logic to accomplish this.  Open the On Reset Logic window 
(Tools > Visual Logic Events > On Reset) and add the following 
code: 

 
Figure 25-20: VL Example 2 - On Reset Logic 

The “Set Prob-Profile Column” command can be found by right-
clicking the VL window and selecting Command > Object > 
Distributions > Set Prob-Profile Column Parameters.  In the 
window that pops up, enter a value for each of the four parameters 
required by the command.  The first parameter is the name of the 
distribution to set (click on the grey “???” box to select the 
distribution from a list).  The column number is the column within 
the probability profile to edit (i.e., 4 columns were created in steps 
4 and 5).  The value is the number returned by the distribution.  In 
this case, we want to return a “1” for product 1, a “2” for product 
2, and so on.  Finally, Percentage Chance is the value which the 
user has input to the spreadsheet ss_Input. 

To quickly reference the appropriate spreadsheet cell, click on the 
grey “???” box to open the Formula Editor.  Double-click on 
ss_Input in the list, and then click the spreadsheet button (circled 
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in the image below).  In the spreadsheet window that opens, click 
the appropriate cell and then click OK to close the window. 

 
Figure 25-21: VL Example 2 - Formula Editor Spreadsheet Button 

7. Now it is necessary to tell the simulation when to assign the 
lbl_Product Type.  The logical place to do this is as soon as Work 
Items enter the model, at the Work Entry point.  Double-click on 
the Work Entry Point, select Label Actions, and select Add to 
create a new label action.  Choose lbl_Product Type and click OK.  
Select “Set To” and then choose dispp_Product Type from the 
distributions drop down menu.  Each Work Item will now be 
assigned a value of 1, 2, 3, or 4 when it enters the model, as 
sampled from the distribution dispp_Product Type. 
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Figure 25-22: VL Example 2 - Setting lbl_Product Type 

8. Now that the product type label is set according to user input from 
our Input spreadsheet, the label can be used to set Work Center 1’s 
processing time.  To do this, use the “Set Object Distribution 
Parameters” command.  The best place to perform this operation is 
in After Loading Work Logic, under the Routing In dialog.  This is 
because the logic is executed after work has been routed into the 
Work Center, but before processing has begun. 

There are two approaches to writing this code.  A series of IF 
statements could be created, in the form of “If lbl_product = 1, set 
processing time = x”.  However, a much more efficient approach is 
to take advantage of the product type label in referring to the 
appropriate row from the spreadsheet.  This way we need only use 
one line of Visual Logic code. 
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Figure 25-23: VL Example 2 - Set Processing Time Logic 

To enter this command, right click in the VL window and select Command 
> Object > Distributions > Object Distribution Parameters.  In the 
window displayed, select the object where the change is to be made (i.e., 
Work Center 1), the distribution to be changed (i.e., Operation Time), the 
new distribution type (i.e., Fixed), and then choose the parameters of the 
new distribution.  A fixed distribution has only one parameter, so we will 
set parameter 1 to reference the appropriate spreadsheet cell.  In this case, 
the cell always references column 4, and computes the row based on the 
formula [12+lbl_Product Type].  This will cause the Visual Logic to read 
the label for the current work item and add 12 to find the row reference.  
For example, if the label is set to 2, then the Visual Logic will compute row 
14, which is the correct cell for product two’s processing time.  This 
approach can significantly speed up both model development time and 
execution speed. 

VL Example 3 – Routing Using the If 
Statement 
Visual Logic is also commonly used when making routing decisions, and 
the options provided in the Work Center routing dialogs do not offer the 
level of control that is required to implement complex routing logic.  

There are two potential locations for implementing Routing In logic within 
the Work Center dialog.  One option is Before Selecting Logic on the 
Options tab of the Routing In dialog and the other option is On Exit logic 
on the Routing Out dialog.  Although On Exit logic may not seem like the 
natural place to implement routing in decisions, it is in fact often preferable 
over using Before Selecting logic.  This is because Before Selecting logic 
runs continuously during model execution, and consequently can slow a 
model down considerably.  Before Selecting Logic is run continuously 
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because there is no precise time “before” a work item enters a Work 
Center, just as there is no precise time “before” tomorrow.  On Exit logic, 
however, runs at the point in time when a work item leaves the work center.  
In many situations, this is also the precise time when a new routing in 
decision must be made.  Frequently used routing in commands include: Set 
Route in Discipline, Set Route in Priority, and Set Collect Number. 

The usual location for implementing Routing Out logic is On Work 
Complete logic on the Routing Out tab.  Frequently used routing out 
commands include: Set Route Out Discipline, Set Route Out Priority, Set 
Route Out Percent, and Set Route Out Label.  At that point, if the routing 
out discipline of the Work Center is set to Label, it is possible to control 
work item routing by setting the value of that label in Visual Logic using the 
SET command.  The next example demonstrates this technique. 

Using the model from the previous example, it is possible to illustrate how 
the IF statement and the SET Command can be used to control model 
behavior. 

Storage Bin 1 has a capacity of 7 and Storage Bin 2 has a capacity of 5.  The 
objective is to send work to the Storage Bin with the maximum space. 

1. Create a label which will be used to decide which route the Work 
Item will follow. 

 
Figure 25-24: VL Example 3 - Creating a label 

2. In Work Center 1, select the Label Routing Out discipline, and 
select lbl_Route as the controlling label. 
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Figure 25-25: VL Example 3 - Routing out by label 

3. Now it is necessary to set the label so that the Work Item will be 
routed to the Storage Bin with the most available space.  In order 
to do this Visual Logic must be used. 

4. At Work Center 1, use the Routing Out On Work Complete Visual 
Logic access point. 

5. Choose the IF command and enter the information below in its 
various edit boxes.  Ensure that the SET lbl_Route command is 
indented within the IF statement. 
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Figure 25-26: VL Example 3 - If Statement Visual Logic 

The simulation will now route Work Items to the Storage Bin with the 
maximum space. 

VL Example 4 – Routing using a Loop 
Using an IF statement in the above situation works well if there are only 
two possible destinations.  However, if the number of destinations were to 
grow, it is easy to imagine how complicated it could become to route items 
using IF statements.  A large number of IF statements would be required to 
consider all the routing options.  The previous example can be expanded to 
show six Storage Bins.  Once again, the objective is to send Work Items to 
the Storage Bin with the fewest items already waiting. 
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Figure 25-27: VL Example 4 - Model Structure 

Again, each of the Storage Bins has a capacity set from the spreadsheet 
ss_Input on reset. 

1. The spreadsheet ss_Input, from the previous examples, can be 
extended to encompass all of the Storage Bins (this is why it is 
always a good idea to leave extra space in your spreadsheets!). 
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Figure 25-28: VL Example 4 - User Input Sheet 

2. A Global object should be created so that we can use the loop 
function to quickly set the storage area capacities on reset.  This 
can be done by going to Objects > Information Store > New.  
Choose Simulation Object and select Storage Bin.  This creates a 
variable that can be set to represent different Storage Bins. 

3. The global object should be named according to a chosen naming 
convention (i.e., obj_SB). 
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Figure 25-29: VL Example 4 - Creating the Object Variable 

4. In order to use a loop, an integer variable must also be created.  
Again, a new information store is created and is named according 
to the chosen naming convention (i.e., int_loopvar). 

 
Figure 25-30: VL Example 4 - Creating the Loop variable 

5. A loop can now be constructed to set storage area capacities on 
reset.  Note that you should delete the code from VL Example 1 
which set capacities individually. 
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Figure 25-31: VL Example 4 - Loop Visual Logic 

6. A loop can also be applied when routing the Work Items from 
Work Center 1.  Another variable should be created which will 
hold the count of spaces available. 

 
Figure 25-32: VL Example 4 - Creating the Count Variable 

7. The following code ensures that the Work Item is sent to the 
Storage Bin with the most available space.  If none of the bins has 
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any available space, the Work Item is routed to Storage Bin 1.  
Remove the code from VL Example 3 which controlled routing 
using an IF statement.  Writing comments, as in the code below, 
will make the code below easy to follow.  For every time the loop is 
run, the first command in the loop sets the obj_SB variable to the 
next Storage Bin named in the spreadsheet.  The IF statement 
checks if the Storage Bin’s available space (i.e., max size – current 
contents) is greater than the  maximum available space found so 
far.  The maximum available space is stored in int_count, which 
has been initialized to zero.  If greater available space is found, 
int_count is updated and the routing label (lbl_Route) is set to the 
current destination number, which is identical to int_loopvar.  
Finally, the label is set to 1 if none of the storage bins have 
available space. 

 

 
Figure 25-33: VL Example 4 - Loop Visual Logic for Routing 
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VL Example 5 – Writing Results to a 
Spreadsheet  
For a variety of reasons, it is often useful to write simulation results to a 
spreadsheet.  Results that could be scattered through different work objects 
in the model can be collected in a single place, allowing for easy viewing.  
The spreadsheet results can also be formatted to highlight important 
information.  Spreadsheets also allow the results to be easily copied or 
exported into an external spreadsheet program such as MS Excel, where 
they can be further analyzed or stored for later examination.  Using the 
mathematical functions of the Visual Logic SET command, the user can 
create results that are not collected automatically within SIMUL8.  For 
example, results that must be calculated based multiple simulation objects 
can be written to a spreadsheet. 

In this example (continued from Example 3), write the following results to 
a spreadsheet for each of the six Storage Areas in the model: 

• Maximum Queue Size 

• Average Queue Size 

• Total number of items processed 

• Utilization % of the storage area throughout the simulation run 

Another useful piece of information for the results spreadsheet is the 
Capacity of the Storage Areas, which was set on the input sheet (see 
example 1).  It will help us to better understand our results by comparing 
the maximum queue size with the maximum queue capacity. 

1. Create a new spreadsheet, titled ss_Results, to store the calculated 
results.  Input column headings, leaving space for future title 
blocks if desired. 
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Figure 25-34 VL Example 5 - Results Spreadsheet setup 

2. The commands to write the results information to the spreadsheet 
should run only once, after the model has finished running, so use 
On End Run Logic (Tools > Visual Logic Events > On End Run): 

 
Figure 25-35 VL Example 5 - On End Run Visual Logic 

3. Input the following code into the On End Run Visual Logic dialog: 
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Figure 25-36 VL Example 5 - Results writing to spreadsheet code 

This code works as follows.  As in VL Example 4, the code will 
loop through the six Storage Areas in the model and write the 
results for each of them in turn.  The first command inside the 
loop sets the Simulation Object variable equal to the object we are 
interested in looking at during this iteration of the loop.  This 
information is taken from column 2 of the ss_Results spreadsheet.  
The next command writes the capacity of the storage area to the 
spreadsheet using the SET Command.  The following three lines of 
code use the Get Current Run Result Value command (i.e., 
Command > Simulation > Results > Get Current Run Results), 
which has four parameters: the location where you want to save the 
result (in this case a spreadsheet cell), the simulation object from 
which the result will be taken, and 2 result codes. 

Each result in a simulation object’s results dialog has a pair result 
codes that identify it; to determine the code for the result you are 
interested in, add the result to the Results Summary and right click 
(see Figure 25-37). 
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Figure 25-37 VL Example 5 – Result Codes from the Results Summary 

The final line of code in the loop uses the SET Command to 
calculate the utilization, (percentage of capacity used) of the 
Storage Area.  This result must be calculated by the user, since it is 
not recorded by SIMUL8 automatically in the storage bin’s results 
dialog.  In this case, set the cell where the result will be stored equal 
to the average queue size (located in column 5) divided by the 
maximum queue size (located in column 3).  Then multiply by 100 
to get a percentage. 

4. After running the simulation model, we can examine our 
spreadsheet and see the results that have been saved.  Note that if 
the simulation is re-run, the new results will overwrite the 
previously-recorded results. 
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Figure 25-38 VL Example 5 - The completed Results spreadsheet 

VL Example 6 – Creating Buttons 
An important part of any simulation model, as we have mentioned 
previously, is the user interface.  With a good user interface, the potential of 
a model can be fully realized as users will find it easier to modify model 
parameters.  In this example, buttons are added to the simulation window 
in order to make the model easier for a non-expert to use.  These buttons 
will open our input and results spreadsheets. 

1. Click the Load Graphics from Disk icon on the graphics palette 
and then click within the simulation window where you would like 
to place the upper left corner of the button image.  Select an image 
to use for the Input button.  The SIMUL8 image library provides 
many suitable images in the “Buttons” folder (this is typically 
accessible through C:\Program Files\SIMUL8\Examples\Images\ 
Button).  Repeat this step and select an image for the Results 
button. 

2. If desired, use the text tool on the graphics palette to label the 
buttons 
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Figure 25-39: VL Example 6 – simulation window with buttons created 

3. Hold the control key and double-click on the top left corner of the 
Inputs button image you created.  In the URL dialog that appears, 
type Inputs. 

 
Figure 25-40: VL Example 6 - URL Dialog 

4. Repeat step 3 for the Results button, typing Results into the URL 
dialog 

5. Create a new information store.  Name it Button and select the 
type text.  The name Button has special meaning in SIMUL8 so 
SIMUL8 knows to use this information store with the On Button 
Click Logic.  

6. Open the On Button Click Logic (i.e., Tools > Visual Logic Events 
> Other Events > On Button Click). 

7. Input the following code into the VL window: 
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Figure 25-41: VL Example 6 - On Button Click Logic 

The Set Main Sheet and Display Main Sheet commands can be 
found under Command > Simulation > Information Store > Main 
Sheet. 

8. Clicking on the buttons in the simulation window will now open 
the appropriate spreadsheet for easy data entry or results retrieval. 
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Chapter 26:  
General SIMUL8 Information 

Preventing Model Crashes 
Although, SIMUL8, like any other program, will occasionally crash if put 
under stress, the user should not panic since the model can be recovered.  
If a model does crash, the first thing to do is to restart SIMUL8.  Most 
models are recovered automatically by SIMUL8 without the user having to 
attempt any recovery.  It is recommended that the model be saved under a 
different name, as it is possible that the model is now corrupt.  The model 
should be checked for structural integrity before continuing with 
development. 

After examination, if the model is deemed corrupt, there are several other 
options available to the user.  The first is the SIMUL8 back-up file named a 
*.bk8.  This file should be located in the same file / folder location as the 
original model, and will have the same name as the original file.  Renaming 
this file to *.s8, provides the SIMUL8 file in the last state prior to the crash, 
i.e. the last un-do option. 

On searching, if no .bk8 file is found or it does not contain an up-to-date 
version of the model, there is a third and final option.  A temporary file will 
be stored in Windows > Temp directory called an emsave_.s8 file.  The 
Temp directory should be found at C:\Documents and Settings > 
Administrator > Local Settings > Temp > s8temp.  If not, try 
C:\WINNT\Temp\s8temp.  In this file location, there will be smaller temp 
directories that should contain a copy of the emsave_.s8. 

There are preventative measures that can be taken to avoid this extreme 
action.  It is encouraged that as models are developed, model saves are 
completed regularly, different versions of the model are saved, and that 
multiple changes are not completed without re-saving of the model.  By 
always taking these precautionary measures, system crashes will not be fatal. 
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And always remember to reset the model before you save! 

Undo and Redo 
During development of a SIMUL8 simulation model, there will be 
occasions when mistakes are made that must be removed.  SIMUL8 
provides a feature which allows the user to return to the model state prior 
to the most recent change.  Up to 20 previous model states are saved so 
that the user can use the Undo feature to remove several mistakes.  To 
access this feature, choose Edit.  The list of states will appear below Select 
All, starting with the last known state. 

 
Figure 26-1: Undo Feature 

This feature can be switched off to speed up development work 
significantly.  However, if this feature is switched off, mistakes cannot be 
undone without returning to the last saved version of the model.  To switch 
off this feature, select File > Preferences > Undo. 

Monitor Simulation 
For de-bugging purposes, a Simulation Monitor is provided so that each 
timed event in the simulation can be seen as it is running.  To switch on this 
feature, select Clock > Simulation Monitor or Ctrl-M.  The timed events 
will be sectioned into History, Now, and Future.  It is recommended that 
the Trying Steps be ignored, as these are not events, but attempts.  The 
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model can now be run from the monitor, displaying each time-based event 
during the simulation run. 

 
Figure 26-2: SIMUL8 Simulation Monitor 

View Documentation 
The view documentation options provide a text document including the 
properties of all objects within the simulation, simulation settings, 
Information Stores and Visual Logic.  Access these options by selecting File 
> Documentation. 

1. View Full Documentation – All documentation will be opened in 
Notepad or WordPad depending on the size of the file.  This is 
extremely useful for searching through the entire simulation, for 
example, to find every instance in which a certain label was used. 

2. Save Full Documentation – All documentation will be saved in .txt 
format. 

3. All memos – Documentation of all memos within objects will be 
opened in Notepad or WordPad depending on the size of the file. 

4. View Object Settings – An Information Store spreadsheet is 
created in SIMUL8 called “Summarize Input Data.”  It contains a 
summary of the parameters for each object in the simulation. 
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Figure 26-3: SIMUL8 Object Summary Data 

5. View as XML – All properties of the simulation will be displayed as 
XML code. 

6. All Visual Logic – A text document containing all the Visual Logic 
in the model will open in Notepad or WordPad. 

Simulation Properties 
SIMUL8 provides the ability to assign properties and information to any 
developed simulation model.  This includes a model title, which can be 
displayed on the top left hand corner of the screen, and notes surrounding 
the model and/or its development.  This can be accessed through File > 
Simulation Properties. 
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Figure 26-4: SIMUL8 Simulation Properties 

Find Function 
A Find function is provided to help retrieve objects within the simulation 
model by searching for a specific word.  Once the search is complete, a list 
of SIMUL8 objects containing the search word will be provided.  Clicking 
on this list will activate the properties of the selected item.  It will also 
highlight its location on the screen.  This feature is therefore useful for 
locating an object in a large simulation model.  To access this feature, select 
Edit > Find, and type in the search word. 

Graphics / Images 
The images within SIMUL8 are all contained within an Image Library.  The 
library holds all the images used in the open model, and will always contain 
the default SIMUL8 images as well. 
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Figure 26-5: List of Model Images 

The user can import images from the SIMUL8 library, which is found 
under Program Files > SIMUL8 > Examples, or import other images 
through a Browse option.  There are many websites that offer icons for free 
download.  SIMUL8 will accept *.bmp, *.wmf, or *.ico images.  Other file 
types will not appear properly on the screen and should be converted with a 
graphics software package.  The user can also create graphics in external 
graphics packages provided the images are saved in the correct format and 
are no larger than 100 pixels in any direction.   

 
Figure 26-6:  Import an Image 

The user can also make use of the SIMUL8 Image Editor, which can be 
accessed under Graphics > Images > New.  This provides a limited set of 
drawing utilities for drawing lines, squares, free drawing, text, and fill 
options, similar to those which can be found in standard graphics packages 
such as Microsoft Paint™ and Paint Shop Pro™.  This allows the user to 
create basic images within the software to meet the individual needs of the 
model, without the need to import images through the browse option. 

 Change the image 
of a Work Item when 
exiting a Work 
Center through Work 
Center Properties  
Graphics.  
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Figure 26-7: SIMUL8 Image Editor 

Data Graphics 
SIMUL8 Data Graphics are a feature that allows the user to create on-
screen graphics that display changing parameters of the model.  The 
graphics can be text, charts, or icons and are automatically updated as the 
model runs. 

  
Figure 26-8: Main Data Graphics Dialog 
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Data Graphics can be accessed by clicking on Object Properties > Graphics 
> Data Graphics (or DG Detail in a Work Center).  The main Data 
Graphics window is shown in Figure 26-10. 

As mentioned above, data can be displayed in textual, chart, or iconic form.  
Text form is useful for displaying the current value of a SIMUL8 Variable, 
spreadsheet cell, or Object Property.   

 
Figure 26-9: Data Graphics Data Types 

Data Bar allows you to create various forms of charts including stacked bar 
charts.  There are many tools for modifying charts to display the 
information that the user requires.  

 
Figure 26-10: Data Graphics Data Bar Types 

Finally, the Icon Set allows the user to display a symbol that changes color 
in response to changing simulation conditions.  

All data graphics are linked to information store variables and can be 
updated using Visual Logic, accessed from wherever the user desires.  
Typically data graphics for an object will hold results or information 
specific to the work item currently being processed at that object. 
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SIMUL8 Explorer / Quickview 
SIMUL8 Quickview provides the ability to select and view the properties of 
an object without actually opening the object’s properties window.  By 
selecting multiple objects (Ctrl-Select), Quickview can be used to make 
changes to several objects at once.  This feature is essential to speedy model 
development when creating large models.  Quick Click options allow the 
user to directly access some object property dialog boxes, eliminating the 
need to click through several dialog screens to get there.  To access this 
feature, select Objects > Quickview or press F11.  This window can be 
docked to the side of the simulation window or placed anywhere on the 
screen during development work. 

 
Figure 26-11: SIMUL8 Quickview 

SIMUL8 Explorer provides a complete list of SIMUL8 objects and access 
to those objects through a list similar to Windows Explorer.  To access this 
feature, click on Objects > SIMUL8 Explorer.  This will open the Explorer 
window which can also be placed anywhere on the screen while model 
development continues. 
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Figure 26-12 SIMUL8 Explorer 

Multi-Object Changer 
Users have the ability to change the properties of several objects at once 
using the Multi-Object Changer functionality within SIMUL8.  Instead of 
individually changing each simulation object, all desired objects can simply 
be selected and their properties can be adjusted at once.  The objects do not 
even have to be of the same type, as long as the property to be adjusted is 
common to the entire selection (e.g., High Volume is used by Storage Bins 
but not Work Entry Points).   

To adjust the values of several objects, select the desired items on screen.  
Either use the Quickview (i.e., F11), right-click and select “Properties – all 
selected objects”, or select multiple objects from one of the dialogs within 
the Objects menu to inspect the properties of the selected objects.   
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Figure 26-13: Multi-Object Changer Using Right-click Options and Quickview. 

Certain objects have more properties in common than others and are more 
easily changed using the Multi-Object Changer (i.e. Storage Bins are highly 
adjustable whereas Work Centers can rarely be adjusted simultaneously).  
And, although several objects may be chosen when viewing their properties, 
only one Properties dialog box will appear from the selected objects. 

 
Figure 26-14: Selecting Objects with the Multi-Object Changer  

For example, although a Storage Bin and a Work Entry Point are chosen, 
only the Storage Bin’s properties are shown. 
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Figure 26-15: Multi-Object Changer Right Click Options 

When selecting multiple objects in a dialog in the objects menu, the user 
has the option to apply the changes to all selected objects of a certain type 
or only to an individual object. 

 
Figure 26-16: Multi-Object Changer Confirmation Message 

The Multi-Object Changer is useful for making quick changes to multiple 
object properties, but a quick inspection of a sampling of the objects is 
always a good idea to ensure the appropriate changes have been applied if 
substantial adjustments were made. 

Watch Window 
One of the most useful Visual Logic de-bugging tools is the Watch 
Window.  This permits the user to see the values in an Information Store at 
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any time during a simulation run, or Visual Logic code execution.  This is 
invaluable for determining where an error in the Visual Logic code lies.  To 
access this feature, select Tools > Watch Window or Ctrl-Alt-W.  To select 
variables, formulas, and information store values to be seen, double-click 
on the Formula section of the window. 

 
Figure 26-17: SIMUL8 Watch Window 

Track Changes 
If there are several versions of the same model and / or different model 
builders are making changes to a model, then Track Changes is a useful 
feature to identify differences between similar models.  By opening the 
second model through the Track Changes feature, a Summary of the model 
structure will be provided with all differences highlighted.  A summary of 
these differences is also provided.  An example of a tracked change is 
provided below.  Track_Changes_1 has an inter-arrival time of 10 minutes, 
while Track_Changes_2 has an inter-arrival time of 15 minutes. 

 
Figure 26-18: SIMUL8 Track Changes Example 
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Input Summary 
The Input Summary provides detailed information about all of the objects 
in a simulation model.  The information is provided in a convenient tabular 
format, with each object type displayed in its own tab in order to simplify 
comparison of object properties.  The summary can be displayed by 
selecting Input Summary from the Objects menu (see Figure 26-19). 

Figure 26-19: Input Summary window 

The input summary is useful when debugging a simulation model, allowing 
the user to quickly find object properties that have been set incorrectly. 

Object properties cannot be edited from within the Input Summary 
window.  However double-clicking a cell in the Input Summary table will 
open the corresponding simulation object dialog box.  Clicking the copy 
button copies the contents of the current summary table to the clipboard, 
allowing them to be pasted into an external software package.  

Additional Features 
This textbook can not cover all of the features in SIMUL8.  The reader is 
encouraged to select from the various menus at the top of the SIMUL8 
main window and explore the depth of functionality that SIMUL8 offers.  
The latest changes option in the help menu is a good overview of some 
interesting features, too. 
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Appendix A: Tips and Tricks 

Refer to the page number for additional information. 

Tips and Tricks Key  
 Tips for new users   
 Tips for experienced users  
 Tips for expert users  

 

 Throughout this book, the term “simulation” refers to visual interactive 
computer simulation modeling.  17 

 A stochastic or probabilistic simulation can act like a deterministic model 
by using fixed distributions.  20 

 Use the Simulation Software Survey from OR/MS Today as a starting 
point when evaluating simulation packages  25 

 Recommended units of time: 27 
­ Seconds for less than 1 day 27 
­ Minutes for less than 6 months 27 
­ Hours for less than 2 years 27 
­ Days for more than 2 years  27 

 See the Institute for Operations Research and Management Science 
website (www.informs.org) for more information on OR  30 

 SIMUL8-Planner is a software package that combines simulation with 
planning and scheduling tools.  31 

 A computer simulation provides a risk-free arena to test various scenarios, 
so try many different situations including extremes.  40 

 Recommended naming Convention: 45 
lbl_ = Label 45 
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dist_ = Distribution 45 
ss_ = Spreadsheet 45 
int_ = Local Integer 45 
gbl_ = Global Integer 45 
str_ = Text String 45 
obj_ = Object Variable  45 

 Use Ctrl+Z to  undo  177 
 Use Shift+Ctrl+Z   to redo  177 
 Use the mouse wheel inside the active window to change the size of 

window contents  178 
 Ctrl+B to move the simulation back 1 minute  179 
 Ctrl+H to move the simulation forward 1 minute  179 
 To lock images on the screen and prevent accidental editing, close the 

Graphics Palette.  182 
 A number variable must be created in the Information Store before it can 

be displayed on the screen  182 
 Since all properties of a Work Item can be manipulated using labels (i.e. 

graphics and size), multiple Work Item types are rarely used.  188 
Minimum wait time only functions when using labels as part of the 

reference if Work Items flow into the Storage Bin. If they are added using 
Visual Logic, no wait time will be applied.  192 

 Change the image of a Work Center depending on its state (working, 
blocked, etc.) through Work Center Properties  Graphics.  195 

 Double-click on the units beside the Length or Speed input box to change 
units  199 

 To quickly link and unlink Objects, hold down the Shift key  203 
 Hold down Ctrl while clicking and dragging to quickly copy objects  204 
 Preface all labels with “lbl_” when assigning names to labels (i.e. use a 

naming convention)  207 
 Shift Patterns can be applied to both Resources and Work Centers  242 
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 When collecting and assembling multiple Work Items, final label values 
are set to the highest of the collected values unless otherwise specified.  
258 

 The maximum collect number is 32,000 when set in Visual Logic  259 
 The maximum collect number is 10,000 if using manual input  259 
 Leaving the ‘Ignore Blocked’ option unchecked could block the Work 

Center unnecessarily  268 
 Note that Shortest Queue routes to the destination object with the least 

Work Items and NOT the smallest proportion of capacity  271 
 Create a user-defined distribution to use for the batch size  272 
 Alternative Routing Methods can be used in a simulation alongside 

conventional flow routing  275 
 A group must be created and selected before any Work Centers can use 

indexing  298 
 Click the range titles to choose confidence intervals from 80 to 99.9  312 
 Click and drag the edges of a chart to re-size the plot  317 
 Select multiple objects and create a plot of their contents in one chart  

318 
 TimeView can be accessed in a simulation either mid-run (after stopping 

it first) or at the end of the run.  319 
 Monetary units can be changed to display a different currency by pasting 

the correct symbol into the field in File > Preferences > Finance.  321 
 Costs cannot be associated with Conveyors or Tanks in SIMUL8.  321 
 Cost and Revenue values cannot be set through spreadsheets or Visual 

Logic.  They must be entered manually.  324 
 The Income/(Loss) Statement only displays financial results for the most 

recent simulation run and does not display results for trials / multiple runs. 
 324 
 The current value of the variable will be displayed when passing the 

mouse over the items in the list  330 
 16,384 rows can be viewed, but Visual Logic can reference approximately 

65,000 rows.  333 
 Use sequential names (i.e. Load 1, Load 2, etc.) for like objects for easy 

referencing in Visual Logic. Set obj_WC = “Load”+int_var  334 
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 Sometimes the Formula Editor can be accessed from other edit boxes, for 
example a Process Time in a Work Center.  Double-click while holding 
down shift to access these options.  352 

 Change the image of a Work Item when exiting a Work Center through 
Work Center Properties  Graphics.  386 
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